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1. Introduction

SpiraTeam® is an integrated Application
Lifecycle Management (ALM) system
that manages your project's
requirements, releases, test cases,
issues and tasks in one unified
environment:

SpiraTeam® contains all of the features
provided by SpiraTest® - our highly
acclaimed quality assurance system and
SpiraPlan® - our agile-enabled project
management solution. With integrated
customizable dashboards of key project
information, SpiraTeam® allows you to
take control of your entire project
lifecycle and synchronize the hitherto
separate worlds of development and
testing.

This user manual outlines the features
and functionality available in
SpiraTeam®, and demonstrates how to
use the application for managing the
guality assurance and project
management processes on a typical
project.

1.1. Quality Assurance

Quality Assurance is a key component
of the Software Development Life-Cycle
(SDLC), which needs to be integrated
into the planning and management of a
program or project from its inception.
Too often though, QA is implemented as
Quality Control - whereby testing that
the required functionality works as
expected, is performed at the end, when
it is most costly to make corrections and
changes.

To manage QA across a project from
day one, it is imperative that the original
requirements are documented together
with the use-cases that validate the
desired functionality. These use-cases
then form the basis of the test scripts
that can be executed to validate that the
functionality has been correctly built,
and that the requirements have been
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satisfied. During the execution of these test
scripts, failures may occur, which are recorded
as incidents - either to be fixed or documented
depending on the severity.

Typically, these activities require people to use
at least three different types of software:

> Requirements Management
» Test Script Management
>» Defect/ Issue / Bug Tracking

However, this stove-piped approach has many
limitations and drawbacks, most importantly the
fact that there is no traceability between the
different artifacts. How can the project manager
know that all the requirements have been
tested? Conversely, how can the developer
know which test script was responsible for a
recorded bug — needed to accurately reproduce
the issue?

1.2. Project Management

As described in the Agile Manifesto, traditional
waterfall software methodologies and lifecycles
have failed to delivery projects on-time and on-
budget. In addition, many systems built this way
will fail to provide the expected business value
as there is no ability to quickly refine the
requirements as the project progresses.

Consequently software development has been
transformed with these new ideas and concepts,
with new methodologies such as Extreme
Programming (XP), Scrum, DSDM and AUP
becoming common. However the traditional
tools of project management - requirements
specifications, high level project plans, GANTT
charts, white-board schedules and top-down
task management - are too cumbersome and
not well suited.

SpiraTeam® provides a complete Agile Project
Management System in one package, that can

manages your project's requirements, releases,
iterations, tasks and issues in one environment,
fully synchronized.
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2. Functionality Overview

This section outlines the functionality provided by SpiraTeam® in the areas of requirements
management, test case management, release planning, iteration planning, incident tracking, task
management and project / user management.

2.1. Requirements Management

SpiraTeam® provides the ability to create, edit and delete project scope / requirements in a
hierarchical organization that resembles a typical scope matrix. Each requirement is associated
with a particular importance level (ranging from critical to low) and a status identifier that
designates where the requirement is in the development lifecycle (requested, planned, in-
progress and completed). In addition, each requirement is mapped to one or more test cases that
can be used to validate that the functionality works as expected. This mapping is called the
“Requirement Test Coverage”, since the test cases “cover” the requirement so that if all the tests
can be executed successfully, then the requirement is validated.

At the same time, from a development perspective, the team begins initial estimation of the
lowest-level requirements in the requirements matrix to determine the complexity and associated
resourcing. Once the high-level release schedule has been determined, the requirements can
then be prioritized and scheduled against the appropriate release according to their business
priority.

Once the release is underway, the requirements are further decomposed into their constituent
low-level project tasks that can be assigned to the project team. The system will track the
progress and revised estimates for the tasks and display them against the requirements so that
risks to the schedule can be quickly determined.

2.2. Test Case Management

SpiraTeam® provides the ability to create, edit and delete project test cases that are stored in a
hierarchical folder structure that resembles Windows Explorer ®. Each test case consists of a set
of test steps that represent the individual actions a user must take to complete the test. These
test steps also contain a description of the expected result and any sample data elements that the
tester should use when performing the action. When a user executes a test case, the results are
stored in a test run that contains the success/failure status of each test step as well as the actual
observed result that the tester experienced.

In addition each test case is mapped to one or more requirements that the test is effectively
validating, providing the test coverage for the requirement. During the execution of the test case,
each failure can be optionally used to record a new incident, which can then be managed in the
incident tracking module (see below). This provides complete traceability from a recorded incident
to the underlying requirement that was not satisfied.

To streamline the assignment and tracking of multiple test cases, SpiraTeam® allows users to
select groups of test cases and arrange them into test sets. Each test set can contain test cases
from a variety of different folders and can be associated with a specific release of the system
being tested.

2.3. Release Planning

SpiraTeam® provides the ability to track different versions / releases of the application being
tested. Each project in the system can be decomposed into an unlimited number of specific
project releases, denoted by name and version number. Requirements and Test Cases
developed during the design phase can then be assigned to these different releases. When a
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tester executes a series of test cases, they are able to choose the version of the project being
tested and the resulting test run information is then associated with that release.

From a project planning perspective, the releases are the major milestones in the project, which
are further sub-divided into iterations which are separate mini-projects with associated project
scope and tasks. The project’s requirements are scheduled at a high-level against the releases
and the detailed tasks are scheduled against specific iteration within the release.

In addition, all incidents raised during the testing process are associated with this release,
allowing the development team to easily determine which version of the project is affected. Finally
as the incidents are resolved and verified during the testing phase, the appropriate release can
be selected to indicate which release the incident was resolved and/or verified in.

2.4. Iteration Planning

As described in section 2.3, in addition to high-level project releases, SpiraTeam® can also track
the individual iterations that comprise a release, giving the project manager the option to manage
agile methodology projects within the SpiraTeam® environment. Unlike the release planning
stage, where high-level requirements are estimated and scheduled, the iteration planning phase
involves assigning each of the tasks in the project backlog against a specific iteration until the
available effort in the iteration has been completely allocated.

When you first create iterations, you specify the start and end-dates together with the notional
number of project resources assigned to the iteration and any non-working days. SpiraTeam®
uses this information to calculate the planned effort available to the iteration, from which it will
subtract the estimated task effort values to determine how much effort is available to schedule.

2.5. Incident Tracking

SpiraTeam® provides the ability to create, edit, assign, track, manage and close incidents that
are raised during the testing of the software system under development. These incidents can be
categorized into bugs, enhancements, issues, training items, limitations, change requests, and
risks, and each type has its own specific workflow and business rules. Typically each incident is
raised initially as a ‘New’ item of type ‘Incident’. Following the review by the project manager and
customer, they are changed to one of the other specific types, given a priority (critical, high,
medium or low), and status changed to ‘Open’. Once it is assigned to a developer for fixing, it is
changed to status ‘Assigned’.

The developer now works to correct the incident, after which time its status changes to ‘Fixed’ or
‘Not Reproducible’ depending on the actions taken (or not taken). Finally the project manager and
customer verify that it has indeed been fixed, and the status is changed to ‘Closed’. SpiraTeam®
provides robust sorting and filtering of all the incidents in the system, as well as the ability to view
the incidents associated with particular test cases and test runs, enabling drill-down from the
requirements coverage display, right through to the open incidents that are affecting the
requirement in question.

2.6. Task Management

As described above, in addition to storing the requirements for a project, SpiraTeam® includes
the capability of drilling each lowest-level requirement down further into a series of work items
called ‘Tasks'. These tasks are the discrete activities that each member of the development team
would need to carry out for the requirement to be fulfilled. Each task can be assigned to an
individual user as well as associated with a particular release or iteration. The system can then be
used by the project manager to track the completion of the different tasks to determine if the
project is on schedule.
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2.7. Projects and Users

SpiraTeam® supports the management of an unlimited number of users and projects, which can
be administered through the same web interface as the rest of the application. All artifacts
(requirements, tests and incidents) are associated with a particular project, and each user of the
system can be given a specific role for the particular project. So, a power user of one software
project, may be merely an observer of another. That way, a central set of users can be managed
across the enterprise, whilst devolving project-level administration to the manager of the project.
In addition to these administration functions, each user profile and project has its own
personalized dashboard view of all the pertinent and relevant information. This feature reduces
the information overload associated with managing such a rich source of project information, and
allows a single user or project snapshot to be viewable at all times for rapid decision-making.

2.7. Miscellaneous

2.7.1. Artifact Relationships

The sections above have outlined the different features and functions available in the system, and
have described the various artifacts managed in the system (e.g. projects, users, requirements,
tests, etc.). To aid in understanding how the information is related, the following diagrams
illustrates the relationships between the different artifacts and entities:

User

Requirement Release Incident

Ll

=)

Figure 1: The main entities that comprise a SpiraTest project.

Requirement

Test Mapping

Test Step

)

Task I\_

Incident Test Run Step

Figure 2: The relationships between the various SpiraTest entities
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With these overall concepts in mind, the rest of this help manual will outline the functionality in
each of the SpiraTeam® screens, and provide specific information on how to manage each of the
artifacts illustrated above. Note that this manual does not explain the Administration-level
functionality of the system; for that, please refer to the SpiraTeam® Administration Guide.

2.7.2. Artifact Naming Conventions

On various screens in the system, you will see lists of artifacts (requirements, test cases, etc.)
together with a unique identification number. In order to make it easier to recognize at a glance
which type of artifact the identification number refers to, SpiraTeam® uses a system of two-letter
prefixes which help identify the type of artifact being displayed. The current prefixes used by the

system are:

Artifact Prefix Artifact Prefix
Project PR Project Group PG
User us Incident Type IT
Requirement RQ Incident Priority IP
Release RL Incident Severity v
Test Case TC Workflow WK
Test Step TS Workflow Transition WT
Test Run TR Custom Property Values PV
Test Run Step RS Project Role RX
Incident IN Task TK
Incident Status IS Test Set TX
Custom List CL Document DC
Document Type DT Document Folder DF

In addition, certain artifacts in the system are displayed with an icon that helps distinguish them
from each other, and provides additional context on the state of the artifact:

Icon Artifact Description
| Summary Requirement
= Detailed Requirement
= Test Folder
43 Test Case with Test Steps
43 Test Case without Test Steps
I3 Test Set
=) Test Run
]| Release
= Ilteration / Build
3 Task
y Incident
0 Artifact has an Attachment
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3. User/Project Management

This section outlines how you can log into SpiraTeam®, view your personalized home-page that
lists the key tasks that you need to focus on, and drill-down into each of your assigned projects in
a single dashboard view. In addition to your personal homepage, each of your projects has its
own dashboard that depicts the overall project health and status in a single comprehensive view.

3.1. Login Screen

Upon entering the SpiraTeam® URL provided by your system administrator into your browser,
you will see the following login screen:

Please enter your user name
WE|CDme tD and password, then click the

log in button.

User Name:

Team’

[l Remember Me

Version v2.0.1
Copyright (C) 2006-2008, Inflectra Corporation Forgot your password?

Daon't have an account?

inflectra’

You need to enter your given user-name and password into the system in the appropriate boxes
then click the <Log In> button to gain access to the application. Normally you only remain logged
in to the application whilst in active use, and you will be asked to log-in again after either closing
the browser or 20 minutes of inactivity. To prevent this, and stay logged-in to SpiraTeam®
regardless of browser window closing or inactivity, select the “Remember Me” check-box before
clicking the <Log In> button. Note that this setting is specific to each individual computer you are
logging-in from, and that it will be reset when you explicitly log-out with the log-out link (described
in more detail in section 3.3).

If for any reason you are unable to login with the provided username/password combination, and
error message will be displayed. If you cannot remember the correct log-in information, click on
the “Forgot user name / password” link and your password will be emailed to the email address
currently on file.

If you don’t have a SpiraTeam® account setup, clicking on the “Don’t have an account?” link will
take you to a form that you need to fill-in, which will be forwarded to the system administrator,
who will actually create your account.

In addition, the system will prevent you logging on to the system with the same username at the
same time on multiple computers. This is to avoid the system getting confused by a user trying to
make contradictory actions at the same time. If for any reason you do try and log in to the system
when you already have an active session in progress, you will see the following screen:
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WE|CDI‘I’IE tO Your user account is

currently signed into
SpiraTest in multiple
locations.

Team

You can either Log Qut and
try a different user-name or:

Sign Off The Other
Locations to force the other

Version v2.0.1 :
locations to log-out,

Copyright (C) 2006-2008, Inflectra Corporation

inflectra’

You have two choices: you can either click the “Log Out” link and try logging in as a different user,
or if you want to log-off any other active sessions (e.g. you closed the browser and the session is

still listed as active), simply click the “Sign Off The Other Locations” link, and you will be logged in
to the application.

Since SpiraTeam®is licensed to organizations for a specific number of concurrent users — unless
they have purchased an unlimited Enterprise license — only a fixed humber of users may be
active at the same time. So, for example if an organization has a five (5) concurrent user license
and a sixth user tries to log-in, they will be presented with the following screen:

Welcome to

You have exceeded the
allowed number of
concurrent users.

A logged in user needs

™
' eam to log-out before you can
proceed.

Change License Details

Return to Login page.

Version v2.0.1
Copyright (C) 2006-2008, Inflectra Corporation

inflectra’

This means that one of the other users who is already logged-in, needs to click the “Log Out”
button so that one of the concurrent licenses is freed for your use. If the user has logged out by
closing the browser, the system may not have detected the logout. In this case, the other user
needs to log back in, and then click the “Log Out” link.
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3.2. My Page

Once you have successfully logged in, you will initially be taken to your personalized home page

called “My Page™:

s =
spiraTeam
o

Welcome Fred Bloggs to Your Dashb

Welcome, Fred Bloggs | My Profile | Administration | Log Out |

d (Modify Layout/Settings | Add tems)

My Projects

My Assigned Incidents

Help?|

liiw Project Home Planning Tracking Reporting

7 Develop edit subjact details s

Library Information .

Project Name Group Creation Date Name Project Type Priority Date Opened
Library Information System Internal Projects 1-Dec-2005 % Ability to associate multiple authors  Library Information ...  Enhancement 17-Nev-2003
Sample ication One Internal Projects 1-Dec-2005 B Test System Limitation Library Information ... Limitation 4-Dec-2003
Sample ication Two Extemnal Projects 1-Dec-2005 B Test Training ltem Library Information ... Training 3-Dec-2003
) Editing the date on a book is clunky  Library Inft ion ... Bug 4-Nov-2003
My Saved Searches B Test Training ltem Library Information ... Training 3-Dec-2003
Neme Project ',_] Test Change Request Library Information ... Change Request 3 - Medium  7-Dec-2003
) Crtical Not-Covered Requitements Library Information System > Delete ) Ability to import data from excel Library jion ... Enh: 3 -Medium  25-Nov-2003
& Failed Active Test Cases Libeary Information System > Delete Test System Limitation Library krformation ... Limitation HMEBRGEY 4-Dec-2003
) New Unassigned Incidents Library Information System > Delete %) Sampie Risk 3 Librery riormation ... Risk 4-Low 10-Dac-2003
B All Reopened Incidents Library Information System > Delete
) High Priority Late Tasks Libeary Information System > Delat My Detected Incidents
Ai.‘] Mot Executed Test Sets Library Information System > Delete Name Project Type Priority  Date Opene.
B Cannet leg into the application Library Information ... Incident 1-hov-2003
My Assigned Requirements ) Clicking on link throws fatal error Library Information Incident 1-hov-2003
Name Project Importance Status B Cannot install system on Windows ME Library Information ... Issue 1-Dec-2003
) Ability to create different editions Library Information .. In Progress ) Cannot install svstem on Oracle S Library - Bug 2hiow-2003
) Ability to link authors to their contact..  Library Information ... |2 Requested ) Ability to associate multiple authors  Library Information ... Enhancement 17-Nov-2003
1) Abiity o edit existing authors in the Py . Planned B Cannet log into the application Sample Application O... Incident 10-Dec-2003
) Ability to delete existing authors in th Library Information . In Progress B Test System Limitation Library Information ... Limitation 4-Dec-2003
) Ability to create new users in the syste. . Library Information ... 3 - Medium ~ Requested ) Sampie Risk 1 L ArzEaly
£ Abiity o import fomlsgacy systsmx  Library _ B Test Training ltem Library Information ... Training 3-Dec-2003
) Test Change Request Library Information ... Change Request |2 6-Dec-2003
My Assigned T e &) Suppont for IEu\fI DB2 L!blary IMormat!nn E_nh_an?amenl 17-Nov-2003
) Test System Limitation Library Information ... Limitation 4-Dec-2003
Hame Project Status__ Last Executed ®) Sample Risk 2 Library Information Risk 10-Dec-2003
8 gLt Creste nen buok LReary/okcanatontis I glsc 2002 ) Test Training ltem Library Information .. Training 3-Dec-2003
£ Ability to edit existing book Library Inf 1-Dec-2003 ) Test Change Request Library Information ... Change Request 4 -Low  7-Dec-2003
> Execute ) Sample Risk 3 Library Information Risk 4-Low 10-Dec-2003
) User expectations from old client app  Library Information ... Training 4-Low  3-Dec-2003
My Assigned Test Sets ) Exporting data to excel Library Information ... Training 4-Low  3-Dec-2003
Name Project Due Date Status
£ Exploratory Testing (2) Library Information ... -nfa- Deferred M)" ASSigned Tasks
> Eocits Name Project Progress Priority Due Date
& Iesﬂtﬁ‘:""h’w @) Library Information 10-Feb-2007  In Progress ¥ Develop new edition entry scre Library Information .. [N 12-Mar-2004
T ) Create edition oblect insert m Library Information ... [N 12-Mar-2004
My Pending Test Runs :‘,J Write edition object insert qu_. Library Infarmation .. 12.Mar.2004
7)) Refactor author screen to incl.. Library Information .. 10-Mar-2004
fiams Binjecy Ensipinie Bioiess #1 Create author object delete me.. Library . | 10-Mar-2004
7 Wirite author object delete que Library Information .. [ 2 10-Mar-2004

3 - Medium  27-Oct-2004

Note that once you have successfully logged-in and chosen a project, SpiraTeam® remembers
this selection, and on subsequent log-ins will automatically select that project, and highlight it for

you in the “My Projects” list (see 3.2.1 below).

Your homepage contains all the information relevant to you consolidated onto a single page for
you to take immediate action. By default the page lists the information for all projects that you are
a member of. However, you can choose to filter by the current project, to get a more focused list.

Initially the page is loaded in ‘view mode’ which means that the various ‘widgets’ on the page are
displayed with minimum visual clutter (no toolbars or control icons) that makes it easy to scan the
items on the page and see what work has been assigned. To switch the page to ‘edit mode’, click
on “Modify Layout/Settings” hyperlink:




—— . Welcome, Fred Bloggs | My Profile | | Log Out | [~Crosse et~ v] Help
spiraTeam
— Project Home Planning Tracking Reporting
bl
Welcome Fred Bloggs to Your Dachboard (Return to Normal View | Add ltems)
~ My Projects * % ~ My Assigned Incidents #
Project Name Group Creation Date Name Project Type Priority Date Opene|
Library Information System Interal Projects 1-Dec-2005 B Ability to associate multiple authors  Library Information ...  Enhancement 17-Nov-2003
Sample Application One Internal Projects 1-Dec-2005 B Test System Limitation Library Information ...  Limitation 4-Dec-2003
Sample Application Two External Projects 1-Dec-2005 B Test Training ltem Library Information ... Training 3-Dec-2003
¥ Editing the date on 3 book is clunky  Library Information ... Bug 4-Mov-2003
¥ My Saved Searches #ox B Test Training ltem Library Information Training g 3-Dec-2003
Name Project ®) Test Change Request Library Information ... Change Request 3 - Medium 7-Dec-2003
2 Ciitical Not-Covered Requirements Library Information System > Delete B Ability to impert data from excel Library Information ...  Enhancement 3-Medium  25-Nov-2003
£) Failed Active Test Cases Library Information System > Delete & Test System Limitation Library Information ... Limitation 3-Medium  4-Dec-2003
B} New Unassigned Incidents Library Information System > Delete ¥ Sample Risk 3 Library Information ... Risk 4-Low 10-Dec-2003
®) Al Reopened Incidents Library Information System > Delete
#] High Priority Late Tasks Library Information System > Delete = My Detected Incidents #*
2% Not Executed Test Sets Library Information System > Delete Name Project Type Priority  Date Opene|
B Cannot log into the application Library Information ... Incident 1-Nov-2003
My Assignod Raquiremonts R & Clicking on link throws fatal ermor Library Information ... Incident 1-Nov-2003
Name Project Importance Status B Cannot install system on Windows ME  Library Information ... Issue 1-Dec-2003
) Ability to create diferent editions Library Information .. In Progress ¥ Cannot install system on Oracle 3i Library Bug 2.Mov-2003
) Abilty to link authors o their contact Library It Requested ¥) Ability to associate multiple authors  Library Information ... Enhancement 17-Now-2003
] Abilty 1o edit existing authors in the Library Inf Planned ¥ Cannot log into the application Sample Application O... Incident 10-Dec-2003
£ Ability to delete existing authors inth...  Library = In Progress B Test System Limitation Library Information .. Limitation 4-Dec-2003
) Ability to create new users in the syste. . Library Information ... 3 -Medium  Requested B) Sample Risk 1 Library Information .. Risk 10-Dec-2003
3 Abilty to import from legacy systemx  Library Information ... 4 - Low Requested ¥ Test Training tem Library Informatian Training 3-Dec-2003
®) Test Change Request Library Information ... Change Request |2 6-Dec-2003
~ My Assigned Test Cases * %
B Support for IBM DE2 Library Information ... Enhancement 17-Now-2003
;;r:.:mty to create new book Sh{::ﬂnfunnatim = :::::;::md !I Tost System Limighon ibedly nfotmeion’.. Linidtn 4Dec 2009
BErcid ® Sample Risk 2 Library Information Risk 10-Dec-2003
) Abiliy to edit existingbook  Library Information .. 1.Dec-2003 ) Test Training tem Library Information . Training h | 3-Dec-2003
> Execute &) Test Change Request Library Information ... Change Request 4-Low  T-Dec-2003
®] Sample Risk 3 Library Information ... Risk 4-Low  10-Dec-2003
i Nyéstgnediiestiets O3 3 ) User expectations from old client app  Library Information ... Training 4-Low  3-Dec-2003
o Eojsce InisDals S ukis W} Exporting data to excel Library Information . Training 4-low 3Dec-2003
Aj Exploratory Testing (2) Libsary Information .. -nfa- Deferred
> Execute ~ My Assigned Tasks o
5 %&Wﬂy ® Libery Inkomztion it (lAceD Name Project Progress Priority Due Date
¥ Develop new edition entry scre Libeary Information ... [N 12.Mar-200
+ My Pending Test Runs % ox ¥] Create edition object insert m Library Information ... [ 12-Mar-200|
Name Project Last Update Progress 7] Write edition object insert qu Library Information 12.Mar-200
7] Refactor author screen to incl.. Library Information .. 10-Mar-200

In this mode, each of the ‘widgets’ displayed on the page can be minimized by clicking on the
arrow icon () in the top-left of the window, or closed by clicking-on the cross icon (¥) in the top-
right of the window. This allows you to customize your page to reflect the types of information that
are relevant. If you have closed a widget that you subsequently decide you want to reopen, you
can add them back to the page display by clicking the “Add Items” hyperlink at the top of the
page. In addition, the various widgets have a “settings” icon (3#) that allows you to customize how
that widget appears. The settings are specific to each widget and in general allow you to specify

how many rows of data are displayed and what columns are displayed.

You can move and reposition the various widgets on the dashboard by clicking the mouse on the
title bar of the widget you want to move and dragging it to the desired location. This change will
be remembered when you next login to the system. Once you have the dashboard configured the

way you like it, you can click “Return to Normal View” to switch back to ‘view mode’.

When you load your ‘My Page’ for the first time it will consists of the following main elements:

> My Projects

My Saved Searches

My Assigned Requirements
My Assigned Test Cases
My Assigned Test Sets

My Pending Test Runs

YV VY Vv Yy




» My Assigned Incidents
» My Detected Incidents
» My Assigned Tasks

However these are not the only widgets available. If you click on the “Add/Remove” items
hyperlink it will display the list of any additional widgets that are available:

Add/Remove ltems Close

Select the catalog you would like to browse.

Closed Widgets (0}
Available Widgets (1)

Available Widgets

D My Saved Reports

Add to: | Left Side [+|| Add || Close |

You can add the additional widgets by selecting the appropriate checkbox, choosing the
destination location (left side vs. right side) and then click the [Add] button. The additional widgets
available in the My Page are:

» My Saved Reports

3.2.1. My Projects

This section lists all the projects you have been given access to, together with the name,
description, project group and date of creation. To view the description of the project, simply
position the mouse pointer over the link, and a tooltip window will popup containing the
description.

When you initially view the page, all of the projects will be shown as links, in normal type, with a
white background. When you click on a project to view, you will be taken to that project’'s home-
page, and that project will be set as the current project. That project will now appear in your
home-page in bold-type with a yellow background (see above screen-shot). To change the
currently selected project, simply click on the link of another project name. You can always
change your current project by clicking on the drop-down-list of projects displayed on the global
navigation bar to the right of the “Log Out” link.

If you are a project group member, the name of the project group will also be displayed as a
hyperlink. In which case, clicking on the project group hyperlink will take you to the Project Group
dashboard (see section 3.5).

3.2.2. My Saved Searches

This section lists any filters/searches you have saved from the various artifact list screens
throughout the application. This allows you to store specific combinations of searches that you
need to perform on a regular basis (e.g. display all newly logged incidents, display all
requirements that are completed but have no test coverage).

The name of the saved search is displayed along with an icon that depicts which artifact it's for
and the project it refers to. Clicking on the name of the saved search will take you to the
appropriate screen in the project and set the search parameters accordingly. Clicking the “Delete”
link next to the saved search will delete it.
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3.2.3. My Assigned Requirements

This section lists all the requirements you have been made owner of, across all the different
projects you are a member of. This typically means that the project manager has assigned you to
be responsible for either developing the supporting test cases or decomposing the requirement
into its detailed work breakdown structure of project tasks. The requirement name is displayed,
along with its status (requested, accepted, in-progress, etc.) and its importance.

3.2.4. My Assigned Test Cases

This section lists all the test cases you have been made owner of, across all the different projects
you are a member of. This typically means that the project manager has assigned you to be
responsible for executing the assigned test scripts. To aid in this process, the script name is
displayed, along with its last execution status (failed, passed or not-run) and date of last
execution. This enables you to see how recently the tests have been run, and whether they need
to be re-run.

If you click on the test-name hyperlink, you will be taken to the details page for this test-case (see
section 5.2) and the project that the test-case belongs to will be made your current project. If you
click on the “>Execute” link listed below it will actually launch the test-case in the test-case
execution module (see section 5.4) so that you can easily retest failed cases.

3.2.5. My Assigned Test Sets

This section lists all the test sets (groups of test cases) you have been made owner of, across all
the different projects you are a member of. This typically means that the project manager has
assigned you to be responsible for executing the test cases contained within the test set against a
specified release of the system under test. To aid in this process, the test set name is displayed,
along with its status, the project it belongs to, the number of remaining test cases to be executed,
and the date by which all the tests need to have been run.

If you click on the test-set name hyperlink, you will be taken to the details page for this test-set
(see section 5.6) and the project that the test-set belongs to will be made your current project. If
you click on the “>Execute” link listed below it will actually launch the test-cases contained within
the test-set in the test-case execution module (see section 5.4) so that you can easily carry out
your assigned testing task.

3.2.6. My Pending Test Runs

This section lists any test runs that you started executing in the test case module but haven't yet
completed. Once a test case or test set is executed, a pending test run entry is stored in the
system so that you can continue execution at a later date. Any pending test run can be either
deleted or resumed by clicking on the appropriate link.

3.2.7. My Assigned Tasks

This section lists all the project tasks that you have been made the owner of across all the
different projects you are a member of. This typically means that the manager of the project in
guestion has assigned development tasks to you that need to be completed so that a release can
be completed and/or a requirement can be fulfilled. The tasks are listed in ascending date order
so that the items with the oldest due-dates are displayed first. In addition, each task is displayed
with a progress indicator that graphically illustrates its completion against schedule. See section 8
— task management for details of the different progress indicators.
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Clicking on the task name hyperlink will take you to the task details page. This page will describe
the task in more detail, illustrate which requirement and release it is associated with, and also
allow you to view the change log of actions that have been performed on it.

3.2.8. My Assigned Incidents

This section lists all the open incidents you are the owner of, across all the different projects you
are a member of. This typically means that the project manager has assigned you to be
responsible for resolving the incident. In the case of a bug, this can mean actually fixing the
problem, whereas for other incident types (e.g. training item) it may mean simply documenting a
workaround. In either event, this section highlights the open incidents you need to manage,
ranked by importance/priority and categorized by type, with the open date displayed to give you a
sense of the age of the incident.

Clicking on the incident name hyperlink takes you to the incident details page (see section 6.2)
that describes the incident in more detail, and allows you to add new information or change its
status to indicate actions taken. In addition, if you position the mouse pointer over the name of
the incident, a more detailed description is displayed as a “tooltip”.

3.2.9. My Detected Incidents

This section lists all the open incidents that you have detected, across all the different projects
you are a member of. These incidents are not necessarily ones that you need to take an active
role in resolving, but since you were the originator — either by executing a test case or just logging
a standalone incident — you can watch them to make sure that they are resolved in a timely
manner.

Clicking on the incident name hyperlink takes you to the incident details page (see section 6.2)
that describes the incident in more detail, and allows you to add new information or change its
status to indicate actions taken. In addition, if you position the mouse pointer over the name of
the incident, a more detailed description is displayed as a “tooltip”.

3.2.10. My Saved Reports

This section lists any reports you have saved from the reports center. This allows you to store
specific combinations of report elements, format, filters and sorts (see the section on Reporting
for more details on how to configure a report) for reports that you need to run on a regular basis:

My Saved Reports

Name Project

v1.0 Release List Report Library Information System = Delete

3.3. Global Navigation

Regardless of the page you are on, SpiraTeam® will always display the global navigation bar,
consisting of six section tabs (My Page, Project Home, Planning, Testing, Tracking and Reports)
that correspond to the main activities that take place in the system, as well as three secondary
links to “My Profile” and “Log Out” and “Help”. Under the various tabs are several secondary
menu options that are displayed when you hover the mouse over the appropriate tab as
illustrated below:

>» Project Home

D> Project Home (described in Section 3.4)
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> Documents (described in Section 10)
>» Planning

D> Requirements (described in Section 4)

> Releases (described in Section 7)

D> lterations (described in Section 7.3)
> Testing

[> Test Cases (described in Section 5)

> Test Sets (described in Section 5.6)
>» Tracking

B> Incidents (described in Section 6)

> Tasks (described in Section 8)

> Resources (described in Section 9)
» Reports (described in section 11)

Note: The main tabs will take you to the appropriate artifact type (requirement, test case, incident,
etc.) for the currently selected project. However if you haven't selected a project, then clicking on
any of the tabs will simply take you back to “My Page” so that you can select a project.

3.3.1. Log Out

Clicking on the “Log Out” link will immediately log you out of your current session and return you
to the login page illustrated in section 3.1. If you had set the “Remember Me” option during your
previous login, that setting will be reset; so if you want to avoid having to keep logging-in, you'll
need to re-check that box during your next log-in.

3.3.2. Help
Clicking on this link on any page will bring up the online version of this manual shown below:
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= http:/fsandman/?helpUrl=User Manual.xml&section=4.1. Requirements List - SpiraTeam Online Help - Windows Internet Explorer

SpiraTeam Help Center

Table of Contents

1. Introduction
2. Functionality Overview
3. User/Project Management
= 4. Requirements Management
4.1. Requirements List
4.1.1. Insert
4.1.2. Delete
4.1.3. Indent
4.1.4. Outdent
4.1.5. Refresh
4.1.6. Edit
4.1.7. Show Level
4.1.8. Filttering
4.1.9. Show / Hide Columns
4.1.10. Copying Requirements
4.1.11. Noving Requirements.
4.1.12. Exporting Requirements
4.2, Requirement Details
4.2.1. Test Coverage
422 Tasks
4.2.3. Custom Properties
424 Aftachments
425 History
4.28. Associations

5. Test Case Management
6. Incident Tracking

7. Release Management
8. Task Tracking

9. Reporis Center

E
4.1. Requirements List T
When you click on the Planning > Requirements link on the global navigation bar, you will initially be
taken to the requirements list screen illustrated below:
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The requirements list consists of a hierarchical arrangement of the various requirements and functionalities
that need to be provided by the system in question. The structure is very similar to the Work Breakdown
Structure (WBS) developed in Microsoft Project®, and users of that software package will find this very U
&;Ii"&n Vi \AJ’:.—.— aema ;ﬂ-&n T N S o ] LB I St B Rt | et s

Clicking on any of the [+] expand links in the left hand table of contents will open up the detailed
list of topics for each of the main areas of the system. In each area, clicking on one of the

individual links will open the appropriate section in the help manual. By default, the reading-pane
will open to the help item that is most closely related to the screen you happened to be on when

you clicked the “Help” link.

3.3.3. Choose Project

Choosing a project from the list of your assigned projects in the drop-down-menu allows you to
quickly and easily jump between projects regardless of the page you happen to be on. When you

choose a project, you will be taken to the home page for that project (which is described in
section 3.4 below).




3.4. Project Home

When you click on either the “Project Home” tab or the name of the project in the “My Page”
project list, you will be taken to the homepage of the specific project in question:

Welcome, Fred Bloggs | My Profile | Administration | Log Out | |Ubrry infomation System v Help?

e — 0
spiraTeam

Planning Test Tracking Repol

Library Information System (PR000001) - Modify Layout/Settings | Add ltems Display data for: |— &1 Reeases — v

Project Overview Top Open Issues (view Al
Sample application that allows users to manage books, authors and lending records for a typical branch Description Priority Owned By Date Opened
libra

U Cannot install system on Windows ME 1-Dec-2003
Group:  Intemal Projects
Web Site: wwow libranyinformationsystem org ™ Ability to be accessed by Mozilla _ Joe P Smith 1-Dec-2003
Ownerls): System Administrator Management of children's loans 3-Medium  Joe P Smith 1-Dec-2003

System may require process changes 3 - Medium 1-Dec-2003

Requirements Summary (View Details)

::tusmd 1.Critical  2- Hlflu e Iled:un 4 -L:w (None) TOT:L Top Open Risks viswAl
e 1 3 1 5
Evaluated 0 Description ity Owned By Date Opened
Rejected 0 Sample Risk 1 10-Dec-2003
Accepted 0 Sample Risk 2 10-Dec-2003
Planned 1 2 3 Sample Risk 3 4-Low Fred Bloggs 10-Dec-2003
In Progress 1 1 2
Complsted 1 1 8 ) )
TOTAL 8 4 g 1 18 Test Execution Status (view Details)
3 Total # Runs: 19
Requirements Coverage (View Details) Daily Run Count:
q g iew Details NS
9 > 12/3/2003 - 3
> 12/2/2003 - 2

> 12172003 - 11

Failed Passed Not Run Blocked Caution

Passed Failed Blocked Caution Mot Run Not Covered

Release Test Summary (View Details

Release / Iteration #Tests  Execution Status

Release Task Progress (view Details) 8 1.0.0.0- Library System Release 1 z -
Release / lteration Tasks Est. Actual Task Progress @1010- Librany System Release 1 SP1 1
T1.0.0.0 - Libeary System Release 1 18 94.0h  935h | | 1,020 - Ubrary System Release 1 5P2 I

@ 1.0.1.0 - Library System Release 1 SP1 2 s = MNa Tasks B1100-Libm em Release 1.1 3 LB

ERN ] - Library System Relesse 1 SP2 0 = = Mo Tasks @1110- Library System Release 1.1 SP1 ks
T 1.1.0.0 - Libary System Release 11 18 860h 857h @ 1200 - Library System Release 2005 1

1.1.1.0 - Library System Release 1.1 SP1 2 = E Na Tasks
1200 Libeary System Relsase 2005 3 100h 9.5 Incident Summary (View Details)

Displaying for Incident Type:
Late Finishing Tasks (view an Slﬂm 1.Critical ~ 2-High 3.Medium  4.low  (None) TOTAL
Name Owner Progress End Date ::;zod ;’ g % % 1‘;
73 Create edition object insert method Fred Bloggs NN 12-Mar-2004 Duplicate E B i ) 3 E
7] Develop new edition entry screen Fred Bloggs [ 12-Mar-2004 New 3 3
] Wite auther object dslete query Fred Bloggs I 10-Mar-2004 Nt Reproducible 1 - 1
7] Create author object delete method Fred Bloggs NN 10-Mar-2004 Open 3 4 2 2 4 15
Reopen o
Late Starting Tasks (view Al ?;?::d 12_‘ ‘2‘ T ‘21 o r.§n
Name Owner
) Write edition obiect insert quenes Fred Bloggs Incident ODBI'I Count (View Details
¥ Refactor author screen to include delste Fred Bloggs o]
¥ Write author object update queries Joe P Smith
#] Create author object update method Joe P Smith
7] Develop edit author details screen Joe P Smith
g T T T
(None) 1- Critical 2-High 3 - Medium 4-Low

Requirement Incident Count
Requirement Name #0pen  #Total
£ Ability to add new books to the system

) Ability to associate books with different editions

T Ability to edit existing books in the system

¥ Ability to associate books with different subjects

T Ability to associate books with different authors

) Ability to completely erase all bocks stored in the system w.
T Ability to create new users in the system
e ————————
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This page summarizes all of the information regarding the project into a comprehensive, easily
digestible form that provides a “one-stop-shop” for people interested in understanding the overall




status of the project at a glance. It contains summary-level information for all types of artifact
(requirements, test cases, incidents, etc.) that you can use to drill-down into the appropriate
section of the application. In addition to viewing the project home page, you can choose to filter
by a specific release, to get the homepage for just that release (and any child iterations).

In a similar manner to the ‘My Page’, the Project Home dashboard is initially loaded in ‘view
mode’ which means that the various ‘widgets’ on the page are displayed with minimum visual
clutter (no toolbars or control icons) that makes it easy to scan the items on the page and see the
health of the status of the project at a glace. To switch the page to ‘edit mode’, you should click
on “Modify Layout/Settings” hyperlink.

Once in ‘edit mode’, each of the ‘widgets’ displayed on the project homepage can be minimized
by clicking on the arrow icon () in the top-left of the window, or closed by clicking-on the cross
icon () in the top-right of the window. In addition, the widgets allow you change their settings by
clicking on the settings icon (¥).This allows you to customize your view of the project to reflect
the types of information that are relevant to you. If you have closed a widget that you
subsequently decide you want to reopen, you can rectify by clicking the “Add Items” hyperlink at
the top of the page, and locating the closed item from the list of ‘Closed Widgets'.

When you load your ‘Project Home’ for the first time it will consists of the following main elements:

A\ 4

Project Overview
Requirements Summary
Requirements Coverage
Release Task Progress
Late Finishing Tasks
Late Starting Tasks

Top Open Issues

Top Open Risks

Test Execution Status
Release Test Summary
Incident Summary
Incident Open Count
Requirement Incident Count

YV V VY VY VY VY VY VY VY Y VYY
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However these are not the only widgets available. If you click on the “Add/Remove” items
hyperlink it will display the list of any additional widgets that are available:

Add/Remove ltems Close
Select the catalog you would like to browse.

Closed Wid (0}
Available Widgets (4)

Available Widgets

D Requirements Regression Coverage
[ Test set Status

D Incident Aging

D Incident Tezt Coverage

Add to: | Left Side  [v|[ Add |[ Close |

You can add the additional widgets by selecting the appropriate checkbox, choosing the
destination location (left side vs. right side) and then click the [Add] button. The additional widgets
available in the Project Home dashboard are:

» Requirements Regression Coverage
>» Test Set Status
> Incident Aging
» Incident Test Coverage
Each of the different widgets listed is described in more detail below:

3.4.1. Project Overview

This section displays the name of the project, together with a brief description, the web-site that
points to any additional information about the project, and the names of the owners of the project.

3.4.2. Requirements Summary

This section consists of a summary table that displays the aggregate count of requirements in the
system broken-down by importance (on the x-axis) and status (on the y-axis). This allow the
project manager to determine how many critical vs. low priority enhancements are waiting to be
implemented, vs. actually being implemented. In addition, it makes a distinction between those
requirements simply requested and those actually planned for implementation, so the project
manager can see what the backlog is between the customer’s demands, and the plan in place.
Clicking on the “View Details” link at the top of the table simply brings up the project requirements
list (see section 4.1), whereas clicking on the individual values in the cells will display the
requirements list with the filter set to match the importance and status of the value.

3.4.3. Requirements Coverage

This section consists of a bar graph that displays the aggregated count of requirements test
coverage for the project. The Passed, Failed, Blocked, Caution and Not-Run bars indicate the
total count of requirements that have tests covering them, allocated across the execution status
of the covering tests. For example if a requirement is covered by four tests, two that have passed,
one that has failed and one that has not yet been run, the counts would be passed = 0.5, failed =
0.25 and not-run 0.25. These fractional quantities are then summed across all the requirements
to give the execution status breakdown of the covered requirements.
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In addition to the five statuses for the covered requirements, the sixth (“Not Covered”) bar depicts
the total number of requirements that have no tests covering them, putting the five other bars into
perspective. Typically a project is in good health if the “Not Covered” bar is zero, and the count of
“Passed” requirements is greater than “Failed”, “Caution” or “Not Run”. The greatest risk lies with
the “Blocked”, “Not Covered” and “Not Run” status codes, since the severity/quantity of any bugs
lurking within is not yet fully known.

If you position the mouse pointer over any of the four bars, the color of the bar changes slightly
and the underlying raw data is displayed as a tooltip, together with the percentage equivalent.
Clicking on the any of the bars in the chart will take you to the requirements list page (see section
4.1) with the corresponding filters set.

When you filter the project home by releasel/iteration, this widget will filter the requirements
coverage graph to only include requirements that are specifically mapped to the selected
releasel/iteration. This is useful when you want to determine the test coverage of new
requirements that are being added to the specific release/iteration. If instead you want to
determine the regression test coverage for a release, you should add the separate “Requirements
Regression Coverage” widget to the page instead.

3.4.4. Requirement Incident Count

This section displays a count of the total number of incidents, and the number of open incidents
mapped against requirements in the system, sorted by the requirements that have the most open
incidents first. This section is useful for determining the parts of the application that have the most
instability, as you can look at the requirements that have yielded the greatest number of incidents.
Clicking on any of the requirements hyperlinks will take you to the detail page for the requirement
in question (see section 4.2). You can configure in the settings whether to include requirements
with no open incidents, and also how many rows of data to display.

3.4.5. Top Open Issues

This section displays a breakdown of the top issues logged against the project, in order of
decreasing priority. Note that items not given a priority are listed at the top, since critical issues
could be lurking in that list, and the project manager will want to immediately review these to
assign priorities. Clicking on the issue item hyperlink will take you to the incident details page for
the issue in question (see section 6.2). You can configure in the settings whether to use Priority
or Severity for the display, and also how many rows of data to display.

3.4.6. Top Open Risks

This section displays a breakdown of the top risks logged against the project, in order of
decreasing priority. Note that items not given a priority are listed at the top, since critical risks
could be lurking in that list, and the project manager will want to immediately review these to
assign priorities. Clicking on the risk item hyperlink will take you to the incident details page for
the risk in question (see section 6.2). You can configure in the settings whether to use Priority or
Severity for the display, and also how many rows of data to display.

3.4.7. Release Test Summary

This widget allows you to quickly ascertain the test execution status of each of the active releases
that make up the current project in one snapshot. Each release is displayed together with a
graphical display that illustrates the execution status with different colored bars. In addition, if you
hover the mouse over the graphical display it will display a tooltip that provides a more detailed
description of the number of tests in each status.
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Release Test Summary (View Details)

Release / lteration # Tests Execution Status

= 1.0.0.0 - Library System Release 1
E1.01.0- Library System Release 1 SP1
E1.020- Library System Release 1 SP2

E1.1.0.0- Library System Release 1.1
[ 1.1.1.0 - Library System Release 1.1 SP1

E1200- Library System Release 2005

1=

1=

1=

(%=}

=l

1=

Each release will display the aggregate status of any test cases directly assigned to itself,
together with the test status of any child iterations that are contained within the Release. Clicking
on one of the releases will drill you down one level further and display the test execution status
for the parent release as well as each of the child iterations separately:

Release Test Summary (View Details)

Release [ Iteration # Tests Execution Status
= 1.1.0.0 - Library System Release 1.1 9

21 1.1.0.0.0001 - Iteration 001 2

21 1.1.0.0.0002 - Iteration 002 3

21 1.1.0.0.0003 - Iteration 003 4

3.4.8. Incident Summary

This section consists of a summary table that displays the aggregate count of incidents in the
system broken-down by priority (on the x-axis) and status (on the y-axis). This allow the project
manager to determine how many critical vs. low priority incidents are waiting to be addressed,
and how many new items need to be categorized and assigned. Clicking on the “View Details”
link at the top of the table simply brings up the incident list (see section 6.1), whereas clicking on
the individual values in the cells will display the incident list with the filter set to match the priority
and status of the value.

By default this summary table displays the total count of all incidents — regardless of type,
however my changing the drop-down list to a specific incident type (e.g. bug, enhancement,
issue, etc.), the project manager can filter the summary table to just items of that type. You can
also configure in the settings whether to use Priority or Severity for the x-axis

3.4.9. Test Execution Status

This section consists of a bar graph that displays the aggregated count of test cases in each
execution status for the project. Note that this graph does not consider past test-runs when
calculating the totals in each status (Passed, Failed, Not Run, etc.), it simply looks at each test-
case and uses the last-run status as the best health indicator. Thus if a test case that previously
passed, has subsequently failed upon re-execution, it will be considered a failure only.

If you position the mouse pointer over any of the five bars, the color of the bar changes slightly
and the underlying raw data is displayed as a tooltip, together with the percentage equivalent.
Clicking on any of the bars will bring up the project test case list (see section 5.1) with the
appropriate filter applied.
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In addition to the bar-chart, there is a also a display of the total number of test runs recorded for

the project, and a list of the five most recent days of recorded test-runs, together with the daily
count.

3.4.10. Release Task Progress

This widget allows you to quickly ascertain the task progress of each of the active releases that
make up the current project in one snapshot. Each release is displayed together with a graphical
display that illustrates the completion percentage and status with different colored bars. In
addition, if you hover the mouse over the graphical display it will display a tooltip that provides a
more detailed description of the number of tasks in each status.

Release Task Progress (view Details)

Release [ Iteration Tasks Est. Actual Task Progress
[E1.0.0.0 - Library System Release 1 18 94.0h  93.5h

[E1.0.1.0 - Library System Release 1 SP1 0 - - Mo Tasks

[E1.0.2.0 - Library System Release 1 SP2 0 Mo Tasks
E1.1.00- Library System Release 1.1 18 86.0h  857h

[E[1.1.1.0 - Library System Release 1.1 SP1 0 - - Mo Tasks
[E11.2.0.0 - Library System Release 2005 3 10.0h  3.5h

Each release will display the aggregate progress of any tasks directly assigned to itself, together
with the task progress of any child iterations that are contained within the Release. Clicking on
one of the releases will drill you down one level further and display the task progress for the
parent release as well as each of the child iterations separately:

Release Task Progress (View Details)

Release [ lteration Tasks  Est. Actual Task Progress
21.000- Library System Release 1 18 94 0h 93 5h

32.0n  32.3h

|

J 1.0.0.0.0001 - lteration 001
21 1.0.0.0.0002 - lteration 002
21 1.0.0.0.0003 - lteration 003

32.0h 31.2h
30.0h 30.0h

([=7]

[[=3]

3.4.11. Late Finishing Tasks

This section displays the list of any project tasks that have not yet been completed, but whose
scheduled end date has already elapsed. A graphical progress bar is included with each task in
the grid, so that you can easily see which tasks are nearest completion.

3.4.12. Late Starting Tasks

This section displays the list of any project tasks that have not yet started, but whose scheduled

start date has already elapsed. Each task is listed along with its owner, priority and due-date so

that you quickly ascertain how many days late it will be starting, how important it is to the project,
and who needs to be contacted to get more information.

3.4.13. Requirements Regression Coverage

This section consists of a bar graph that displays the aggregated count of requirements test
coverage for the project in a similar fashion to the ‘Requirements Coverage’ widget:

© Copyright 2006-2009, Inflectra Corporation Page 21 of 121 This document contains Inflectra proprietary information




Requirements Regression Coverage (View Details)
-
D T T T T T 1
Passed Failed Blocked Caution Mot Run Mot Covered

However, unlike the ‘Requirements Coverage’ widget, when you filter the project home by
releasel/iteration, this widget will filter the requirements coverage graph to include all requirements
(regardless of releaseliteration), but only considering covering test cases that are associated with
the selected releasef/iteration. This is useful when you want to determine the regression
requirements test coverage of a specific release (i.e. does running all the tests relevant to this
release cover all the necessary requirements, not just new requirements).

3.4.14. Test Set Status

This section consists of a bar graph that displays the aggregated count of test cases in each
execution status for each test set in the project:

Test Set Status  (view Details)
20 |

Overdue Test Sets:
TX000001 5-Feb-2007

TX000002 7-Feb-2007
TX000005 10-Feb-2007

o | |

T
Failed Passed Mat Run Blocked Caution

Therefore if you have the same test cases stored in multiple test sets, then this widget will display
the total test case count for all combinations of test set. This is useful if you have the same test
cases being executed in different environments — represented by different test sets — and you
need to make sure that the tests passed successfully in all environments.

If you position the mouse pointer over any of the five bars, the color of the bar changes slightly
and the underlying raw data is displayed as a tooltip, together with the percentage equivalent.
Clicking on any of the bars brings up the project test set list (see section 5.6) page with the
appropriate filter applied. In addition to the bar-chart, there is a also a display of the five most
overdue test sets in the project.

3.4.15. Incident Aging

This section displays the number of days incidents have been left open in the system. The chart
is organized as a histogram, with the count of incidents on the y-axis and different age intervals
on the x-axis.

3.4.16. Incident Test Coverage

This section displays a bar-graph that illustrates the execution status of any test cases that
previously failed and resulted in the generation of an incident that has subsequently been
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resolved. This is very useful when a test case was executed in Release 1.0 and an incident was
logged. That incident has now been resolved in Release 1.1 (and is in a closed status) but we
need to know that the test case that caused the failure has been successfully re-run. Any test

cases listed as Blocked, Caution, Not-Run or Failed in this graph need to be executed to verify
that all resolved bugs in the release have truly been fixed.

3.5. Project Group Home

When you click on either the “Project Group Home” tab in the global navigation or the name of the

project group in the “My Page” project list, you will be taken to the homepage of the specific
project group in question:

- L] Welcome, Fred Bloggs | My Profile | Administration | Log Out | |Lbrey nformation System v Help?
raTeam o
Wy Page Project Home Planning Testing Tracking Reporting

Project Group Home | Project Home | Documents

Role: Manager
Project Group: Internal Projects (PG000002) - Modify Layout/Settings | Add Rems

Group Overview

Project List
Contains the library project and sample application one Project Name Web Site Creation Date
Web Site: www.libranvinformationsystem.org = Library Information System  hitp-//uwww libearyir rstem org 1-Dec-2005
Owner{s): Fred Bloggs , System Administrator
Sample Application One hittpyflwww tempuri arg 1-Dee-2005
Requirements Coverage )
o Test Execution Status

4

g T T T T T T 1
Passed Failed EBlocked Caution NotRun Mot Covered o] - S

Project #Reqgs Coverage Falled " Passed | MNotRun = Blocked Caution
Library Information System 18 Praject # Tests #Runs Execution Status
Sample Application One 1 Library Information System 1 19

Sample Application One 1 1
Task Progress )
Incident Agin
23 ging
35
v T aI T T >
On Scheduls Late Finish Late Start Mot Started 0 1 : - . : 5
Project Tasks Est. Actual Task Progress 0-15 16-30 3145 46-50 61-75 76-90 =00
Library Information System 39 190.0h 188 7h Project # Open Open By Priority
Library Inf Syster .
Sample Application One a 0.0h 0.0h Mo Tasks Library Information System 34

Sample Application One 1

This page summarizes all of the information regarding the project group into a comprehensive,
easily digestible form that provides a “one-stop-shop” for people interested in understanding the
overall status of the group as a whole as well as the relative performance of the different projects
that make up the group. It contains summary-level metrics for all types of artifact (requirements,

test cases, tasks, incidents, etc.) that you can use to drill-down into the appropriate project for
more details.

In a similar manner to the ‘My Page’, the Project Group Home dashboard is initially loaded in
‘view mode’ which means that the various ‘widgets’ on the page are displayed with minimum
visual clutter (no toolbars or control icons) that makes it easy to scan the items on the page and
see the health of the status of the project at a glace. To switch the page to ‘edit mode’, you
should click on “Modify Layout/Settings” hyperlink.

Once in ‘edit mode’, each of the ‘widgets’ displayed on the project group homepage can be
minimized by clicking on the arrow icon () in the top-left of the window, or closed by clicking-on
the cross icon (¥) in the top-right of the window. In addition, the widgets allow you change their
settings by clicking on the settings icon (¥).This allows you to customize your view of the project
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group to reflect the types of information that are relevant to you. If you have closed a widget that
you subsequently decide you want to reopen, you can rectify by clicking the “Add Items” hyperlink
at the top of the page, and locating the closed item from the list of ‘Closed Widgets'.

When you load the ‘Project Group Home’ for the first time it will consists of the following main
elements:
» Group Overview
Requirements Coverage
Task Progress
Project List
Test Execution Status
> Incident Aging

However these are not the only widgets available. If you click on the “Add/Remove” items
hyperlink it will display the list of any additional widgets that are available:

>
>
>
>

Add/Remove ltems Close

Select the catalog you would like to browse.

Closed Widgets (0}

Available Widgets (2)

Available Viidgets

D Top Open lzsues
D Top Open Rigks

Add to: | Left Side [+ || Add || Closs |

You can add the additional widgets by selecting the appropriate checkbox, choosing the
destination location (left side vs. right side) and then click the [Add] button. The additional widgets
available in the Project Group Home dashboard are:

» Top Open Issues

>» Top Open Risks
Each of the different widgets listed is described in more detail below:

3.5.1. Group Overview

This section displays the name of the project group, together with a brief description, the web-site
that points to any additional information about the project group, and the names of the owners of
the project group.

3.5.2. Project List

This section lists all the active projects that make up the group, together with the name,
description, project group and date of creation. To view the description of the project, simply
position the mouse pointer over the link, and a tooltip window will popup containing the
description.
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3.5.3. Requirements Coverage

This section consists of a bar graph that displays the aggregated count of requirements test
coverage for the entire project group. The Passed, Failed, Blocked, Caution and Not-Run bars
indicate the total count of requirements that have tests covering them, allocated across the
execution status of the covering tests

Under the main bar graph is displayed a table containing each project in the group and a colored
bar illustrating the specific requirements coverage distribution for that project. That way you can
see both the aggregate coverage and also the relative coverage for the projects. You can
configure in the widget settings whether you want to see the aggregate bar graph, and/or the
project-specific requirements coverage.

3.5.4. Task Progress

This section consists of a bar graph that displays the aggregated count of tasks by progress
category for the entire project group. The ‘On Schedule’, ‘Late Finish’, ‘Late Start’ and ‘Not
Started’ bars indicate the total count of tasks that are in that category for all the projects in the
group.

Under the main bar graph is displayed a table containing each project in the group and a colored
bar illustrating the specific task progress for that project (using the same coloring convention as
the main graph). That way you can see both the aggregate task progress and also the relative
progress for each project. You can configure in the widget settings whether you want to see the
aggregate bar graph, and/or the project-specific task progress.

3.5.5. Test Execution Status

This section consists of a bar graph that displays the aggregated count of test cases by execution
status for the entire project group. The Passed, Failed, Blocked, Caution and Not-Run bars
indicate the total count of test cases that are in that category for all the projects in the group.

Under the main bar graph is displayed a table containing each project in the group and a colored
bar illustrating the specific test case execution status for that project (using the same coloring
convention as the main graph). That way you can see both the aggregate test status and also the
relative status for each project. You can configure in the widget settings whether you want to see
the aggregate bar graph, and/or the project-specific test status.

3.5.6. Incident Aging

This section displays the number of days incidents have been left open in the system. The chart
is organized as a histogram, with the count of incidents on the y-axis (for all projects in the group)
and different age intervals on the x-axis.

Under the main bar graph is displayed a table containing each project in the group and a colored
bar illustrating the distribution of open incidents by priority for that project. That way you can see
both the aggregate aging for the group and also the relative priority of open incidents for each
project. You can configure in the widget settings whether you want to see the aggregate aging
histogram, and/or the project-specific incident count by priority.

3.5.7. Top Open Issues

This section displays a breakdown of the top issues logged against any of the projects in the
group, in order of decreasing priority. Note that items not given a priority are listed at the top,
since critical issues could be lurking in that list, and the project manager will want to immediately
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review these to assign priorities. Clicking on the issue item hyperlink will take you to the incident
details page for the issue in question (see section 6.2). You can configure in the settings whether
to use Priority or Severity for the display, and also how many rows of data to display.

3.5.8. Top Open Risks

This section displays a breakdown of the top risks logged against any of the projects in the group,
in order of decreasing priority. Note that items not given a priority are listed at the top, since
critical risks could be lurking in that list, and the project manager will want to immediately review
these to assign priorities. Clicking on the risk item hyperlink will take you to the incident details
page for the risk in question (see section 6.2). You can configure in the settings whether to use
Priority or Severity for the display, and also how many rows of data to display.

3.6. My Profile

When you click on either the “My Profile” link in the global navigation, you will be taken to the
page in the system that allows you to view and edit your personal profile:

Please review the information listed below and make any changes if necessary.
Once you have finished, click [Update] to confirm them.

First Name™: |Fred |
Middle Initial: |:|

Last Name™: |B|oggs |
User Name™: |fredb|oggs |

Email Address™ |fredb|oggs@mycompany.com |

LDAP DN: MNIA

[Jchange Password

Current Password: |

|
Mew Password: | |
|

Confirm Password: |

You can change your user information including your first-name, last-name, middle-initial and
user-name. The system will check to make sure that the user-name is not already in use, and
warn you if this is the case. Clicking the <Update> button will commit the changes, whereas
clicking <Cancel> returns you back to either “Project Home” or “My Page” depending on whether
you have a project currently selected or not.

3.6.1. Change Password

In addition to being able to update your user information, you can optionally change your
password at the same time. If you check the “Change Password” box, when the <Update> button
is clicked, the system will expect you to have entered your old password and two instances of
your new proposed password. If the old password matches the one stored in the system, and the
two entries of the new password match, then the system will update your password, otherwise
you will simply get a warning message indicating what needs to be corrected.

Note: If your SpiraTest user profile is linked to an account stored in an external LDAP server, you
may find the change password option is disabled. This is because the system uses the password
held in the external server. To change the password in this case, please contact your system
administrator who will be able to help you change the password in your LDAP environment.
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4. Requirements Management

This section outlines how the requirements management features of SpiraTeam® can be used to
develop a requirements / scope matrix for a project, and how you can map any existing test-
cases to the requirements. Typically when starting a project, developing the requirements list is
the first activity after the Administrator has set up the project in the system.

4.1. Requirements List

When you click on the Planning > Requirements link on the global navigation bar, you will initially
be taken to the requirements list screen illustrated below:

_.‘ i1z Team- Welcome, Fred Bloggs | My Profile | Log Out | Help?
) — My Page Project Home Planning Testing Tracking Reporting
Requirements | Releases | lterstions Role: Manager
dhlnset §3Delefe | o> indent < Quident |—Showlevel— [v]| RyRefesh | CHEG (FEspot |- Showhide columns~ (v] Y Fier
¥ U Requirement Name Test Coverage Task Progress Importance Status Release Difficulty Req # Edit
o | |- ] [m- v] [m- v] - v] [Am-v] [Am- ] Ra| ] [rmer]
0O = T Functional System Requirements Not Covered 1 In Progress RQO0000T [+ Edit |
O = ' Online Library Management System Mot Covered || In Progress. RQO00002Z ,E
0O = Tl Book Management || 1 - Critical Completed RQO00003 [+ Edit_|
0O e ) ability to add new bocks ta the system 1 - Critical Completed 1000 Moderate RQO00004
0 1 Ability to edit existing books in the system 1- Critical Completed 1000 RQ00000S
O B avility to delete existing books in the sys 1- Critical Complated 1.0.00 RQO00006
O f_] A associate books with d 1 - Critical Completed 11.00 ROO000OT
[m] B associate books with d 1 - Critical Complated 1100 RQ000008
O = associate books with d 1 - Critical Completed 11.00 RQO0000Y
0 1 Ability to complstely erase all books 1- Critical Completed 1200 RQ000M10
O # I Edition Management 1 - Critical In Progress RQO00011
0O @ 'l Author Management 2 - High In Progress. ROO00013
[m] & T Subject Management 3 - Medium Planned RQO00019
O % T Administration Functions No Tasks 3 - Medium Requested RQO00022
Shcwlu rows per page « « Displaying page u—. of 10
op Insert  £3 Delete => Indent <5 Outdent

The requirements list consists of a hierarchical arrangement of the various requirements and
functionalities that need to be provided by the system in question. The structure is very similar to
the Work Breakdown Structure (WBS) developed in Microsoft Project®, and users of that
software package will find this very familiar to use. When you create a new project, this list will
initially be empty, and you will have to start using the <Insert> button to start adding
requirements.

Requirements come in two main flavors: summary items shown in bold-type, and detail items
shown in normal-type with a hyperlink. When you indent a requirement under an existing
requirement, the parent is changed from a detail-item to a summary-item, and when you outdent
a child item, its parent will return to a detail-item (assuming it has no other children). This
behavior is important to understand, as only detail items are assigned a status themselves; the
summary items simply display an aggregate of the worst-case assessment of their children’s
status. Also, only detail items can be mapped against test-cases for test-coverage (thus only they
have hyperlinks), the summary items simply display an aggregate coverage status of their
children.

Each requirement is displayed along with its importance/priority (ranked from “Critical” to “Low”),
its completion status (from “Requested” to “Completed”), the version of the software that the
requirement is planned for, and graphical indicators that represents its test coverage status and
its task progress.

For those requirements that have no test-cases covering them (i.e. validating that the requirement
works as expected) the indicator consists of a white solid bar, bearing the legend “Not Covered”.
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For those requirements that have at least one test-case mapped against them, they will display
block graph that illustrates the last execution status of each of the mapped test-cases. Thus if the
requirement is covered by two test cases, one of which passed, and one of which wasn't run, the
graph will display a green bar (50% passed) and an equal length gray bar (50% not run). To
determine the exact requirements coverage information, position the mouse pointer over the bar-
chart, and the number of covering tests, along with the pass / fail / blocked / caution / not-run
breakdown will be displayed as a “tooltip”.

For those requirements that have at least one task associated with them, they will display a block
graph that illustrates the relative numbers of task that are on-schedule (green), late-starting
(yellow), late-finishing (red) or just not-started (grey). These values are weighted by the effort of
the task, so that larger, more complex tasks will be change the graph more than the smaller
tasks. To determine the exact task progress information, position the mouse pointer over the bar-
chart and the number of associated tasks, along with the details of how many are in each status
will be displayed as a “tooltip”.

4.1.1. Insert

Clicking on the <Insert> button inserts a requirement above the currently selected requirement —
i.e. the one whose check-box has been selected, at the same level in the hierarchy. If you want to
insert a requirement below a summary item, you need to insert it first, then indent it with the
<Indent> button. If you insert a requirement without first selected an existing requirement from the
list, the new requirement will simply be inserted at the end of the list.

Once the new requirement has been inserted, the item is switched to “Edit” mode so that you can
rename the default name and choose a priority, status and/or author.

4.1.2. Delete

Clicking on the <Delete> button deletes all the requirements whose check-boxes have been
selected. If any of the items are summary items, then: if the item is expanded and the children are
visible, the children are simply made children of the item above it in the list, however if the item is
not expanded and the children are hidden, then the children are all deleted. This behavior is
similar to that found in project planning tools like Microsoft Project®. In addition, if all the children
are deleted from a summary item, it changes back into a detail item.

4.1.3. Indent

Clicking on the <Indent> button indents all the requirements whose check-boxes have been
selected. If any of the items are made children of a requirement that had no previous children, it
will be changed from a detail item into a summary item.

4.1.4. Outdent

Clicking on the <Outdent> button de-indents all the requirements whose check-boxes have been
selected. If any of the items were the only children of a summary requirement item, then that item
will be changed back from a summary item to a detail item.

4.1.5. Refresh

Clicking on the <Refresh> button simply reloads the requirements list. This is useful as other
people may be modifying the list of requirements at the same time as you, and after stepping
away from the computer for a short-time, you should click this button to make sure you are
viewing the most current requirements list for the project.
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4.1.6. Edit

Each requirement in the list has an <Edit> button display in its right-most column. When you click
this button or just click on any of the cells in the row, you change the item from “View” mode to
“Edit” mode. The various columns are made editable, and <Update> <Cancel> buttons are
displayed in the last column:

P-4 - Welcome, Fred Bloggs | My Profile | Log Out | Loy komatien System ] Help?
sprraTeam oggs | My | Log Out | [Liorery System Help?
E— My Page Project Home Planning Testing Tracking Reporting

Requirements | Releases | lterations Role: Manager
ploset  30eile | >indent < Quident [ —Showlevel— [v] RyRefresh | [Ed @ Epot [-Showlhide colimns— [v] 7 Fiter

v Requirement Name Test Coverage Task Progress Importance Status Release Req# Edit

O [ [-any= W] [-amy- v [caw- ¥] |[caw-  ¥] [-aw- Y| pa[ |

O | = T Functional System Requirements Not Covered 1 In Progress RQO00001

] = T Online Library System HNot Covered | In Progress RQO00002

] = T Book Management | [ Eritical U completed RQO00003

O 0 2 ‘Abililyw add new books to the system |@ . ‘ 1-Crical ¥ I@ |Cawl«a¢ V|@ |1 0.0.0 v|@

+ Cancel

O & ‘Abllilﬂﬂ edit exisiing books in the system | ] ‘1 - Critical v | |Cnrmle1!d Yl |1 0.0.0 Vl

O =8 ‘Abililyw delete existing books in the sysl.e| ‘ 1-Crtcal Y I | Campleted Y| || 0.0.0 Y|

m] ) Ability to associate books with different subiects | _ Completed 1.1.00 RQO00007

] 1 avility to associate books with difterent authors [1-Citieal 1 Completed 1100 RQO00008

0 ) Avilty to associate books with different editions ] [1-Catieal 1 Completed 1100 RQ000009

m] B bility to erase all books stored in th | - Completed 1200 RQ000010

m] & T Edition Management Not Covered | ] In Progress RQO00011

o & 3 Author Management Not Covered 1 m In Progress RQO00013

] @ 2 Subject Management Not Covered 3 Medium Planned RQO00019

0 @ =] Administration Functions Mot Covered No Tasks 3 - Medium Requested RQO00022
ShnwEl rows per page 1 « Displaying page Tof 1m e

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed
on the first row, and you can make changes to all the editable rows and then update the changes
by clicking the one <Update> button. Also, if you want to make the same change to multiple rows
(e.g. to change five requirements from “In Progress” status to “Completed”), you can click on the
“fill” icon to the right of the editable item, which will propagate the new value to all editable items
in the same column.

When you have made your updates, you can either click <Update> to commit the changes, or
<Cancel> to revert back to the original information. Alternatively, pressing the <ENTER> key will
commit the changes and pressing the <ESCAPE> key will cancel the changes.

4.1.7. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily
view the entire requirements list at a specific indent level. For example you may want to see all
requirements drilled-down to the third level of detail. To do this you would simply choose ‘Level 3’
from the list, and the requirements will be expanded / collapsed accordingly.

4.1.8. Filtering
You can easily filter the list of requirements as illustrated in the screen-shot below:




-Sm Team- Welcome, Fred Bloggs | My Profile | Log Out | Help?
— My Paga Project Home Planning Testing Tracking Raporting
Requirements | Rel | herations Role: Manager
Gised  f3Dele | o> ndent GoOudent [—Showlevel— [v| RyReffest | ChEdt (FEwot |- Showihidecolumns- [v]  Fiter
v Requirement Name Test Coverage Task Progress. Importance Status Release Difficulty Req # Edit
o | |- v [aw- v] [aw- ] [reveses v] [aw- v] (- v] pa| | [oower]
4] = T Functional System Reguirements Not Covered 1 In Progress RQO00001
] = T Online Library Management System HNot Covered 1 In Progress RQO00002
O = 5 Author Management Mot Covered 1 In Progress RQO00013
0 B Ability to link authors to their contact informati Mot Covered |2-High  Requested 1.1.00 RQU0001T
(] & T Administration Functions Not Covered No Tasks 3 - Medium Requested RQ000022
@] ) Aility to completely backup the database Mot Covered Mo Tasks 3 - Medium Requested RQO00023
O = "% Data Import Functionality Mot Covered No Tasks 4 Low Requested RQO00024
0o e ) Abilty o import from legacy system x Mot Covered Mo Tasks 4-Low Requested RQ000025
O a Ability to create new users in the system Mo Task 3 - Medium Requested RQ000026
@] ) Awility to modify existing users in the system Mot Covered Mo Tasks 3 - Medium Requested RQO00027
Show |15 ¥ |rows per page 4 - Displaying page[]_l'b of 1 m
e inset {3 Delete | o> indent <o Quident

To filter the list by any of the displayed columns, you either choose an item from the appropriate
drop-down list or enter a free-text phrase (depending on the type of field) then click <Filter> or
press the <ENTER> key to apply the different filters. Note that the name field is searched using a
“LIKE” comparison, so that searching for “database” would include any item with the word
database in the name. The other freetext fields need to be exact matches (e.g. dates,
requirement numbers). In the screen-shot above, we are filtering on Status = Requested.

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose
the option Filter > Save Filter to add the current filter to the list of saved filters that appear on your
‘My Page’. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter:

A~ . Welcome, Fred Bloggs | My Profile | Log Out | Help?
spiraTeam " — e
_— My Page Project Home Planning Testing Tracking Reparting

Requirements | Releases | lterations Role: Manager

fhinsert  §3Delefe | 2 Indent <a Quident RRofesh | [EGK (Expot |-Showhdecours — V| Y Faler
¥ @ Requirement Name Status V' appiy Fiter Ity Req # Edit
O[] | B cmmer b Y] o]
[m] = 'l Functional System Requirements In Progress > Retrieve Filter RQO0000T
0 = T Online Library Management System | In Progress B saverilter RQO00002
0O = Tl Book Management Comp RQO00003
0e 1 Ability to add new baoks to the system Completed 1000 Moderate RO000004
O B2 Ability to edit existing books in the system Completed 1.0.0.0 RQO00005
0O 1 Ability to delete existing books in the system Completed 1000 RQO00006
[m] T Ability to associate books with different subiects Completed 11.0.0 RQO000OT
O s Ability to associate books with different authors Complated 1100 RQO0000
0O T ability to associate books with different editions Completed 1100 RQO00003
O # Ability to completely erase all books stored in th Completed 1200 RQO00010
] & T Edition Management Hot Covered || _ In Progress RQO00011
[m] # T Author Management Hot Covered 1 In Progress RQDOOM3
O # T Subject Management Not Covered 3 - Medium Planned RQO000Y
O ® 7 Administration Functions HNot Covered No Tasks 3 - Medium Requested RQO00022
Show|[15 ¥ | rows per page 4 < Displaying page [1_|%of 15 »
P insent  §3 Delete | o indent < Outdent

4.1.9. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the requirement list as
columns for the current project. To show a column that is not already displayed, simply select that
column from the list of “Show...” column names and to hide an existing column, simply select that
column from the list of “Hide...” column names. This is stored on a per-project basis, so you can
have different display settings for each project that you are a member of. The fields can be any of
the built-in fields or any of the custom properties set up by the project owner.




4.1.10. Copying Requirements

To copy a requirement or set of requirements, simply select the check-boxes of the requirements
you want to copy and then select the Edit > Copy menu option. This will copy the current
requirements selection to the clipboard. Then you should select the place where you want the
requirements to be inserted and choose the Edit > Paste option.

The requirements will now be copied into the destination location you specified. The name of the
copied requirements will be prefixed with “Copy of...” to distinguish them from the originals. Note
that copied requirements will also include the test coverage information from the originals.

4.1.11. Moving Requirements
To move a requirement in the requirements hierarchy, there are two options:
1. Click on the icon the requirement you want to move and then drag the icon to the location

you want it moved. The border between the destination requirements will change as the
icon is dragged over it to illustrate where it will be inserted:

. Team Welcome, Systam Administrator | My Profile | Administration | Log Out | | Library nformaton System w Help?
. - My Page Project Home Planning Testing Tracking Reporting

Requirements | Releases | lterations Role: Project Owner

cdhinsert  §3 Delete | > indemt b Outdent | Showlevel - v| [jRefresh | Chcopy [ Export |- Showihide columns — |v| Y Clear Fiters
+ i Requirement Name Test Coverage  Task Progress Importance Status Author Release Req # Edit
O | [ any - v] [-any- v [ any- ¥| [-any- ¥ [~ any- v RQI | [+ Filter |
O = 2 Functional System Requirements ¢ | In Progress Fred Bloggs RQO00001
O = ZJ Online Library Management System Not Covered | In Progress Fred Bloggs RQO00002
O = 7l Book Management | 1 - Critical Completed Fred Bloggs RQO00003
O e ) Ability to add new books to the system 1 - Critical Completed Fred Bloggs 1000 RQO00004
0 3 Ability to edit existing books in the system 1- Crtical Complated Fred Bloggs 1.0.0.0 RQO00005
O £ Ability to delete existing books in the system 1 - Crtical Completed Fred Bloggs 1.0.0.0 RQO0000E [~ Edit
[m] B2 Apili i | 1- Critical Complated Fred Bloggs 1.1.00 RQO0000T  [Edit |
O 2 Abilit 1- Critical Complated Fred Bloggs 1.1.00 RQO0000E | [+ Edit ]
O (=TT hoaks with &facset aditions 1- Critical Completed Fred Bloggs 1100 RQ000009
0 ') Ability to edit existing books in the *3“‘-’”[?;, || 1 - Critical Complated Fred Bloggs 1200 RQO00010
O # ) Edition Management | | 1. Critical In Progress Fred Bloggs RQO00O11
O % 7 Author Management 1 2. High In Progress Joe P Smith RQO00O1Z | Edit
O # . Subject Management 3 - Medium Planned Joe P Smith RQOOOO1Y | = Edit
O ® 2 Administration Functions k ‘ Ho Tasks 3 - Medium Requested Joe P Smith RQO00022 [+ Edit |
Show [15 ¥ | rows per page 4 < Displaying Daﬂel‘l |,‘ of 10 b

Once you have the requirement positioned at the correct place that you want it inserted,
just release the mouse button and the requirement list will be refreshed, with the
requirement moved to the desired location.

2. Alternatively you can simply select the check-boxes of the requirements you want to
move and then select the Edit > Cut menu option. This will cut the current requirements
selection to the clipboard. Then you should select the place where you want the
requirements to be inserted and choose the Edit > Paste option. The requirements will
now be moved into the destination location you specified.

4.1.12. Exporting Requirements

To export a requirement or set of requirements from the current project to another project in the
system, all you need to do is select the check-boxes of the requirement(s) you want to export and
then click the <Export> button. This will then bring up a list of possible destination projects:
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S}.-)};Ere st- Welcome, Fred Bloggs | My Profile | Log Out | [Livay ifomation Systen ___+] Help?
— My Page Project Home Planning Testing Tracking Reporting

Requirements | Releases Role: Manager

fhinsent  {3Delete | o> indent <oQudemt |-—Showlevel— ~| RyRefiesh | Chcopy @ Expon |- Showhidecoumns-  v| Y ClearFiters
« i Requirement Name [otus Release Difficulty Req # Edit
[} ‘ Export ltems Any - v| [cany- ¥ [-any- ¥| Ra D
i = T Functional System Requirements Please select the project you want to export to: | Progress RQOD00T
(4] = 7 Online Library Systemn Sample Application One = Progress RQ000002
B = T Book Management smpleted RQO00003
¥ @ ) Ability to add new books to the system > Export | Cancel mplated 10.0.0 Moderate RQO00004
[4] B) Ability to edit existing books in the system _T-ﬁmﬂeled 1000 RQ000005
B 22 Awilty to delete existing books in the system Completed 1000 RQ000006
B ) bility to associate books with different subjects | Complated 11.0.0 RQ000007
B ) Ability to associate books with different authors Completed 1100 RQO000008
] ) Ability to associate books with differsnt editions - Complated 1.1.0.0 RQO000009
(] B Avility to erase all books stored in th || Completed 1200 RQO00010
B 7 Edition Management Mot Covered In Progress RQO0011
B & 7 Author Management MNot Covered In Progress RQO00013
B & T Subject Management Mot Covered 3 - Medium Planned RQO00019
B ® B Administration Functions MNot Covered 3 . Medium Requested RQOD0022

st  §3Delete | > Indent <o Quident

Once you have chosen the destination project and clicked the <Export> button, the requirements
will be exported from the current project to the destination project. Any file attachments will also
be copied to the destination project along with the requirements.

4.2. Requirement Details

When you click on a requirement item in the requirements list described in section 4.1, you are
taken to the requirement details page illustrated below:

A~ . Welcome, Fred Bloggs | My Profile | Administration | Log Out | Help?
spiraTeam
o My Page Project Home Planning Testing Tracking Reporting
Requirements > Requirement Details | Releases | lterations Role: Manager
<< Back to Requirements List | Elsave cpSaveandNew §3 Delete | [2Refresh (5 Print
T2 Book Management Requirement: Ability to add new books to the system [RQ:000004)
e e
EAbll'ww“d new books to the system Name*: I.ﬁbilib,'lc add new books to the system |
T Ability to edit existing books in the sy... G
ripti Fart - - G - == -
ﬂﬂilﬂytodelmaemsﬂmbwksinthe... S | Fort 'l | Sae " BJU |"’|L.-ﬂ¥|1‘ﬂﬁl =E0e@
a'lemlng to associate books with differan._ The ability to add new books into the system. complete with ISBN. publisher and other related information
) ity to associate books with differen
&) Ability to associate books with differen
ElAI:lIdy to completely erase all books st...
Imponance: [ 1+ Critical v } Author: ‘ Frad Blagge v]
Status": IComlsm v 1 Release: “_ILD_D;M.M:&G_‘ v |
Created On:  12/1/2003 12:00:00 AM Owner: ‘Joe P Smith !'|
Last Updated:  12/1/2003 12:00.00 AM Planned Effo: 15 |hows[D | minutes
Test Coverage Tasks = Custom Props * Attachments ® Histery ® Agsocistions ®

This page is made up of three areas; the left pane displays the requirements list navigation, the
top of the right pane displays the details of the selected requirement, and the bottom of the right
pane can display different information related to the requirement.

The navigation pane consists of a link that will take you back to the requirements list, as well as a
list of the peer requirements to the one selected. This latter list is useful as a navigation shortcut;
you can quickly view the coverage information of all the peer requirements by clicking on the
navigation links without having to first return to the requirements list page.

The top part of the right pane allows you to view and/or edit the details of the particular
requirement. You can edit the various fields (name, description, etc.) and once you are satisfied
with them, simply click either the <Save> or <Save and New> button at the top of the page to
commit the changes. In addition you can delete the current artifact by choosing <Delete>, discard
any changes made by clicking <Refresh> or print it by clicking <Print>.




In addition, the bottom part of the right pane can be switched between six views: “Test
Coverage”, “Tasks”, “Custom Properties”, “Attachments”, “History” and “Associations”, each of
which will be described in more detail below.

4.2.1. Test Coverage
In this mode, the right pane contains the test coverage information for the requirement in

guestion:

Test Coverage # Tasks #* Custom Props # Attachments # Hiztory # Associations #

Available Test Cases: Test Coverage:
v | Name v |Test# | Name Status
[] =C3Functional Tests - [] TCoo0ooo02 A_'I,"-‘Ahilit\,' to create new boaok Failed

8w ty to create new book [ TCO00008 £9pook management Passed
O £ Ability to edit existing book [ TC000013 £ Adding new book and author to Mot Run
O £ Ability to create new author [[Remove< |
O 5 Ability to edit existing autho._.
O 3| Ability to reassign book to di__.
[ =2 Regression Tests
[] =& Scenario Tests
b

> Create Test Case From This Requirement LY

The test coverage box indicates the test cases that are currently mapped against the requirement.

To add test cases to this requirement, choose from the list above and click [Add].

You can use the [Remove] and [Remove All] buttons to remove tests that no longer cover the requirement.

The pane consists of two lists of test cases, the one on the left being the hierarchical list of the
test cases belonging to the project arranged in test folders. The right box (which will initially be
empty) contains the list of test cases mapped to this requirement. The test cases in this box
include columns for their ID, name and execution status. Hovering the mouse over the names of
the test cases in either box will display a “tooltip” consisting of the test case name, place in the
folder structure and a detailed description. Clicking on the hyperlinks in right-hand box will jump
you to the test case details screen for the test case in question (see section 5.2.9).

To change the coverage for this requirement, you use the buttons (Add, Remove, Remove All)
positioned between the two list-boxes. The <Add> button will move the selected test cases from
the list of available on the left to the list of mapped on the right. Similarly the <Remove> and
<Remove All> buttons will remove either the selected or all the test cases from the right list-box
and add them back to the left list-box.

Finally, as a shortcut you can click the “Create Test Case from This Requirement” link to create a
new test case in the list of covered test cases that will be automatically linked to this requirement.
This is useful when you have created a new requirement and want to generate an initial covering
test to be fleshed-out later.

4.2.2. Tasks

In this mode, the right pane displays the list of project tasks that need to be completed for the
requirement to be satisfied:

Test Coverage # Tasks # Custom Props # Atftachments # History # Aszszociations #
v Task Name Progress Status Iteration Owned By Priority Est/ Actual Task#
O oh New Task £2 Remove £3 Delete 2] Refresh Est. Effort: 16.0h / Actual Effort: 15.5h
[0 ¥ Develop new book entry screen Completed | 1.0.0.0.0001 | Fred Bloggs | 1-Crtical  5.0h/7.3h TKO00001
[ ¥ Create book object insert method Completed | 1.0.0.0.0001 | Fred Bloggs | 1-Crtical  5.0h/5.3h TK000002
[0 #% Write book object insert queries Completed | 1.0.0.0.0001 | Fred Bloggs | 1-Crtical  3.0h/2.8h TK000003
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Each of the tasks is displayed together with its name, description (by hovering the mouse over
the name), progress, priority, start-date, current owner, estimated effort, actual effort and numeric
task identifier. Clicking on the task name will bring up the Task Details page which is described in
more detail in section 8.2. This allows you to edit the details of an existing task.

You can perform the following actions on a task from this screen:

» New Task — inserts a new task in the task list with a default set of values. The task will be
associated with the current requirement.

Remove — removes the task from this requirement without actually deleting the task

Delete — deletes the task itself.

4.2.3. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
requirements. To learn more about how to setup and configure custom properties for a project,
please refer to the SpiraTest Administration Guide. Assuming that custom properties have been
defined for your project, you will see a list of optional parameters that can be set on the
requirement. These can be either freetext or drop-down-lists. In the example below, you can enter
a URL, difficulty and/or Requirement Type.

Test Coverage # Tasks # Custom Props # Attachments # Hiztory # Aszsociations #
Please edit the following custom properties of this artifact and click [Update] when finished:

URL: nttp://www.libraries.org

Difficulty: [Moderate -]

Requirement Type: ‘ —MNone — - |

Once you are satisfied with the values for the custom properties, simply click [Update] to commit
the changes.

4.2.4. Attachments

In this mode, the main pane displays the list of documents or web-links (URLS) that have been
“attached” to the requirement. The documents can be in any format, though SpiraTeam® will only
display the icon for certain known types.
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Test Coverage # Tasks # Custom Props # Attachments # Higtory # Associations %
Document Name Type Size Uploaded By Upload Date ¥
B Book Management Functional Spec doc File 285 KB Fred Bloggs 2-May-2006
T2 Graphical Design Mockups psd File 1,009 KB Joe P Smith 1-May-2006
€| URL to related information URL 0KB Fred Bloggs 1-May-2006
4 Book Management Screen Wireframe ai File 392 KB Joe P Smith 2-Mar-2005
Upload New Document/URL
Type: @® File O URL
Filename:* | ” Browse... |
Description: | |

The attachment list includes the filename/URL that was originally uploaded together with the file-
size (in KB), name of the person who attached it and the date uploaded. In addition, if you
position the pointer over the filename and hold it there for a few seconds, a detailed description is
displayed as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser
window will open. Depending on the type of file, this window will either display the document /
web-page or prompt you for a place to save it on your local computer. To delete an existing
attachment from a requirement, simply click the <Delete> button and the attachment will be
removed from the list.

To attach a new document to the requirement, you need to choose “File” as the type and then
click the Browse button and select the file from your local computer, optionally enter a detailed
description then click the <Upload> button. The document will be copied from your computer and
attached to the requirement. To attach a web-link (URL) to the requirement, you need to choose
“URL" as the type and then enter the fully qualified URL (e.g.
http://mywebsite.com?Document=1), an optional description and then click the <Upload> button
to attach the web-link.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file
extensions on filenames (e.g. .xls for an Excel sheet) automatically, then you will need to
manually add the file extension to the filename before uploading if you want it to be displayed with
the correct icon in the attachment list.

4.2.5. History

In this mode, the main pane displays the list of changes that have been performed on the
requirement artifact since its creation. An example requirement change history is depicted below:

Test Coverage # Tasks # Custom Props # Attachments # History # Aszsociations #
Change Date ¥ Field Name Old Value New Value Changed By
5/2/2006 12:00:00 AM Status In Progress Completed Fred Bloggs
3/4/2005 12:00:00 AM Status Requested In Progress Joe P Smith

The change history displays the date that each change was made, together with the fields that
were changed, the old and new values and the person who made the change. This allows a
complete audit trail to be maintained of all changes in the system.
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4.2.6. Associations

In this mode, the main pane displays a list of any incidents or other requirements that are
associated with this requirement:

Test Coverage # Tasks # Custom Props # Attachments #* Hiztory # Associations #
v Date Artifact Name Created By Comment Artifact Type Artifact #
qp Add 3 Delete
14-Mar-2004 | B Cannot install system on Oracle i Fred Bloggs | This bug affects the requirement Incident IMO0000S

12-Mar-2004 | & Ability to delete existing books in the system Fred Bloggs | These two requirements are related Requirement | RQ000006
4-Nov-2003 Cannot add a new book to the system Joe P Smith | Test Run: Ability to create new book | Incident IMO000O7

The requirements in this list are ones that a user has decided are relevant to the current one and
has created a direct link between them. In the case of incidents, the association can be either due
to the creator of an incident directly linking the incident to the requirement, or it can be the result
of a tester executing a test-run and creating an incident during the test run. In this latter case, the
check-box to the left of the association will be unavailable as the link is not editable.

Each association is displayed with the type of artifact (requirement vs. incident), name of the
artifact being linked-to, the name of the person who created the association, and a comment that
describes why the association was made. In the case of an indirect association due to a test run,
the comment will contain the name of the test run.

To create a new association, simply click the <Add> icon and then choose the type of artifact you
want to create an association to:

Add New Association (Step 1 of 2)
Please choose the artifact that you want to add an association to:

@ Requirement Incident

|- Next | |- Cancel |

Once you have selected the appropriate artifact type, you will then be able to choose the specific
artifact you want to link to. In the case of requirements you choose the item from a hierarchical
list-box, and in the case of incidents you can either enter the incident ID or choose from a list of
incidents you have recently submitted. In either case you can also add a comment that explains
the rationale for the association:

Add New Association (Step 2 of 2) Add New Association (Step 2 of 2)
Please choose the requirement that you want to add an association to: Please choose the incident that you want to add an association to:
- @  Enterlncident & |y |

bility to edit existing books in the system

bility to delete existing books in the system

-« Ability to associate books with different subjects

-« Ability to associate books with different authors
- Ability to associate books with different editions

-« Ability to completely erase all books stored in the system with one click  ~

Add from history: Sample Risk 1 g
Sample Risk 2 -
Sample Risk 3
Test Change Request
TestChange Request
TestChange Request
L Test Change Request
TestChange Request
Comment Test Changg Fle:uasl

Comment:

< Back | [~ Add | [~ Cancel
< Back | |» Add | |» Cancel

Finally, to delete an existing association (except for those due to test runs) select the check-box
next to its name and click the <Delete> icon. This will only delete the association, not the linked
artifact itself.
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5. Test Case Management

This section outlines how the use-case / test-case management features of SpiraTest® and
SpiraTeam® can be used to develop the business use-cases for the system, which specify how
the different pieces of functionality are expected to work in practice. In addition, these use/test-
cases form the basis of the business specification of the system when associated with the
underlying requirements matrix. Typically when starting a new project:

> The requirements matrix is entered first

» Then the list of use-cases is developed to outline the key scenarios that need to
supported to implement the requirement

» Then the use-cases are fleshed out into full test-cases by adding the detailed test-steps
with the expected result and suggested sample-data

> Finally the tests are grouped into test-sets so that they can be assigned to users in
batches for execution and tracking.

However when migrating existing projects into SpiraTeam®, you may need to migrate the test-
case list first, and then add the supporting requirements matrix afterwards.

5.1. Test Case List

When you click on the Testing > Test Cases link on the global navigation bar, you will initially be
taken to the test case list screen illustrated below:

. - Welcome, Fred Bloggs | My Profile | Log Out Help?
. T eam ggs | | | [Lrary informatin System Help?
My Page Project Home Planning Testing Tracking Reporting

Test Cases | Test Sets Role: Manager I

Pinset §3Deiete | > indent < Quident |- Showlevel— v| BjRefresh | ChEedt {fToos |- Showhidecolumns- v| Y7 Fiter

Displaying 9 out of 11 test case(s) for this release Display data for: |- All Releases - [v]

v i Test Case Name Execution Status Owner Last Executed Author Active Test # Edit

a [ [~ any— v] [cAw- v| [ m [—any - v [cany—¥ 1| | [Fner |
O = B Functional Tests (5) || Fred Bloggs 1.Dec-2003 Fred Bloggs Yes TCO00001
o |e &9 Ability to create new book Failed 4-Dec-2003 Fred Bloggs Yes TCO00002
O L7 Ability to edit existing book Caution Fred Bloggs 1-Dec-2003 Fred Bloggs Yes TCO00003
o |e £ pbility to create new author Failed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00004
O a‘_]Ahu:u:- to edit existing author Blocked Joe P Smith 1-Dec-2003 Fred Bloggs Yes TC000005
O £3 Avility to reassign book to different author Passed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00006
(] & £ Regression Tests (2) 1.Dec.2003 Joe P Smith Yes TCO00007
] E B Scenario Tests [2) Joe P Smith Joe P Smith Yes TC000010
O =@ Exception Scenario Tests (1) Joe P Smith Joe P Smith Yes TCO00011
[m] 29 Person loses book and needs to report loss Hot Run Joe P Smith Yes TC000012
O £ Adding new book and authar to librany Mot Run Joe P Smith Yes TCO00013
(] =B Common Tests (2) 1.Dec-2003 Fred Bloggs Yes TC000015
4] 49 Open Up ¥ I Passad 1-Dec-2003 Fred Bloggs Yes TCO00016
[3] &9, agin to Application Mot Run 1-Dec-2003 Fred Bloggs Yes TCO00017
srm.vE rows per page « « Displaying page D" of 10 p

The test case list consists of a hierarchical arrangement of the various test folders and test cases
that the system being developed needs to be able to demonstrate. The structure is very similar to
the folder structure in Microsoft Windows® Explorer, and users will find this very familiar and
intuitive to use. When you create a new project, this list will initially be empty, and you will have to
use the <Insert> button to start adding test folders and test cases to the system.

The list consists of test folders shown with a folder icon and in bold-type, and test cases that are
shown with a document icon and a hyperlink. You can nest test folders and test cases under an
existing test folder, but you cannot nest anything under a test case. All of the items in the list have
a name, together with the most recent execution status (passed, failed or not-run), and owner,
author, execution date, active flag and test case number. Clicking on a test case’s hyperlink will
take you to the test case details page for the item in question (see section 5.2).
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It is important to understand that only test cases are assigned a status themselves; the test
folders instead display a test execution bar graph that illustrates the aggregate execution status
of its child test-cases. Thus if the test folder contains two test cases, one of which passed, and
one of which wasn't run, the graph will display 50% green and 50% gray.

To determine the exact aggregate test folder execution status information, position the mouse
pointer over the bar-chart, and the number of tests in each of the execution statuses (passed,
failed, not-run, blocked, caution) will be displayed as a “tooltip”. Note that if you change the owner
of a test folder, then all the child test cases will be assigned the same owner. This allows you to
more easily associate entire folders to test cases to be executed by a specific user.

5.1.1. Insert

Hovering over the <Insert> button brings up a secondary menu that allows you to choose whether
to insert a test case or a test folder (if you just click Insert it defaults to inserting a test case). In
either case, it will insert the new test folder / test case above the currently selected item — i.e. the
one whose check-box has been selected, at the same level in the hierarchy. If you want to insert
a new test case below an existing test case, you need to select the item below it. If you insert a
new test folder / test case without first selected an existing item from the list, the new test case
will simply be inserted at the end of the list.

Once the new test folder / test case has been inserted, the item is switched to “Edit” mode so that
you can rename the default name and choose an owner and/or author. Note that all new test
cases are initially set with an execution status of “Not Run”.

5.1.2. Indent / Outdent

Clicking on the <Indent> button indents all the test folders / test cases whose check-boxes have
been selected. You cannot indent a test case or folder if it is below a test case, as test cases are
not allowed to have child items. Clicking on the <Outdent> button de-indents all the test folders /
test cases whose check-boxes have been selected.

5.1.3. Delete

Clicking on the <Delete> button deletes all the test cases and/or test folders whose check-boxes
have been selected. If any of the items are test folders, then all the children are all deleted
(whether test cases or folders). This behavior is similar to that in Microsoft Windows® Explorer.

5.1.4. Execute

Clicking on the <Execute> button executes all the test cases selected, together with all the test
cases contained with any selected test folders. The test execution functionality of SpiraTeam® is
explained in more detail in section 5.3.

5.1.5. Refresh

Clicking on the <Refresh> button simply reloads the test case list. This is useful as other people
may be modifying the list of test cases at the same time as you, or executing specific test cases,
and after stepping away from the computer for a short-time, you should click this button to make
sure you are viewing the most current test case list for the project.

5.1.6. Edit

Each test case in the list has an <Edit> button display in its right-most column. When you click
this button or just click on any of the cells in the row, you change the item from “View” mode to
“Edit” mode. The various columns are made editable, and <Update> <Cancel> buttons are
displayed in the last column:
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o S Team‘ Welcome, Fred Bloggs | My Profile | Log Out | [Liry rfemation System  [w] Help?
h - My Page Project Home Planning Testing Tracking Reporting
e R T e nager |

dpinsent £} Delete o> Indent  <h OQuident |- Show Level - |v| B Refresh Chedt {BToos |- Showhide columns~ w| Y/ Filter

Displaying 9 out of 11 test case(s) for this release Display data for: | All Releases - q

¥ 4 Test Case Name Execution Status  Owner Last Executed  Author Active Test# Edit

O B I = O ) . | e N

=] = B Functional Tests {5) I Fred Bloggs 1-Dec.2003 Fred Bloggs Yes TCO00001 [+ Edit |

O e &J_Ablllty to create new book |0 Failed ’ﬁ@ 4-Dec-2003 ZWE :’9! M
O .&J_ﬂblhw to edit existing book | Caution Fred Bloggs V| 1-Dec-2003 FredBloggs V| [vee v

Ole B ity 10 create new auther Failed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00004  [SEdit |

O £ ability 10 edit existing author Blocked Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00005 [+ Edit |

O £ Ability to reassign book to different auther Passed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00006 [+ Edit |

O # 3 Regression Tests (2) 1-Dec-2003 Joe P Smith Yes TC000007 v Edit ]

[3 = B Scenario Tests (2) Joe P Smith Joe P Smith Yes TC000010 [+ Edit |

O =B Exception Scenario Tests (1) Joe P Smith Joe P Smith Yes TC000011 E

O £ Person loses book and needs to report loss Mot Run Joe P Smith Yes TC000012 [+ Edit |

O B aaa ng new book and auther to library Mot Run Joe P Smith Yes TCO00013  |» Edit

0 = & Common Tests (2) 1-Dec-2003 Fred Bloggs Yes TC000015 [+ Edit |

O L open Up Wab Browser Passed 1-Dec-2003 Fred Bloggs Yes TCO00016 E

O ) Login to Application Not Run 1-Dec-2003 Fred Bloggs Yes TC000017  [FEdi |

Shew [E fows per page “ « Displaying page u'a of 1 &

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed
on the first row, and you can make changes to all the editable rows and then update the changes
by clicking the one <Update> button. Also, if you want to make the same change to multiple rows
(e.g. to change the owner of five test cases from “Fred Bloggs” to “Joe Smith”), you can click on
the “fill” icon to the right of the editable item, which will propagate the new value to all editable
items in the same column.

When you have made your updates, you can either click <Update> to commit the changes, or
<Cancel> to revert back to the original information. Alternatively, pressing the <ENTER> key will
commit the changes and pressing the <ESCAPE> key will cancel the changes.

5.1.7. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily
view the entire test case list at a specific indent level. For example you may want to see all test
cases drilled-down to the third level of detail. To do this you would simply choose ‘Level 3’ from
the list, and the test cases will be expanded accordingly

5.1.8. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the test case list as
columns for the current project. To show a column that is not already displayed, simply select that
column from the list of “Show...” column names and to hide an existing column, simply select that
column from the list of “Hide...” column names. This is stored on a per-project basis, so you can
have different display settings for each project that you are a member of. The fields can be any of
the built-in fields or any of the custom properties set up by the project owner.

5.1.9. Filtering
You can easily filter the list of test cases as illustrated in the screen-shot below:
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T . Welcome, Fred Bloggs | My Profile | Log Out | [Lirry Wemation System  [w] Help?
spfraTeam oggs | My Profile | Log Out | ystem Help?
o My Page Project Home Planning Testing Tracking Reporting
TestCases | Te Role: Manager
Guset G3ose | Do < Ousem | Showlovel- v] @R | QIE® (H%os |-Srowheocobmns- v] V Fllr
Displaying T out of 7 test case{g) for this release Display data for: | - All Releases - ﬂ
v @ TestCase Name Execution Status  Owner Last Executed Author Active Test# Edit
D | \Er- v fooe ) [ @) [ v [aw-v] 7c[ ]
O E B Functional Tests (5) | Fred Bloggs 1.Dec.2003 Fred Bloggs Yos TCO00001
O @  Elabiity to create new book Failed 4Dec-2003 Fred Bloggs Yes TC000002
[3] = B> Regression Tests (2) 1.Dec-2003 Joe P Smith Yes TCO00007
O 23 Book management Passed 1-Dec-2003 Joe P Smith Yes TCO00008
O 3 Author management Passed 1-Dec-2003 Joe P Smith Yes TCO00009
O E B Scenario Tests (2) Joe P Smith Joe P Smith Yos TCO00010
O = By Exception Scenario Tests (1) Joe P Smith Joe P Smith Yes TC000011
O £)Person loses book and needs to report loss Nt Run Joe P Smith Yes TC000012
0O 23 Adding new book and author to library Hot Run Joe P Smith Yes TCOO0013
O = By Common Tests (2) 1.Dec.2003 Fred Bloggs Yos TCOO0015
O %3 Open Up Web Browser Passed 1-Dec-2003 Fred Bloggs Yes TCO00016
O %1 Login to Application Met Run 1-Dec-2003 Fred Bloggs Yes TCO00017
Show ToWs per page 4« Displaying page [T |%of 15
dhinset {3 Delete | > indent < Ouident | [> Execute

To filter the list by any of the displayed columns, you either choose an item from the appropriate
drop-down list or enter a free-text phrase (depending on the type of field) then click <Filter> or
press the <ENTER> key to apply the different filters. Note that the name field is searched using a
“LIKE” comparison, so that searching for “database” would include any item with the word
database in the name. The other freetext fields need to be exact matches (e.g. dates, test case
numbers). In the screen-shot above, we are filtering on Owner = (None).

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose
the option Filter > Save Filter to add the current filter to the list of saved filters that appear on your
‘My Page’. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter:

— . Welcome, Fred Bloggs | My Profile | Log Out | Help?
spiraTeam
My Paga Project Home Planning Testing Tracking Raporting
Test Cases | Te: Role: Manager
dhiosent  3psele | o dent <o Quident RyRerest | GhEdt i Tos Y Fier
Displaying 4 out of 11 test case(s) for this release Display v Apply Filter — VI
¥ 0 TestCase Name Save Filter % Author| $2 0o Fitter Test # Edit
O ‘ Please choose a name for this filter g i i Zl Tc l:l
O = B Functional Tests (5) |Dec-2003 - TC000001
O £ aility to reassign bk to different author | | Dec-2003 TC000006
O = B Regression Tests (2) > Save | Cancel |Dec-2003 Joe P Smith Yes TCO00007
O 3 Book management “Passed “Dec-2003 Joe P Smith Yes TC000008
O £ Author management Passed 1.Dec-2003 Joe P Smith Yes TC000009
O =By Common Tests (2) 1.Dec-2003 Fred Bloggs Yes TCO00015
O £9 Open Up Web Browser Passed 1-Dec-2003 Fred Bloggs Yes TCO00016
Show (15 ¥ | rows per page 4« Displaying pugell_lﬁ of 1w
dfinset  §3Delete | o> ndent < Outdent | [> Exeate

5.1.10. Copying Test Cases

To copy one or more test cases, simply select the check-boxes of the test cases you want to copy
and then select the Edit > Copy menu option. This will copy the current test case selection to the
clipboard. Then you should select the place where you want the test cases to be inserted and
choose the Edit > Paste option.

The test cases will now be copied into the destination location you specified. The name of the
copied test cases will be prefixed with “Copy of...” to distinguish them from the originals.

5.1.11. Moving Test Cases
To move test cases in the hierarchy, there are two options:




1. Click on the icon the test case/folder you want to move and then drag the icon to the
location you want it moved. The background of the destination location will change as the
icon is dragged over it to illustrate where it will be inserted:

Eﬁ‘aream- Welcome, System Admini | Wy Profile | Administralion | Log Oul | | Lbrary nformation System ] Help?
R My Page Project Home Planning Testing Tracking Reporting
TestCases | TestS Role: Project Gwner
dhisert  §3Delete | o indent < Ouident | Showlewel- v| BiRefiesh | fTools [> Execute W Clear Fiters
Displaying 9 out of 13 test case{s) for this release Dieplay data for: | ~— Al Releases — [¥]
« @ TestCase Name Execution Status Owner LastExecuted  Author Active Test# Edit
ol |l |Ean—v] [Cam-_¥] | B - v [a- v e[ ]
0 E B Functional Tests {5) | | Fred Bloggs 1.Dec.2003 Fred Bloggs Yes TCO00001
0o |e § Passed Fred Bloggs 1-Dec-2003 Frad Bloggs Yo TCO00002
0 Fred Bloggs 1-Dec-2003 Frad Bloggs Yes TC000003
0 8 & Abiy new author _ Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00004
O &) Ability to edit existing author Blocked Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00005
o 1 pbility 10 reassign book to different author Passed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TC000006
(] = E> Begression Tests (2) 1.Dec-2003 Joe P Smith Yes TC000007
O £ Book management Passed 1-Dec-2003 Joe P Smith Yes TC000003
(] £ puthor management Passed 1-Dec-2003 Joe P Smith Yes TCO00009
O 0 Scenario Tests (2) Joe P Smith Joe P Smith Yes TCO00010
0 E B> Common Tests (2) 1-Dec-2003 Fred Bloggs Yes TCO00015
O % Open Up Web Browser Net Run 1-Dec-2003 Fred Bloggs Yes TCO00016
m| &3 ogin 1o Application Passed 1-Dec-2003 Fred Bloggs Yas TC000017
Show fows per page 4« Displaying page [1_|%af 155
fhimsert 3 Dekte | o> invent <o Ougent | [> Exeae

Once you have the test case/folder positioned at the correct place that you want it

inserted, just release the mouse button and the test case list will be refreshed, with the
item moved to the desired location.

2. Alternatively you can simply select the check-boxes of the test cases you want to move
and then select the Edit > Cut menu option. This will cut the current test case selection to
the clipboard. Then you should select the place where you want the test cases to be
inserted and choose the Edit > Paste option. The test cases will now be moved into the
destination location you specified.

5.1.12. Exporting Test Cases

To export a test case or set of test cases from the current project to another project in the system,
all you need to do is select the check-boxes of the test case(s) you want to export and then click
Tools > Export Tests. This will then bring up a list of possible destination projects:

“m Tes t. Welcome, Fred Blo.ggs | My Profile | w | - Help?
—— My Page Project Home Planning Testing Tracking Reporting

Test Cases | Test Sets Role: Manager

et 3Dsiels | o lndent <o Ouidont |- Showlevel- ~| GRofist | §iToos [>Exeote |- Showlhide columns- v 7 CloarFiters

Displaying 7 out of 7 test case(s) for this release Display data for: | 1.0.1.0- Library System Release 1SP1 + |
¥ 4 TestCase Name Export ltems recuted Author Active Test# Edit
o | Flease select the project you want to export to @ |_My_ 'l |_A"y_ 'I TC:]
4] = B Functional Tests (5) ) 003 Fred Bloggs Yes TCO00001
@ e £ Ability to create new book L-SelectProject— i> po03 Fred Bloggs Yes TCO00002
] L Ability to edit existing book > Export | Cancel  P003 Fred Bloggs Yes TC000003
B e L) ability to create new author o T e T 0 Fred Bloggs Yes TCO00004
B &Y it / to edit existing author Blocked Joe P Smith 1-Dec-2003 Fred Bloggs Yoz TCO00005
5] & ability to reassign book to diflerent author Passed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00006
4] [=l B Regression Tests (2] 1-Dec-2003 Joe P Smith Yes TCO0000T
(4] 23 Book management Passed 1-Dec-2003 Joe P Smith Yes TCO00008
B 23 Author management HNot Run 1-Dec-2003 Joe P Smith Yes TCO00009
[a] = Common Tests (0) 1.Dec-2003 Fred Bloggs Yes TCO00015

dpinset {3 Delete | < indent < Ouident | [> Execuls




Once you have chosen the destination project and clicked the <Export> button, the test cases will
be exported from the current project to the destination project. Any file attachments will also be
copied to the destination project along with the test cases.

5.1.13. Adding Test Cases to a Release or Test Set

To quickly add a series of test cases to either a Release or Test Set, all you need to do is select
the check-boxes of the appropriate test cases and then click Tools > Add to Release / Test Set.
This will then bring up a dialog box displaying either a list of available releases, or a list of
available test sets (depending on which option was chosen):

Smrest. Welcome, Fred Bloggs | My Profile | Log Out | Help?
— My Page Project Home Planning Testing Tracking Reporting
Test Cases | Test Sets Role: Manager
dpinset  $3Delele | o> indent <h Quident RRefiesh | iToos [> Exeate Y Clear Fters
Displaying T out of T test case(s) for this release Display data for: | 1.0.1.0- Library System Release 1SP1 -
v W TestCase Name Add To Test Set Executed Authar Active Test# Edit
4 Please select the test set you want to add to joes_B) | |_Mv_ ' ‘ I_M,_ T | TCI:|
[a] = B Functional Tests {5) £-2003 Fred Bloggs Yes TCO000M
@ (8| ) abiity to creste new book ! v ko3 Frad Bloggs Yes TCo00002
] £ abilty to edit existing book Testng vﬁe ease 10 2003 Fred Eloggs Yes TCo00003
m |e & Ability to create new author Testing Cycle for Release 1.1 2003 Frad Bloggs Yes TCO00004
4] £ ability to edit existing author 2:::::2: I:ggg :::m::mé‘;ﬁ -Dec-2003 Fred Bloggs Yes TCO00005
B &) Ability to reassign book to different author P Testing New Functionality Dec-2003 Fred Bloggs Yes TCO00006
51 98 Regression Tests 2 ooy Testng | pec.o003 Joe P Smith Yos TCO00007
] £ Book management Passed 1-Dec-2003 Joe P Smith Yes TCO00008
1 3 author management Not Run 1-Dec-2003 Joe P Smith Yes TC000009
B = B Comimon Tests (0) 1.Dec-2003 Fred Bloggs Yes TCO00015
cpinset {3 Delele | <> indent o OQuident | [> Exeate
e

Once you have chosen the destination release / test set, clicking <Add> will add the selected test
cases to the destination release / test set.

5.1.14. Viewing the Test Status for a Release

By default, when you view the list of test case cases, it will display an aggregate status for all
releases of the project. l.e. the test list will include all the test cases in the system (regardless of
which release they apply to) and the execution status will reflect the most recent test run —
regardless of which release it was for.

To change the test case list to just display test cases and execution status for a particular
release, simply change the release selected in the drop-down list located below the toolbar (on
the right-hand side) from “Any” to a specific release:

e . Welcome, Fred Bloggs | My Profile | Administration | Log Out | Help?
spiraTeam
— My Page Project Home Planning Testing Tracking Reporting
Test Cases | Test Sel Role: Manager
Sinset  G3Deiete | > indent < Outdent % Refresh | (HEdt {3 Toos W Fiter
Displaying 7 out of 7 test case(s) for this release Display data for: [10.4.0- L 1581 v|
¥ @ TestCase Name Execution Status Owner Last Executed Author Active Test # Edit
o) |l |[Aer- ¥] [A- Y] ] [ T | R S
m] = B Functional Tests (5) Fred Bloggs Fred Bloggs Yes TCO00001
0o e 4 Ability to create new book Passed Fred Bloggs 1-Dec-2003 Fred Bloggs Yes TC000002
(] £ Ability to edit existing book Mot Run Fred Bloggs Fred Bloggs Yes TCo00003
o |e £ pbilty to create new author Mot Run Joe P Smith Fred Bloggs Yo TC000004
@] £ Ability to edit existing author Blocked Joe P Smith 1-Dec-2003 Fred Bloggs Yes TCO00005
O 3| Ability to reassign book to different author Passed Joe P Smith 1-Dec-2003 Fred Bloggs Yes TC000008
] E B> Regression Tests (2) Joe P Smith Yes TCO00007
O £ Book management Passed 1-Dec-2003 Joe P Smith Yes TC000008
] 53 Author managament Mot Run Joe P Smith Yes TC000009
Show |15 v |rows per page 1 4 Displaying page[]_l'a of 1 &
chuset  {3Deete | > moent < Ougent | [> Exeate




As illustrated in the example above, when the drop-down list is changed to select a specific
release, the list of test cases is filtered to just those mapped to the release in question. In
addition, the execution status for the test releases will only reflect test runs for that specific
release (and any child iterations if applicable). As can be seen in our example, many test cases
that have been run for other releases now show the “Not Run” status since they’ve not been run
for this specific release.

As a shortcut, when you select a specific release for viewing, subsequent execution of any of the
test cases via the Tools > Execute menu option will default the test run to the selected release.

5.2. Test Case Details

When you click on a test case item in the test case list described in section 5.1, you are taken to
the test case details page illustrated below:

Welcome, Fred Bloggs | My Profile | Administration | Log Out | |Ubrary Infomation System v Healp?

: Team

My Page Project Home Planning Testing Tracking Reporting

Test Cases > Test Case Details | Test Sets

<< Back to Test List

B Functional Tests
£ ability to create new book
3| Ability to edit existing book
L_'lﬂ,bmt)- to create new author
£ aility to edit existing autho

[E)save <<hsaveandNew 3 Delete [ Refresh

Test Case: Ability to create new book [TC:000002]

Name®:

Description:

[Ability to create new book

> Execute () Print

Role: Manager

- Font - v| [-Swe- ¥

BIU|E=E=]|;}

S| B | —epOoe@

Tests that the user can create a new book in the system

Author*: [FredBioges ¥ Estimated Time lui hours M—| minutes
Owmer FredBoges V| Creation Date 12/1/2003 12:00:00 AM

Priority: 1 - Crtieal v Execution Status Failed

Active™: [fes v Execution Date: 12/4/2003 3:40:01 AM

Test Steps * Req Coverage ® Custom Props % Test Runs * Releases ® Aftachments ® History

This page is made up of three areas; the left pane is the navigation window, the upper part of the
right pane contains the test case detailed information itself, and the bottom part of the right pane
contains related information about the test case.

The navigation pane consists of a link that will take you back to the test case list, as well as a list
of the peer test case to the one selected. This latter list is useful as a navigation shortcut; you can
quickly view the detailed information of all the peer test cases by clicking on the navigation links
without having to first return to the test cases list page.

The top part of the right pane allows you to view and/or edit the details of the particular test case.
You can edit the various fields (name, description, etc.) and once you are satisfied with them,
simply click either the <Save> or <Save and New> button at the top of the page to commit the
changes. In addition you can delete the current artifact by choosing <Delete>, discard any
changes made by clicking <Refresh> or print it by clicking <Print>.

The lower part of the right pane can be switched between six different views by clicking the
appropriate tab. Initially the pane will be in “Test Steps” mode, but it can be switched to
“Requirements Coverage”, “Custom Properties”, “Test Runs”, “Releases”, “Attachments” and
“History” modes if so desired. Each of the views is described separately below. In addition there
is a shortcut link “Execute This Test” that allows you to execute this test (see section 5.3) without

having to return to the Test Case list.

5.2.1. Test Steps

This view displays the name of the test case together with all the defined test steps that a tester
would need to perform to verify that the functionality works as expected. The list of test steps
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displays the position number, the description, the expected result, some suggested sample data
and the most recent execution status of the individual test step.

Test Steps * Req Coverage ¥ Custom Props # Test Runs * Releaszes % Atftachments #* History #
Step # Test Step Description Expected Result Sample Data Status
on InsertStep  op Insertlink  §3 Delete 4> MoveUp  {F MoveDown [ Refresh Parameters
Step 1 &7 Call Login to Application’ (TC17) N/A MNAA NAA
Step 2 BIQTE|GEJE(> BIHTE|E(> BIHTE‘EO Passed
(TS000002)
- User clicks link to create book User taken to first screen in wizard
Step 3 B7 UTy|epo@ B/ UuTg|emo@ B UuTg|epo@ Passed
(TS000003)
1] lUser enters books name and User taken to next screen in wizard [Macheth, William Shakespeare

author, then clicks Mext

Step 4 Bl U1 |ego@ Bl o |ego@ B UuTg|epo@ Passed
(TS000004)

lUser chooses book's genre and User sees screen displaying all Play. Tragedy

sub-genre from list entered information
Step 5 BT |lepgo@ BT |lemgo@ Bz UuTy|epo@ Passed
(TS000005)

User clicks submit button Confirmation screen is displayed

Note: Test steps that are marked with a hyperlink and test case icon (e.g. “Call Login to
Application” in the screen shot above) are in fact linked test cases. Linked test cases are a useful
way of reusing existing test steps from other test cases. For example if you want to have a set of
steps be in more than one test case (e.g. a login step) then you would create a separate test case
just containing these steps, then have all the other test cases just link to it. This avoids the need
to have duplicate test steps throughout the project.

In addition, if you click on the hyperlink displayed below the step number (e.g. TS00003) you will
be taken to the test step details page which allows you to perform additional editing of a specific
test step as well as attach documents, view the change history, etc.

5.2.1.1. Insert Step

Clicking on the <Insert Step> button inserts a new test step before the currently selected (by
means of the check-box) test step. Clicking the <Insert Step> button without selecting a test step
will insert a new step at the end of the list. All test steps are displayed in “Edit” mode, so the
description, expected result and sample data fields are editable, allowing you to enter the
appropriate data (see section 5.2.7). In addition to the existing test steps, the system always
displays five blank test steps so that it is easy and quick to enter large numbers of test steps.
Upon entering up to five test steps and clicking the <Update> button, five new blank rows will be
added at the bottom of the list.

5.2.1.2. Insert Link

Clicking on the <Insert Link> button brings up the following panel that allows you to choose the
test case to be inserted:
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Test Steps # Req Coverage # Custom Props # Test Runs # Releazes # Aftachments # History #

Choose the test case to add as a link in the test step list:

------ Abhility to edit existing book

------ Ability to edit existing author

------ Ability to reassign book to different author
------ Book management

------ Author management

m

-

You need to then select the name of the test case you want to insert as a link and click <Next>. If
the test case has declared parameters (see the section on Parameters below for more details)
you will be taken to the following screen:

Test Steps * Req Coverage # Custom Props # Test Runs # Releases # Attachments # History #

Please fill out the parameters for this linked test case:

login- | |

password: | |

You need to fill out the values of the parameters for the linked test case and then click the
<Insert> button to complete the operation. The system will then insert the test case as a link just
before the currently selected test step. If no existing test step was selected, the link will be added
at the end of the test step list.

5.2.1.3. Delete

Clicking on the <Delete> button deletes the currently selected test steps, and reorders the test
step position numbers to close any gaps in numbering.

5.2.1.4. Move Up

Clicking on the <Move Up> button simply reorders the test step list so that the currently selected
test step is one position higher up the list. Note: Attempting to move a test step above the top of
the list will give a warning message.

5.2.1.5. Move Down

Clicking on the <Move Down> button simply reorders the test step list so that the currently
selected test step is one position lower down the list. Note: Attempting to move a test step below
the bottom of the list of existing test steps will give a warning message.

5.2.1.6. Refresh

Clicking on the <Refresh> button simply reloads the list of test steps. This is useful if other people
are making changes to the test list and you want to make sure that you have the most current
version.

5.2.1.7. Update

Each test step in the list is always in an editable mode. When you click this button, you commit
any changes made to the test step list. These changes consist of modifying an existing test step
or entering a new test step in one of the five blank rows. The delete/insert/move-up/move-down
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operations on the other hand are committed immediately, and do not need to have the <Update>
button clicked for them to take effect.

5.2.1.8. Cancel

If during the entry of new test steps or the modification of existing test steps, you want to revert
back to the original information, click <Cancel> and your changes will be discarded.

5.2.1.9. Parameters

Test cases can have parameters associated with them. This enables one test case to be called
several times by another test case (as a link) and have different parameters passed in each case,
making the operation different. E.g. you could have a generic “login to application” test case that
others call as an initial step, which could be provided with different login information depending on
the calling test case.

To view / change the parameters associated with the current test case, click on the <Parameters>
icon in the toolbar and the list of current parameters will be displayed:

Test Steps #* Req Coverage Custom Props # Test Runs Releazes Attachments History
The following parameters have been defined for this test case:

Name Default Value Operations

${login} Copy To Clipboard | Delete

H{password} Copy To Clipboard | Delete

Add a new parameter to this test case:

Name:* | |

Default Value: | |

The list of existing parameters is displayed in a grid, followed by the option to add a new
parameter and default value (used when the test case is run directly rather than being called by
another test case). You can delete an existing parameter and also copy the parameter token to
your computer’s clipboard. The latter option is useful so that you can insert the parameter token
(in the format ${parameter name}) in the test step description, expected result or sample data
fields and have it converted into the parameter value during test execution.

5.2.2. Requirements Coverage

This view displays the name of the test case together with the requirements coverage information
for the test case in question:
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Test Steps #* Req Coverage # Custom Props # Test Runs # Releazes # Attachments # History #

Available Requirements: Requirements Coverage:
v | Name v | Test # | Name Status
[J = "= Functional System Requirements it ] RQoo0004 7 Ability to add new books to th Completed
[0 = = Online Library Management Syst. ..
O = = Book Management
T Ability to add new books to th | Remove < |
= o
= Ability to edit existing books._. Remove All

= Ability to delete existing boo.__.
ETN : .
= Ability to associate books wit...

T Ahilit tn acencista hanke wit

“qloo|o

> Create Requirement From This Test Case ;j

The requirements coverage box indicates the requirements that are currently mapped against the test case.
To add requirements to this test case, choose from the list above and click [Add].
You can use the [Remove] and [Remove All] buttons to remove requirements that are no longer covered by the test case.

The pane consists of two lists of requirements, the one on the left being the complete hierarchical
list of requirements in the project. The right box (which will initially be empty) contains the list of
requirements mapped to this test case. The requirements in this box include columns for their ID,
name and status. Hovering the mouse over the names of the requirements in either box will
display a “tooltip” consisting of the requirement name, place in the hierarchical structure and a
detailed description. Clicking on the hyperlinks in right-hand box will jump you to the requirement
details screen for the requirement in question (see section 4.2).

To change the coverage for this test case, you use the buttons (Add, Remove, Remove All)
positioned between the two list-boxes. The <Add> button will move the selected requirements
from the list of available on the left to the list of mapped on the right. Similarly the <Remove> and
<Remove All> buttons will remove either the selected or all the requirements from the right list-
box and add them back to the left list-box.

Finally, as a shortcut you can click the “Create Requirement from This Test Case” link to create a
new requirement in the list of covered requirements that will be automatically linked to this test
case. This is useful when you have created a new test case and want to generate an initial
placeholder requirement to be fleshed-out later.

5.2.3. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
test cases. To learn more about how to setup and configure custom properties for a project,
please refer to the SpiraTest Administration Guide. Assuming that custom properties have been
defined for your project, you will see a list of optional parameters that can be set on the test case.
These can be either freetext or drop-down-lists. In the example below, you can enter a URL
and/or Test Type.
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Test Steps # Req Coverage # Custom Props # Test Runs # Releazes # Attachments #* History #

Please edit the following custom properties of this artifact and click [Update] when finished:

URL:

http://www.libraryreferences.org

Test Type: | Functional Test hd

Once you are satisfied with the values for the custom properties, simply click [Update] to commit
the changes.

5.2.4. Test Runs

This view displays the name of the test case together with a list of the previous execution runs
that the test case has been put through. Each test run is listed together with the date of
execution, the name of the test case, the name of the test set (if applicable), the name of the
tester, the release/version of the system that the test was executed against, the overall execution
status for the test case in that run and a link to the actual test run details (see section 5.4). In
addition, you can choose to display any of the custom properties associated with the test run.

TestSteps * Req Coverage ® Custom Props * TestRuns » Relzases # Attachments » History ®

> Refresh | Apply Filter | Clear Filters | | - Show/hide colimns v]

¥ @ TestRun Name 4¥ Execution Date AV Test Set AY Release AV Status AV Est. Dur. AY Act. Dur, AY Web Browser AY Operating System AY Run# AY
0 | ]| —any— V||[cany— ] [~Any v [ I [ [ Por v [-hy- v| TR|

O B Ability 10 create new book | 4-Dec-2003 Failed 0.0n 1.2h TRO00G18
o B ( book | 3-Dec-2003 Passed 0.0h 12h TRO00015
2| |f Passed 0.0h 12h TRO00013
(] ok | 1-Dec-2003 Passed 0.2h 1.5h Mozilla / Firefox Windows 2000 TRO0D0O02
0 B Ability to create new book | 1-Dec-2003 Failed 0.2h 1.2h Opera Windows 2003 TRO0D012
O ¢ B Ability 1o create ok | 1-Dec-2003 Failed 0.2h 1.3h Internet Explorer | Windows XP TROODOO1
Show (15 ¥ | rows per page « < Displaying page |1 Zof 1

The “customize columns” drop-down list allows you to change the fields that are displayed in the
test run list as columns. To show a column that is not already displayed, simply select that
column from the list of “Show...” column names and to hide an existing column, simply select that
column from the list of “Hide...” column names. The displayed columns can be any standard field
or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-
header row of each field and clicking the “Apply Filter” link. In addition, you can quickly sort the
list by clicking on one of the directional arrow icons displayed in the header row of the appropriate
field.

5.2.5. Release Mapping

This view displays the name of the test case together with the release mapping information for
the test case in question:
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Test Steps # Req Coverage # Custom Props # Test Runs # Releases Attachments #* History #

Available Releases: Mapped Releases:
v ‘Name v |Tes1# |Name Status
= &1.0.0.0 - Library System [0 RL00000T [E1.0.00-Library System Relea Active
:l [0 RLO0O0OOZ _:l 1.0.1.0 - Library System Relea Active
E1020-Libra stem Relea [0 RLO00003 IE 4020 - Library System Relea Active
O £11.0.0.0.0001 - hteration 001 [Remove< | [ RLO000D4 B 1100 - Library System Relea Active
O £11.0.0.0.0002 - Heration 002 Remove Al O RL000017 £ 1.1.0.0.0001 - hteration 001 Active
O £11.0.0.0.0003 - lteration 003 [J RL000018  t31.1.0.0.0002 - lteration 002 Active
[ 1.1.0.0 - Library System Relea O RL000019 T 1.1.0.0.0003 - lteration 003 Active
O E1.2.00- Library System Relea...

The release coverage box indicates the releases that are currently mapped against the test case.
To associate releases with this test case, choose from the list above and click [Add].
You can use the [Remove] and [Remove All] buttons to remove releases that are no longer covered by the test case.

The pane consists of two lists of releases/iterations, the one on the left being the complete
hierarchical list of releases and iterations in the project. The right box (which will initially be
empty) contains the list of releases/iterations mapped to this test case. The releases in this box
include columns for their ID, name and active status. Hovering the mouse over the names of the
releases/iterations in either box will display a “tooltip” consisting of the release/iteration name,
place in the hierarchical structure and a detailed description. Clicking on the hyperlinks in right-
hand box will jump you to the details screen for the release/iteration in question (see section 7.2).

To change the release mapping for this test case, you use the buttons (Add, Remove, Remove
All) positioned between the two list-boxes. The <Add> button will move the selected releases
from the list of available on the left to the list of mapped on the right. Similarly the <Remove> and
<Remove All> buttons will remove either the selected or all the releases from the right list-box
and add them back to the left list-box.

5.2.6. Attachments

In this mode, the main pane displays the list of documents that have been “attached” to the test
case. The documents can be in any format, though SpiraTeam® will only display the icon for
certain known types.

Test Steps # Req Coverage # Custom Props # Test Runs % Rel * ts * History #
Document Name Type Size Uploaded By Upload Date ¥
ﬂ Sequence Diagram for Book Mgt pdf File 35 KB Fred Bloggs 3-May-2006
Upload New Document/URL
Type: @® File O URL
Filename:* | H Erose |
Description: | |

The attachment list includes the filename that was originally uploaded together with the file-size
(in KB), name of the person who attached it and the date uploaded. In addition, if you position the
pointer over the filename and hold it there for a few seconds, a detailed description is displayed
as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser
window will open. Depending on the type of file, this window will either display the document or
prompt you for a place to save it on your local computer. To delete an existing attachment from a
test case, simply click the <Delete> button and the attachment will be removed from the list.
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To attach a new document to the test case, you need to choose “File” as the type and then click
the Browse button and select the file from your local computer, optionally enter a detailed
description then click the <Upload> button. The document will be copied from your computer and
attached to the test case. To attach a web-link (URL) to the test case, you need to choose “URL”
as the type and then enter the fully qualified URL (e.g. http://mywebsite.com?Document=1), an
optional description and then click the <Upload> button to attach the web-link.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn't put file
extensions on filenames (e.g. .xls for an Excel sheet) automatically, then you will need to
manually add the file extension to the filename before uploading if you want it to be displayed with
the correct icon in the attachment list.

5.2.7. History

In this mode, the main pane displays the list of changes that have been performed on the test
case artifact since its creation. An example test case change history is depicted below:

Test Stepe #* Req Coverage % Custom Props # Test Runs * Releazes # Attachments # History *
Change Date ¥ Field Name 0ld Value New Value Changed By
5/2/2006 12:00:00 AM Mame MNeed to create new book Ability to create new book Fred Bloggs
3/4/2005 12:00:00 AM Owner Fred Bloggs Joe P Smith

The change history displays the date that each change was made, together with the fields that
were changed, the old and new values and the person who made the change. This allows a
complete audit trail to be maintained of all changes in the system.

5.3. Test Step Details

When you click on one of the hyperlinks next to a test step in the test step list (see above), you
will be taken to the test step details screen illustrated below:

Welcome, Fred Bloggs | My Profile | Administration | Log Out | [Lbry inforation System v Help?

raTeam

My Page Project Home Planning Testing Tracking Reporting
Test Cases > Test Step Details | Test Sets Role: Manager

<< Back to Test Step List | Eisawe <saveandNow g3 Delele

L Ability to create new book Test Step 3 [TS:000003)] - Test Case #:TC000002
1 Description:* ot~ 7] [Se- v| Bz u|EEE|EEEE| Ry —egOcR

User enters books name and author, then clicks Next

Step 2 (TS000002)
Step 3 (T5000003)

Step 5 (TS000005)

Expected Result [ ot - V| [Se- v] Bz u|EEE|EEEETEE—egOo@

User taken to next screen in wizard

Sample Data —Fert— v |-s.:¢-- v| BIﬂliiilEiEﬁiil"&‘hl—Wﬂﬂ()@

[Macbeth, William Shakespeare

Incidents * Custom Properties ® Attachments ® History ®

v Date Artifact Name Created By Comment Artifact Type Artifact #
D dhadd  $3 Deiete
4-Mev-2003 ¥ Cannet add a new book to the system Joe P Smith Test Run: Ability to create new book Incident IMO00007

This page is made up of three areas; the left pane is the navigation window, the upper part of the
right pane contains the test step detailed information itself, and the bottom part of the right pane
contains related information about the test step.

The navigation pane consists of a link that will take you back to the test step list, as well as a list
of the peer test steps to the one selected. This latter list is useful as a navigation shortcut; you
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can quickly view the detailed information of all the peer test steps by clicking on the navigation
links without having to first return to the test step list page.

The top part of the right pane allows you to view and/or edit the details of the particular test step.
You can edit the various fields (description, expected result and sample data) and once you are
satisfied with them, simply click the <Save> button just below the fields to commit the changes. If
you want to add a new test step to the test case, you should click <Save and New> instead.

The lower part of the right pane can be switched between four different views by clicking the
appropriate tab. Initially the pane will be in “Incidents” mode, but it can be switched to “Custom
Properties”, “Attachments” and “History” modes if so desired. Each of the views is described
separately below.

5.3.1. Incidents

In this mode, the main pane displays a list of any incidents that are associated with this test step.
They can either be linked indirectly due to being logged during a test run, or directly linked after

the fact:
Incidents # Custom Properties # Attachments # History #
v Date Artifact Name Created By Comment Artifact Type Artifact #
dhAdd 93 Delete
4-Mov-2003 B Cannot add a new book to the system Joe P Smith Test Run: Ability to create new book Incident INO00007

Each incident is displayed with its name, the name of the person who executed the test run or
made the direct association, and a comment that describes why the association was made. In the
case of a test run, the comment will simply contain the name of the test run.

To create a new association between this test step and an existing incident, simply click the
<Add> icon and then choose the incident you want to link to this test step:

Add New Association (Step 2 of 2)

Please choose the incident that you want to add an association to:

) Enter Incident #: M I:I

Add from history: Sample Risk 1
Sample Risk 2
Sample Risk 3
Test Change Request
Test Change Request
TestChange Request
TestChange Request
TestChange Reguest
TestChange Request ™

m| »

Comment:

[« Back | [ Add | |» cancel |

Finally, to delete an existing incident association (except for those due to test runs) select the
check-box next to its name and click the <Delete> icon. This will only delete the association, not
the linked incident itself.
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5.3.2. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
test steps. To learn more about how to setup and configure custom properties for a project,
please refer to the SpiraTest Administration Guide. Assuming that custom properties have been
defined for your project, you will see a list of optional parameters that can be set on the test step.
These can be either freetext or drop-down-lists.

Incidents #* Custom Properties # Attachments # History #
Please edit the following custom properties of this artifact and click [Update] when finished:
Additional Data:  |goma Data
Step Type: | Step Type 1 -

Once you are satisfied with the values for the custom properties, simply click [Update] to commit
the changes.

5.3.3. Attachments

In this mode, the lower section of the screen displays the list of documents that have been
“attached” to the test step. The documents can be in any format, though SpiraTeam® will only
display the icon for certain known types.

Incidents # Custom Properties # Attachments # History #
Document Name Type Size Uploaded By Upload Date ¥
[&¥] Expected Result Screenshot.png File 314 KB Fred Bloggs 1-May-2006

Upload New Document/URL

Type:* ® File O URL

y -
Filename: | || Browse... |

Description: | |

The attachment list includes the filename that was originally uploaded together with the file-size
(in KB), name of the person who attached it and the date uploaded. In addition, if you position the
pointer over the filename and hold it there for a few seconds, a detailed description is displayed
as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser
window will open. Depending on the type of file, this window will either display the document or
prompt you for a place to save it on your local computer. To delete an existing attachment from a
test step, simply click the <Delete> button and the attachment will be removed from the list.

To attach a new document to the test step, you need to choose “File” as the type and then click
the Browse button and select the file from your local computer, optionally enter a detailed
description then click the <Upload> button. The document will be copied from your computer and
attached to the test step. To attach a web-link (URL) to the test step, you need to choose “URL”
as the type and then enter the fully qualified URL (e.g. http://mywebsite.com?Document=1), an
optional description and then click the <Upload> button to attach the web-link.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn't put file
extensions on filenames (e.g. .xls for an Excel sheet) automatically, then you will need to
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manually add the file extension to the filename before uploading if you want it to be displayed with
the correct icon in the attachment list.

5.3.4. History

In this mode, the main pane displays the list of changes that have been performed on the test
step artifact since its creation. An example test step change history is depicted below:

Incidents * Custom Properties % Attachments #* History #
Change Date ¥ Field Name 0ld Value New Value Changed By
2-May-2006 12:00 AM Expected Result User taken to first screen User taken to next screen in wizard Fred Bloggs
4-Mar-2005 12:00 AM Expected Result User taken to first screen Joe P Smith

The change history displays the date that each change was made, together with the fields that
were changed, the old and new values and the person who made the change. This allows a
complete audit trail to be maintained of all changes in the system.

5.4. Execute Test Case(s)

This section describes how a tester can follow the steps defined for a series of test cases and
record what actually happened in the process. In addition, recorded failures of test cases can be
used to automatically generate new incidents that will be added to the incident tracking module
(see section 6).

You start test case execution in SpiraTeam by either selecting test cases or test sets on their
respective page(s) and clicking the <Execute> button, or by clicking the “Execute” link on the test
cases / test sets listed on your personalized home page under “My Test Cases” or “My Test
Sets”. If you execute a test set then the values of the selected release and custom list properties
for the test run are automatically populated from the test set, whereas if you directly execute a
test case itself, those values can be chosen by the tester.

Regardless of the route taken to launch the test execution module, the first screen that will be
displayed will look like the following:

Tea . Welcome, Fred Bloggs | My Profile | Log Out | |Lieary Infomation System ) Help?
My Page Project Home Planning Testing Tracking Reporting
Test Cases » Test Case Execution | Test Sets Role: Manager
=< Back To Tests
17 Testing New Functionality (TX5) Test Execution Wizard
Please Choose the Release To Execute Against
Release": | 120.0- Library System Release 2008 ]
Mow enter the following properties for this test run:
Motes:
Web Browser. [--None |
Operating System [--Nane - ]
» Cancel |[» Next

Before actually executing the test scripts, you need to select the release of the system that you
will be testing against and any test run custom properties that have been defined by the project
owner. This ensures that the resulting test runs and incidents are associated with the correct
release of the system, and that the test runs are mapped to the appropriate custom properties
(e.g. operating system, platform, browser, etc.).
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If you have not configured any releases for the project, then the release drop-down list will be
disabled and the test runs/incidents will not be associated with any particular release. If the test
run was launched from a test set, the release and list custom properties will be pre-populated
from the test set itself and will not be changeable on this screen.

Once you have chosen the appropriate release name and/or custom properties, click the <Next>
button to begin executing test steps:

Test Cases > Test Case Execution | Test Sets

== Back To Tesis

4% Testing New Functionality (TX5)
1247 Ability te create new author (TC4)
Step 1 - (TC16)
Step 2 - (TCAT)
[]Step 3 - (TC4)

[Passaid| [Blocked® [Fair ]
Ability to create new author (TC000004)

Release # 1.2.0.0

Tests that the user can create a new author record in the system

Step 1 - Please follow the directions outlined in the box below

T . Welcome, Fred Bloggs | My Profile | Log Out | Libeary nformation System v Help?
My Page Project Home Planning Testing Tracking Raporting

Role: Manager

User opens up browser and enters application URL: http:/fwww.libraryinformationsystem.com/beta

L) Ability to reassign book to di... (TCE)

[[]47 Person loses book and needs to... (TC12
O ‘gadcur‘u new book and author to ... (TC13)

Expected Result
The browser loads the login web page

Sample Data
http:(fwww libraryinformationsystem. com/beta

Actual Result - Please enter the actual test result if it differs, then click the appropriate button
BrU|EEE|EEEEEE|—egOo@

- Fort » “Size-

Logged Incidents Attachments *

The screen is divided up into four main elements:

» The left-hand navigation pane contains the list of test cases and test steps for the
currently executing test case. You can click on the various links to move between the test
cases and/or test steps. In addition, each test case and test step has a colored square
next to the name that indicates its status (green = “Passed”, yellow = “Blocked”, orange =
“Caution”, red = “Failed”, gray = “Not Run”) in the current test run. If any of the steps are
marked as “Failed”, "Blocked”, or “Caution” then the overall test case is marked with that
status; if all the test steps passed, then the overall test case is marked as “Passed”; any
other case results in the test case being marked as “Not Run”.

» The main pane displays the details of the test case together with the current test step. As
the tester you would read the name and description of the test case, then read the
description of the test step, carry out the instructions on the system you are testing, and
then compare the results with those listed as expected. As described below, depending
on how the actual system responds, you will use the buttons on the page to record what
actually happened.

>» Below the main pane there are two optional sections. The first one allows you to log an
incident in the system associated with the test step. For failures this will typically be used
to log a bug relating to the failure. However even if you pass a step you can still log an
incident, which may be useful for logging non-critical cosmetic items that are not serious
enough for a failure to be recorded. This tab also displays any pre-existing incidents that
were associated with the test step being viewed.

» The second tab displays a list of attachments that are related to the current test case
and/or test step. This list initially contains any documents that have been attached to
either the test case in general or the test step in particular. However as you perform the
testing, you can attach additional documents to this list that are relevant to the test results
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(e.g. screenshots of an error page); these attached documents will be associated with
both the test run itself and any incidents that are created.

If the expected results are indeed observed, then you simply need to click the <Pass> button to
mark the test step as passed, and advance to the next test step, or if all the steps have passed,
you can click <Pass All> to pass all the steps at once. This is illustrated in the screen shot below:

Welcome, Fred Bloggs | My Profile | Log Out | Library information System v Help?

My Page Project Home Planning Testing Tracking Raporting

spiraTeam

Role: Manager

Test Cases > Test Case Execution | Test Sets

| [Pass /| [PassAl¥| |[Blocked® [Cautionl] [FailX] | Release # 1.2.0.0

Ability to create new author (TC000004)
Tests that the user can create a new author record in the system

<< Back To Tests

47 Testing New Functionality (TX5)
1247 Ability to create new author (TC4)
W Step 1-(TC16)
W Step 2 - (TCAT)
B Step 3 - (TC4
W Step 4 - (TC4
i Step 5 - (TC4
i Step 6 - (TC4
[[]£3 Ability to reassign book to di... (TC6)
147 Person loses book and needs to... (TC12)
[[]43 Adding new book and authorto .. (TC13)

Step 1 - Please follow the directions outlined in the box below:
User opens up browser and enters application URL: http://www libraryinformationsystem com/bata

Sample Data
http:ffweww libraryinformationsystem com/beta

Expected Result
The browser loads the login web page

Actual Result - Please enter the actual test result if it differs, then click the appropriste butten

Bru|lss=E|cEFEha|—egOo@

-~ Font - w Sze- »

Logged Incidents Aftachments

This will change the icon in the left-hand navigation bar into a green square with a check mark in
it. Once all the test steps have passed, you will now have the option of moving to the next test
step by clicking the <Next Test> button; if it is the last test case being executed, the <Finish>
button will be displayed instead.

If the actual results differ from those expected, you need to enter a description of the result
observed and click the <Fail>, <Blocked> or <Caution> button; this is illustrated in the screen-

shot below:
Welcome, Fred Bloggs | Wy Profile | Log Out | | Library Information System ¥ Help?
My Page Project Home Planning Testing Tracking Reporting

Test Cases > Test Case Execution | Test Sets

4% Testing New Functionality (TX5)

§#1 £ Ability to create new author (TC4)

[T]£7 Ability to reassign book to di.. (TC6

¥l L] Person loses book and needs to... (TC12)
[l Step 1 - (TC16)
[] Step 2 - (TCAT
[] Step 3 - (TC12)
[]Step 4 - (TC12
[]Step 5 - (TC12

147 Adding new book and author to ... (TC13]

<< Back To Testa | [Pass | [Blocked®| [Cautionl] [FallX] | Release # 1.2.0.0

Person loses book and needs to report loss (TCO00012)

Role: Manager

Tests that the user can create a new author recerd in the system

Step 1 - Please follow the directions outlined in the box below
User opens up browser and enters application URL: hitp://www libranyinformationsystem com/beta

Expected Result Sample Data:

The browser loads the login web page http:/fwww_libraryinformationsystem com/beta

Actual Result - Please enter the actual test result i it differs, then click the appropriate button

[Fort] viisel viBrp|EEE|EEEE| TN —=gOo@

[The screen displays a 404 emor message page

Logged Incidents Attachments

Unlike the <Pass> button, if you don’t enter a description of the actual result, the system will
display an error message and re-prompt you again for input. In the case of a failure, both the
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individual test step and the overall test case will be marked with a red square containing a cross.
Similarly, in the case of a blocked test case, they will be marked with a yellow square, and in the
case of a caution, they will be marked with an orange square. You will now have the option of
moving to the next test step by clicking the <Next Test> button; if it is the last test case being
executed, the <Finish> button will be displayed instead.

In addition to logging the failure, you can optionally choose to have the failure result in a new
incident be automatically created. This is achieved by clicking on the Incident tab and entering a
name, type, priority, severity (and any custom properties) for the new incident before clicking the
<Fail/Caution/Blocked> button:

Actual Result - Please enter the actual test result if it differs, then click the appropriate button:
[Fort] vszl v|B r u|EEE|EEEE TS| —=pOoc@

he screen displays a 404 error message page

Logged Incidents Attachments

Please enter the following information to log an incident with this test step:

Name:* |Cannot login to the web page correctly |

Type:* |Bug v| Prigrity: |‘|-Critica| v|

Owner: [~ None - |+ Severity: |[2-High v]

Also enter the following custom properties for this new incident:

Motes:

Operating System: [Windows 2000 ~]

The other information needed for the new incident is automatically populated from the test step
details. The newly created incident will also be linked to the test step, allowing traceability from
within the incidents module. The functionality for managing incidents is described in more detail in
section 6.

If you need to attach documents to the test run (e.g. screenshots of the error message), you just
need to select the Attachments tab and then choose the option to upload the necessary
documents, or attach the appropriate URLS.

Note that the entire test run is saved once you first start execution, so you can always step away
from your computer and then resume testing at a later date by locating the test run on your ‘My
Page’ under ‘My Pending Test Runs’ and choosing to resume testing.

5.5. Test Run Details

As described in section 5.2.4, when you view the details of a test case, one of the views possible
is to list all the test runs for that test case:
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TestSteps * Req Coverage ® Custom Props * TestRuns » Relcases # Attachments » History ®
= Refresh | Apply Filter | Clear Filters Show/hide cokumns - v
¥ @ TestRun Name 4¥ Execution Date AV Test Set AY Release AV Status AV Est. Dur. AY Act. Dur, AY Web Browser AY Operating System AY Run# AY
o | | B [ Y [aw— Y] [ V]| I [ v] [R- v [ ]
O | B ability 1o cres ok | 4-Dec-2003 Falled 1 0.0n 1.2h TRO00018
O &) ok  3-Dec-2003 Passed 0.0h 1.2h TROD00O15
0 ok | 2-Dec-2003 Passed 0 0h 12h TRO00013
O book | 1-Dec-2003 Testing Cycle Passed 0.2h 1.5h Mozilla / Firefox Windows 2000 TROO0002
i for Release 1.1
] ( book | 1-Dec-2003 1000 Falled 0.2h 1.2h Opera Windows 2003 TRO00012
O @ D_]_.s_h lity 1o create new book | 1-Dec-2003 Fﬂqi 0.2h 1.3h Internet Explorer Windows XP TRODOOO1
Show |15 W | rows per page « < Displaying page {1 % of 1 &

When you click on any of the individual test runs in the list, you are taken to the Test Run details
page (not to be confused with the Test Case details page!) shown below:

Welcome, Fred Bloggs | My Profile | Administration | Log Out |

sTeam

My Page

Test Cases > Test Run Details | Test Sets

<< Back to Test Run List B sawe
Dj 4-Dec-2003 (TRODDO18)
7 3-Dec-2003 (TROD0015)
IU 2-Dec-2003 (TROD0013)
1.Dec-2003 (TRO00012)

Release #

£3 Delete

Project Home Planning

% Refresh  (g) Print

Tests that the user can create a new book in the system

[L000- Loy sus

Testing

Test Run: Ability to create new book [TR:000001]

Lorary Infomation System

Tracking

Estimated Duration:

v

Reporting

Role: Manager

0 hours | 10 minutes

Tester Name Joe P Swith v Actual Duration: 1 hours |15 minutes
Test Set: [Testino Cuce tor Relesse 10 v| Execution Date: 120112003 10:45:20 AM
Test Case # TC000002 Execution Status:
Test Run Type:  Manual
Test Run Steps » Stack Trace Custom Properties ® Aftachments »

This page consists of three panes:
» The left hand navigation pane displays a list of the last fifteen (15) runs

» The main pane displays the details of the test run itself (nhame, description, release, test
set, estimated and actual duration, tester name, test run type, etc.)

» The tab-control displays the list of test run steps (populated if a manual run executed by a
user), the stack trace (populated if an automated run executed by an automated testing
tool such as NUnit, JUnit, etc.), any custom properties set for the run, and a list of any

documents/URLSs that were attached to the test results.

5.5.1. Editing a Test Run

When reviewing the test run, you may find that you need to change the results of the test run (e.g.
the user selected the wrong release or custom property value). Many of the fields are editable at
a later date, and to make changes, just modify the appropriate fields and click [Save].

5.5.2. Deleting the Test Run

If you need to delete a test run that was erroneously captured, all you need to do is click on the
link to access the invalid test run and then click the <Delete> button to remove it from the system.
This will then force the system to update the status of the test case itself from the other logged
test runs.

5.5.3. Test Run Steps

In the case of a manual test run, this tab displays all the steps of the test case as they appeared
during the test run in question. This means that if the test steps were changed after running the
test, the list here will reflect the original information.
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Test Run Steps #* Stack Trace Custom Properties #

Run Step # Test Step Description Expected Result Sample Data Test Step # Actual Result Status

RS000001 | User logs in to application User taken to main TS000019 Passed
menu screen

RS000002 | User clicks link to create book User taken to first 15000002 Passed
screen in wizard

RS000003 | User enters books name and User taken to next Macheth, William TS000003 | An error page is displayed - "No such object [Failed

author. then clicks Next screen in wizard Shakespeare or with block variable at line 473"
=View Incidents

Each test step is displayed along with the description, expected result, suggested sample data, a
link back to the current version of the test step in question, the actual result and the execution
status for this step in this particular test run. Where an actual result was recorded, you will have
an additional hyperlink “View Incidents” displayed. This allows you to view any incidents that are
associated with this particular test run step:

Test Run Steps # Stack Trace Custom Properties #

Run Step # Test Step Description Expected Result Sample Data Test Step # Actual Result Status

RS000001 | User logs in to application User taken to main TS000019 Passed
menu screen

RS000002 | User clicks link to create book User taken to first TS000002 Passed
screen in wizard

RS000003  User enters books name and User taken to next Macbeth, William TS000003  An error page is displayed - "No such object [Failed

authar, then clicks MNext screen in wizard Shakespears or with block variable at line 473"

>View Incidents

Incidents List for Step: 3 (Test Run Step # RS000003)

Incident# Name Type Status Priority Owned By  Detected On  Detected By
INODOOOT B Cannot add a new book to the system Bug |[Assigned 1 - Critical | Joe P Smith | 4-Now-2003 Joe P Smith

Clicking on the link will change the background color of the test case to gray and display a list of
all the associated test steps in a grid below the test step list. Each of the incidents listed will
reflect the most up-to-date information regarding that incident, including its type, status, priority,
name, assigned owner, detection date and who first detected it. Clicking on the incident number
hyperlink will take you to the details page for that incident, which is described in section 6.2.

5.5.4. Stack Trace

In the case of an automated test run, this tab will display the details of the test run as reported
from the test runner application. These details will vary depending on the type of automated tool
being used, but typically they include the name of the automated test runner, the number of
assertions raised, the name of the corresponding test case in the tool, the status of the test run
and a detailed error message, and stack-trace in the case of a failure. An example test run as
reported from the NUnit automated test runner is illustrated below:
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Test Run Steps Stack Trace # Custom Properties #

Runner Name: NUnit Assert Count: 1
Message: Expected 1 but 2 was found Test Name: _01_TestCreateBook
Failure Details: [0bject wariable or With block variable not set. -

Description: An unhandled exception occurred during the execution of the current
web request. Please review the stack trace for more information about the error and
where it originated in the code.

Exception Details: System.NullReferenceException: Cbject wariable or With block
[variable not set.

Source Error:

Line 215: Response.Write ("<option selected wvalue=""" & MonthCheck (MonthCount)
& "mrs»r g MonthCount & "</option>" & vbCrLf)

Line 216:Else

Line 217: Response.Write ("<option wvalue=""" & MonthCheck (MonthCount) & """>" &

MonthCount & "</option>"™ & vbCrLf)
Line 218:End If
Line 215:

Details on how to use SpiraTeam® in conjunction with an automated testing tool are provided in
the SpiraTeam® Automated Testing Integration Guide, which can be downloaded from the
Inflectra® website.

5.5.5. Custom Properties

In this mode, the tab displays any custom properties that the project owner has defined for test
runs. To learn more about how to setup and configure custom properties for a project, please
refer to the SpiraTest Administration Guide. Assuming that custom properties have been defined
for your project, you will see a list of optional parameters that have been set during the test run:

Test Run Steps # Stack Trace Custom Properties #*

Please edit the following custom properties of this artifact and click [Update] when finished:

Notes: Testing with IE 5.5 5P1 o
Web Browser: Intermnet Explorer v
Operating System:  Windows XP M

For test runs, custom properties are most commonly used to capture and record the system
configuration that the test was performed on — for example the operating system, hardware
platform, and web-browser.

5.5.6. Attachments

In this mode, the lower section of the screen displays the list of documents that have been
“attached” to the test run. The documents can be in any format, though SpiraTeam® will only
display the icon for certain known types.
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Test Run Steps # Stack Trace Custom Properties # Attachments #

Document Name Type Size Uploaded By Upload Date ¥
@] Error Logging-in Screen-shot.gif File 48 KB Fred Bloggs 24-Apr-2006

Attach New Document/'URL

Type:® ® File O URL

Filename:* I Browse...

Description: |

The attachment list includes the filename that was originally uploaded together with the file-size
(in KB), name of the person who attached it and the date uploaded. In addition, if you position the
pointer over the filename and hold it there for a few seconds, a detailed description is displayed
as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser
window will open. Depending on the type of file, this window will either display the document or
prompt you for a place to save it on your local computer. To delete an existing attachment from a
test run, simply click the <Delete> button and the attachment will be removed from the list.

To attach a new document to the test run, you need to choose “File” as the type and then click
the Browse button and select the file from your local computer, optionally enter a detailed
description then click the <Upload> button. The document will be copied from your computer and
attached to the test run. To attach a web-link (URL) to the test run, you need to choose “URL” as
the type and then enter the fully qualified URL (e.g. http://mywebsite.com?Document=1), an
optional description and then click the <Upload> button to attach the web-link.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn't put file
extensions on filenames (e.g. .xls for an Excel sheet) automatically, then you will need to
manually add the file extension to the filename before uploading if you want it to be displayed with
the correct icon in the attachment list.
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5.6. Test Set List

As well as being able to organize test cases into folders, you can also create separate groupings
of test cases called test sets which can then be assigned to testers as a package. To view the list
of test sets for a project, click on Testing > Test Sets in the global navigation:

- Tea . Welcome. Fred Bloggs | My Profile | Log Out | [Lbray infomation System v Help?
o My Paga Project Home Planning Testing Tracking Raporting
Test Cases | Test Sets Role: Manager

dfinset {3 Delete | o> indent < Outdent |- Showlevel— |v| RjRefresh | [hEdt [> Execwte |- Showhidecolumns~ |w| Y Filter

~ 4 Test Set Name Execution Status Planned Date Last Executed Qwner Status Test Set # Edit
0 | [=omv— ¥ m [ [i] [y -] [—am -] ™[ | [Fiter]
O = B Functional Test Sets 5.Feh-2007 In Progress TX000008 [» Edit |
o ] 5-Feb-2007 1-Dec-2003 Joe P Smith In Progress TX000001 » Edit
(] 7-Feb-2007 1-Dec-2003 Joa P Smith Mot Started TX000002
B Functionality {4) [ ] 10-Feb-2007 1-Dec-2003 Fred Bloggs In Progress TX000005
O %) Exploratory Testing (2) 22-Jan-2009 Fred Bloggs Deferred TX000006 [+ Edit |
0 = B Regression Test Sets Completed TX000009
O %) Regression Testing for Windows XP (2) 1-Dec-2003 Completed TH000003
(] ) Regression Testing for Windows Vista 2) 1-Dee-2003 Complated TX000004 » Edit
Shnw.lf_'l rows per page 4 < Displaying page"._ Sof1em

dbinset 3 Delele | o> indent b Outdent | [ Execute

The test set list consists of hierarchical list of all the test sets in the current project organized into
folders. When you create a new project, this list will initially be empty, and you will have to use the
<Insert> button to start adding test sets to the system.

Each test set is listed along with the number of test cases contained (in parenthesis), the
aggregate execution status of the contained test cases (using a graphical bar-chart), the date that
the test set has been scheduled to be executed (planned date), the date that it was last executed,
the person currently assigned to execute the test set, the status and the test set id. Clicking on a
test set’s hyperlink will take you to the test set details page for the item in question.

5.6.1. Insert

Clicking on the <Insert> button inserts a new test set before the currently selected (by means of
the check-box) test set. Clicking the <Insert> button without selecting a test set will insert a new
test set at the end of the list.

5.6.2. Indent / Outdent

Clicking on the <Indent> button indents all the test folders / test sets whose check-boxes have
been selected. You cannot indent a test set or folder if it is below a test set, as test sets are not
allowed to have child items. Clicking on the <Outdent> button de-indents all the test folders / test
sets whose check-boxes have been selected.

5.6.3. Delete

Clicking on the <Delete> button deletes the currently selected test sets. It will delete the
association between the test set and its contained test cases, but it will not delete the test cases
themselves.

5.6.4. Execute

Clicking on the <Execute> button executes all the test sets selected. The test execution
functionality of SpiraTeam® is explained in more detail in section 5.3.
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5.6.5. Refresh

Clicking on the <Refresh> button simply reloads the list of test sets. This is useful if other people
are making changes to the test set list and you want to make sure that you have the most current
version.

5.6.6. Edit

Each test set in the list has an <Edit> button display in its right-most column. When you click this
button or just click on any of the cells in the row, you change the item from “View” mode to “Edit”
mode. The various columns are made editable, and <Update> <Cancel> buttons are displayed in
the last column:

- Tea . Welcome. Fred Bloggs | My Profile | Log Out | [Lbrary Information System > Help?
a My Page Project Home Planning Testing Tracking Reporting
Test Cases | Test Sets Role: Manager
cdhinset §}Delele | o> indent < Qudent |—Showlevel— [v| BjRefesh | ChEdt [>Exeawe |-Show/hidecolumns— |w| Yf Fiter
v 4 Test Set Name Execution Status Planned Date LastExecuted  Owner Status Test Set # Edit
m| —any- v] ] [ @] [camw- ¥ —any— V] = [+ Finer |
O =l B Functional Test Sets 5-Feb-2007 In Progress TX000008 |- Edit ]
o &4 [Testing Cycle for Release 10 =3 I [25207 [E|E] 1-Dec-2003 [oepsmen  ¥|E] [mProwess ¥|ED [~ update | [+ Cancer |
O #4)[Testing Cycle for Release 11 [0 @] |1Dec-2003 [losPsmn ¥ [Motstaries ¥]
4] %) Testing New Functionality 4) || 10-Feb-2007 1-Dec-2003 Fred Bloggs In Progress TA000005 = Edit
O &) Exploratory Testing (2) 22-Jan-2009 Fred Bloggs Defarred TX000006 | [~ Edit |
0 = & Regression Test Sets Completed TX000009
O &) Regression Testing for Windows XP (2) 1-Dec-2003 Completed TX000003
] %) Regression Testing for Windows Vista (2) 1-Dec-2003 Complated TXO00004 | [» Eait
Show |15 7| rows per page i < Displaying page [1 | %of 1 »
gpinsert £ Delete £ Indent <& Outdent [ Execute

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed
on the first row, and you can make changes to all the editable rows and then update the changes
by clicking the one <Update> button. Also, if you want to make the same change to multiple rows
(e.g. to change the owner of five test sets from “Fred Bloggs” to “Joe Smith”), you can click on the
“fill"” icon to the right of the editable item, which will propagate the new value to all editable items
in the same column.

When you have made your updates, you can either click <Update> to commit the changes, or
<Cancel> to revert back to the original information. Alternatively, pressing the <ENTER> key will
commit the changes and pressing the <ESCAPE> key will cancel the changes.

5.6.7. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily
view the entire test set list at a specific indent level. For example you may want to see all test set
drilled-down to the third level of detail. To do this you would simply choose ‘Level 3’ from the list,
and the test sets will be expanded accordingly

5.6.8. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the test set list as
columns for the current project. To show a column that is not already displayed, simply select that
column from the list of “Show...” column names and to hide an existing column, simply select that
column from the list of “Hide...” column names. This is stored on a per-project basis, so you can
have different display settings for each project that you are a member of. The fields can be any of
the built-in fields or any of the custom properties set up by the project owner.
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5.6.9. Filtering
You can easily filter the list of test sets as illustrated in the screen-shot below:

Tea . Welcome. Fred Bloggs | My Profile | Log Out | | Lirary Information System » Help?
My Page Project Home Planning Testing Tracking Reporting

Test Cases | Test Sets Role: Manager

dhinset $3Delete | o> indent <b Outdent [—Showlevel— [v| RyRefesh | ChEdt [>Exeaste |- Showhidecolumns— [v] Y7 Fiter

¥ & Test Set Name Execution Status  Planned Date Last Executed Owner Status Test Set # Edit

O | [rowraie ¥] [ @] [ &) [ 2y — M| [~ sy~ v Txl_. [+ Filter |
O = B Functional Test Sets 5-Feb-2007 In Progress TXO00D0S * Edit |

O 25 Testing Cycle for Release 1.0 n 5-Feb-2007 1-Dec-2003 Joe P Smith In Progress TX000001 [» Edit |

O L] Testing New Functionality {4) | 10-Feb-2007 1-Dec-2003 Fred Bloggs In Progress TX000005 * Edit
Show [15 ¥ |rows per page 4 4 Displaying Fage"u_ mof 1w

To filter the list by any of the displayed columns, you either choose an item from the appropriate
drop-down list or enter a free-text phrase (depending on the type of field) then click <Filter> or
press the <ENTER> key to apply the different filters. Note that the name field is searched using a
“LIKE” comparison, so that searching for “database” would include any item with the word
database in the name. The other freetext fields need to be exact matches (e.g. dates, test set
numbers). In the screen-shot above, we are filtering on test sets that contain at least one failed
test case.

In addition, if you have a set of filters that you plan on using on a regular basis, you can choose
the option Filter > Save Filter to add the current filter to the list of saved filters that appear on your
‘My Page’. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter.

5.6.10. Copying Test Sets

To copy one or more test sets, simply select the check-boxes of the test sets you want to copy
and then select the Edit > Copy menu option. This will copy the current test set selection to the
clipboard. Then you should select the place where you want the test sets to be inserted and
choose the Edit > Paste option.

The test sets will now be copied into the destination location you specified. The name of the
copied test sets will be prefixed with “Copy of...” to distinguish them from the originals.

5.6.11. Moving Test Sets
To move test sets in the hierarchy, there are two options:

1. Click on the icon the test set/folder you want to move and then drag the icon to the
location you want it moved. The background of the destination location will change as the
icon is dragged over it to illustrate where it will be inserted.

Once you have the test set/folder positioned at the correct place that you want it inserted,
just release the mouse button and the test set list will be refreshed, with the item moved
to the desired location.

2. Alternatively you can simply select the check-boxes of the test sets you want to move
and then select the Edit > Cut menu option. This will cut the current test set selection to
the clipboard. Then you should select the place where you want the test sets to be
inserted and choose the Edit > Paste option. The test sets will now be moved into the
destination location you specified.
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5.7. Test Set Details

When you click on a test set item in the test set list described in the previous section, you are
taken to the test set details page illustrated below:

- T . Welcome, Fred Bloggs | My Profila | Administration | Log Out | |Ubrary Information System v Help?
- My Page Project Home Planning Testing Tracking Reporting

Test Cases | Test Sets > Test Set Details Role: Manager

<< Back to Test Set List | Blsae chsaeandNew 30sele | B Reiesh [> Beoe (5P

B> Functional Test Sets Test Set: Testing Cycle for Release 1.0 [TX:000001]
5 N
| Testing Cycle for Rel 1.0 = -
1B R B s Name®: |TesungCycIe for Release 1.0
=2 Testing Cycle for Release 1.1
X
= Testing New Fi ¥ R
o Dy [~ Fort - V| [-Se- v| BIU|EEE|SiEEE|hE|—egOo@

5 Exploratory Testin

This tests the functionality introduced in release 1.0 of the library system

Release [12.00- Lorary Systemastease 1 v Created On 1/2/2007 12:00:00 AM

Status": I Progress v Last Executed:  12/1/2003 10:45:20 AM

Planned Date: [25/2007 [ Last Updated:  10/13/2009 3:07:52 PM
Test Cases * Test Runs * Custem Props Atiachments History

This page is made up of three areas; the left pane is the navigation window, the upper part of the
right pane contains the test set detailed information itself, and the bottom part of the right pane
contains related information about the test set.

The navigation pane consists of a link that will take you back to the test set list, as well as a list of
the peer test sets to the one selected. This latter list is useful as a navigation shortcut; you can
quickly view the detailed information of all the peer test sets by clicking on the navigation links
without having to first return to the test sets list page.

The top part of the right pane allows you to view and/or edit the details of the particular test set.
You can edit the various fields (hame, description, etc.) and once you are satisfied with them,
simply click either the <Save> or <Save and New> button at the top of the page to commit the
changes. In addition you can delete the current artifact by choosing <Delete>, discard any
changes made by clicking <Refresh> or print it by clicking <Print>.

The lower part of the right pane can be switched between five different views by clicking the
appropriate tab. Initially the pane will be in “Test Cases” mode, but it can be switched to “Test
Runs”, “Custom Properties”, “Attachments” and “History” modes if so desired. Each of the views
is described separately below. In addition there is a shortcut link “Execute This Test Set” that
allows you to execute all the tests in the set against the release specified in the test set.

5.7.1. Test Cases

In this mode, the main pane displays the list of test cases contained within the test set. You can
add, remove, reposition and remove test cases from the list. The execution status displayed next
to each test case is the most recent execution status of the test case when run in the context of
the current test set.
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Test Cases # Custom Props * Attachments History

v Test Case Name Priority Est. Duration Last Executed Execution Status Test Case #
SR Add  $2 Remove 4 MoveUp < MoveDown [ Refresh
LJ Ability to create new book @ 1 - Critical 10 mins 1-Dec-2003 12:00 AW Failed TCO00002
& Ability to edit existing book 1 - Critical 5 mins 1-Dec-2003 12:00 AM Caution TC000003
AJ Ability to create new author g 1 - Critical 3 mins 1-Dec-2003 12:00 AM Failed TCO000004
&3 Ability to edit existing author 2 - High 5 mins 1-Dec-2003 12:00 AM Not Run TC000005
Q Ability to reassign book to different author 2 - High 8 mins 1-Dec-2003 12:00 AM Mot Run TC000006
LJ Book management 2 - High 4 mins 1-Dec-2003 12:00 AM Mot Run TCO00008
L_j Author management 2 - High 4 mins 1-Dec-2003 12:00 AM Not Run TCO0000S

5.7.2. Test Runs

This view displays the list of all the test runs executed against the test set. Each test run is listed
together with the date of execution, the name of the test case, the name of the tester, the
release/version of the system that the test was executed against, the overall execution status for
the test case in that run and a link to the actual test run details (see section 5.4). In addition, you
can choose to display any of the custom properties associated with the test run.

Test Cases ® Test Runs = Custom Props & Attachments History

> Refresh | Apply Filter | Clear Filters | ~ Show/hide columns ~ v|

¥ & TestRun Name AY Execution Date AV Test Set AY  Release AY  Status AY Est. Dur. AY Act. Dur. AY Web Browser oY Operating System AY Run# AY
0 [ Teating Cycte 1 ¥ | |- Aw w| [-Amy- vl | H--;ny- v - Ay v TR| |

O T Ability to create new suthor | 1-Dec-2003 5 Failed 0.1h 1.5h TRO00004

O | % Ability to edit existing book | 1-Dec-2003 Passed 0.1h 1.5h TRO00003

O a B Abil ty to create new book | 1-Dec-2003 FIiad 02h 1.3n Intemnet Explorer Windows XP TRO00001

Show[15 ¥ | rows per page < < Displaying page i". |%of1e»

The “customize columns” drop-down list allows you to change the fields that are displayed in the
test run list as columns. To show a column that is not already displayed, simply select that
column from the list of “Show...” column names and to hide an existing column, simply select that
column from the list of “Hide...” column names. The displayed columns can be any standard field
or custom property.

You can also filter the results by choosing items from the filter options displayed in the sub-
header row of each field and clicking the “Apply Filter” link. In addition, you can quickly sort the
list by clicking on one of the directional arrow icons displayed in the header row of the appropriate
field.

5.7.3. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
test sets. To learn more about how to setup and configure custom properties for a project, please
refer to the SpiraTest Administration Guide.

Test Cases # Test Runs # Custom Props # Attachments History

The following are the custom properties of this artifact:

Notes:

Operating System: [Windows 2003 ~|

Assuming that custom properties have been defined for your project, you will see a list of optional
parameters that can be set on the test set. These can be either freetext or drop-down-lists. If you
want any of the custom list properties to prepopulate the corresponding value of the test run (e.g.
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you want all test runs to be marked with Operating System = Windows XP) make sure that both
the test set and the test run are configured to use the same custom list.

5.7.4. Attachments

In this mode, the main pane displays the list of documents that have been “attached” to the test
set. The documents can be in any format, though SpiraTeam® will only display the icon for
certain known types.

Test Cases # Test Runs # Custom Props # Attachments History
Document Name Type Size Uploaded By Upload Date ¥
& http-/fwww. mycompany.com/Relatedinformation URL 0 KB Fred Bloggs 22-Jan-2009

Attach New Document/URL

Type:* O File ® URL

URL:" | ‘

Description: | ‘

The attachment list includes the filename that was originally uploaded together with the file-size
(in KB), name of the person who attached it and the date uploaded. In addition, if you position the
pointer over the filename and hold it there for a few seconds, a detailed description is displayed
as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser
window will open. Depending on the type of file, this window will either display the document or
prompt you for a place to save it on your local computer. To delete an existing attachment from a
test set, simply click the <Delete> button and the attachment will be removed from the list.

To attach a new document to the test set, you need to choose “File” as the type and then click the
Browse button and select the file from your local computer, optionally enter a detailed description
then click the <Upload> button. The document will be copied from your computer and attached to
the test set. To attach a web-link (URL) to the test set, you need to choose “URL" as the type and
then enter the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional
description and then click the <Upload> button to attach the web-link.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn't put file
extensions on filenames (e.g. .xls for an Excel sheet) automatically, then you will need to
manually add the file extension to the filename before uploading if you want it to be displayed with
the correct icon in the attachment list.

5.7.5. History

In this mode, the main pane displays the list of changes that have been performed on the test set
artifact since its creation. The change history displays the date that each change was made,
together with the fields that were changed, the old and new values and the person who made the
change. This allows a complete audit trail to be maintained of all changes in the system.
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6. Incident Tracking

This section outlines how the incident/defect tracking features of SpiraTeam® can be used to
manage key project artifacts during the software development lifecycle. In addition to managing
the defects raised during the execution of test cases in the test management module, the Incident
Tracker is also a powerful risk/issue/bug tracking system in its own right. When coupled with the
project dashboard (see section 3.4) it is a powerful tool for representing all the key risks and
issues associated with a project in a single, graphical format.

Unlike a standalone bug/issue tracking tool however, you can trace the incidents/defects back to
the test case and the underlying requirement that generated them, giving the project manager
unprecedented power in analyzing the “in-process” quality of a system during its lifecycle. This
power is clearly illustrated in the “Requirement Incident Count” pane in the Project Home
dashboard (see section 3.4.4).

6.1. Incident List

When you click on the Tracking > Incidents global navigation link, you will initially be taken to the
incidents list screen illustrated below:

o Team‘ Welcome, Fred Bloggs | My Profile | Log Out | [ Loy infermation System vl Help?
My Page Project Home Planning Testing Tracking Reporting

Incidents | Tasks Role: Manager
b Newincident  §3 Delete | [ Refresh | [hCopy [ Expot |- Showhidecolumns -~ | Y Fiter
Displaying 16 - 30 out of 60 incident(s) for this project

v @ Incident Name A Y Type AT Status A Y Priority AV Detected By AY Owned By AY Closed On &Y Operating System AY Inc. # AY Edit

0 ‘ | Ay v |..Al‘y.. v |..,\r,.. v| |..:.n,... v| I..{.ny.. v| EEE v‘ [N_| [+ Fiter |

(] B Ability to generate customized reports  Enhancement Resolved 1 - Critical Joe P Smith Joe P Smith INODOO25 | |»

0 B ability to associate mulliple authers  Enhancement  Duplicate 1 - Critical Fred Bloggs INO0Q029

O ) section 508 compliance Issue Closed 1 - Critical Fred Bloggs Joe P Smith 3.Dec-2003 INODQO35

0 B Toct Training tem Training Assigned 1 - Critical Fred Bloggs Fred Bloggs IN0OOOO40

0 tem Limitation Limitation Open 1 - Critical Fred Bloggs INODOD45

a tem Limitation Limitation Assigned 1 - Critical Joe P Smith Fred Bloggs INOOOD46

O tem Limitation Limitation Duplicate 1 - Critical Joe P Smith Fred Bloggs IN0O0OS0

] t nge Reguest Change Request Closed 1 - Critical Fred Bloggs Joe P Smith 10-Dec-2003 INOODOSS

O ™ sample Risk 1 Risk Open 1 - Critical Fred Bloggs INODODSS

=] ¥ Confiqurable meta-data columns Enhancement  Resolved 2 - High Joe P Smith Joe P Smith INODQ026

] B intogration of security with NTLM/PKI  Enhancement | Assigned 2 - High Joe P Smith Joe P Smith INODDD22

a 3] Support for IBM DB2 Enhancement Open 2 - High Fred Bloggs INOOOD19

0 ¥ The homepage hangs whilst loading ~ Bug Mot Repreducible |2 - High Joe P Smith Fred Bloggs INOOOD16

a ) Quote handiing issues throughout Bug Resolved 2 - High Fred Bloggs Fred Bloggs INOOOD12

O @ ¥ Editing the date on a book is clunky | Eug Assigned 2 - High Joe P Smith Fred Bloggs IN0O0008 E
Ehcw:u_v fows per page 14 « Displaying page 2_"- of dmm

The incident list screen displays all the incidents entered for the current project, in a filterable,
sortable grid. The grid displays the incident number together with fields such as incident type
(bug, issue, risk, etc.), status (new, open, etc.), priority, name, assigned owner, detection date,
detector, closed date, etc. The choice of columns displayed is configurable per-user, per-project,
giving extensive flexibility when it comes to viewing and searching incidents.

In addition, you can view a more detailed description of the incident (along with a resolution if
any) by positioning the mouse pointer over the incident name hyperlink and waiting for the popup
“tooltip” to appear. If you click on the incident name hyperlink, you will be taken to the incident
details page described in section 6.2. Clicking on any of the pagination links at the bottom of the
page will advance you to the next set of incidents in the list according to the applied filter and
sort-order. There is also a drop-down-list at the bottom of the page which allows you to specify
how many rows should be displayed in each page, helping accommodate different user
preferences.
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6.1.1. Sorting and Filtering
You can easily filter and sort the list of incidents as illustrated in the screen-shot below:

Team Welcome, Fred Bloggs | My Profile | Log Out | [Tbrey romaton Sysem [ w] Help?
T My Page Project Home Planning Testing Tracking Reporting
Incidents | Tasks Role: Manager
b Newincident  §3Delete | @jRefesh | Chcopy [ Expot |- Showhidecolmns— | Y Fier
Displaying 1 - 14 out of 14 incident(s) for this project
v @ Incident Name 4 ¥ Type 4 ¥ Status AV Priority A¥ Datected By AY Owned By AY Closed On A¥ Operating System A ¥ Inc. # A Edit
0 | [eus ] [-an- v [~an- v [an- v A V|| T v| w | [+ Filter |
O ®) Cannot add a new book to the system | Bug Duplicate Fred Bloggs Fred Bloggs INDOOOAT | = Edi
O | ™) patabase not backing up comectt Bug Open Joe P Smith INOODOD4
O | ®) Cannot install system on Oracle 9 Bug Open 1- Critical Fred Bloggs 1N00000S
[0 @ ™) Cannot add a new book to the system  Bug Assigned 1 - Critical Joe P Smith Joe P Smith Windows XP INOODOOT
O ™ Validation on the edit book page Bug Resolved 1 - Critical Fred Bloggs Joa P Smith INO00O11
O ) session handling Bug Closed 1- Critical Joa P Smith Joe P Smith 21-How-2003 INDDDO1S
O ) The homepage hangs whilst loading Bug Mot 2 - High Joz P Smith Fred Bloggs INO00016
Reproducible
O %) Quote handling issues throughout Bug Resolved 2 - High Fred Bloggs Fred Bloggs INOOODA2 | [+ Eait
[ @ ™) Editing the date on a book is clunky Bug Assigned 2 - High Joe P Smith Fred Bloags INODO003 |- Edi
O | 8| ™) The book listing screen doesn sort Bug Open 3 - Medium Joe P Smith Windows 2003 INDDODOE | |+ Edit
O 3| Editing the date on an auther is clunky  Bug Assigned 3 - Medium Joe P Smith Joe P Smith INDO0D0S
O %) The tables get cutoff on low-res modes  Bug Closed 3 - Medium Joe P Smith Joe P Smith 20-Nov-2003 INOO0013
O ¥ pemissions not updating when changed  Bug Closed 4-Low Joe P Smith Fred Bloggs 21-Nov-2003 IN0D0014
O ™) Doesnt let me add a new category Bug Resolved 4-Low Fred Bloggs Fred Bloggs 1000010 Edi
Shcw’E_v rows per page < 4 Displaying page[1 | of 15 »

To filter the list by incident type, status, priority, owner or detector name, you simply choose an
item from the appropriate drop-down list, and for the other fields, you enter a free-text phrase
then click <Filter> or press the <ENTER> key to apply the different filters. Note that the name
field is searched using a “LIKE” comparison, so that searching for “database” would include any
item with the word database in the name. The other freetext fields need to be exact matches (e.g.
dates, incident numbers). There are also several aggregate filters that are used to filter on
multiple values at once (e.qg. filtering status on (All Open) will return any incident that is in one of
the open statuses — new, open, assigned, reopen).

To change the column that is sorted, or to change the direction of the current sort, simply click on
the up/down arrow icon in the appropriate column. The currently sorted column is indicated by the
larger, white arrow with the back-border. In the screen-shot above, we are filtering on type=bug
and sorting by decreasing priority.

Clicking on Filter > Clear Filter removes any set filters and expands the incident list to display all
incidents for the current project, and clicking on Filter > Save Filter allows you to save the filter to
your ‘My Page’ for use in the future. The list of saved filters can also be retrieved by clicking Filter
> Retrieve Filter.

6.1.2. New Incident

Clicking on the <New Incident> button takes you to the new incident screen. This is essentially
the same screen as the incident details screen shown in section 6.2 except that the <Update>
button is replaced by an <Insert> button, and depending on how the workflow has been
configured for your project, certain fields may be disabled. For more details on setting and up
configuring workflow for your project, please refer to the SpiraTest Administration Guide.

6.1.3. Delete

Clicking on the <Delete> button deletes the incidents whose check-boxes have been selected in
the incident list.
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6.1.4. Refresh

Clicking on the <Refresh> button simply reloads the list of incidents; this is useful when new
incidents are being added by other users, and you want to make sure you have the most up-to-
date list displayed.

6.1.5. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the incident list as
columns for the current project. To show a column that is not already displayed, simply select that
column from the list of “Show...” column names and to hide an existing column, simply select that
column from the list of “Hide...” column names. This is stored on a per-project basis, so you can
have different display settings for each project that you are a member of. The fields can be any of
the built-in fields or any of the custom properties set up by the project owner.

6.1.6. Edit

Each incident in the list has an <Edit> button display in its right-most column. When you click this
button or just click on any of the cells in the row, you change the item from “View” mode to “Edit”
mode. The various columns are made editable, and <Update> <Cancel> buttons are displayed in
the last column:

o Team‘ Welcome, System Administrator | My Profile | Administration | Log Out | |[Librry infomation Sysem v Help?
My Page Project Home Planning Testing Tracking Reporting

b Newincident  §3 Delete | [ Refresh | Chcopy [ Expot |- Showhidecolumns - |v| 77 Fiter

Displaying 1 - 14 out of 14 incident(s) for this project
¥ U Incident Name 4 ¥ Type AY Status 4F Priority AY Detected By A¥Y  Detected On AY Owned By AT Inc. # AV Edit
O sug Y] [y v ~Ary- V]| [-any- v ‘ B8] [-aw-__ ¥] m[_]
B1| ™ cannat add a new book to the system Bug Duplicate Fred Bloggs 15-Now-2003 Fred Bloggs IN000017 | [ Edit|
O | ®)patabase not backing up comactly Bug Open Joe P Smith 2:Nov-2003 IN000004 | [» Edit |
D 3] |Cannotinstall system on Oracle Si =D |E“D 'l: 1 [open ¥|ED || 1- criiem Yl 1 [FreaBiggs ¥ |[ 7 2-Nov-2003 m 7| [+ Update
O @ ®[Cannotadd anew book o the system [o V] [mssgmes ¥] |[oepsnanv]  +Hov2003 [epsmmn ¥]
O | ™) validation on the edit book page Bug Resolved 1 - Critical | Fred Bloggs 15-Now-2003 Joe P Smith INOB0OT1 | [ Edit_|
O ®)session handing Bug Closed 1 - Critical Joz P Smith 15-Now-2003 Jog P Smith IN0O0015 | [~ Edit_|
[0 | ™) The homepage hangs whilst Iading Bug Naot Reproducible 2 - High Joz P Smith 15-Now-2003 Fred Bloggs INOOOO1E | [~ Edit_|
O | ™) quote handling issues throughout Bug Rasolved 2 - High Fred Bloggs 15-Now-2003 Fred Bloggs IN000012 | [~ Edit |
O @ ™) Editing the date on a baok is elunky Bug Assigned 2 - High Joz P Smith 4.Nov-2003 Fred Bloggs IN0O000S | [~ Edit |
0O @ ™) the baak listing sereen doesnt sont Bug Open 3 - Medium Joe F Smith 2-Mov-2003 INDO000E |» Edit ‘
O %) Editing the date on an auther is clunky Bug Assigned 3 - Medium Joe P Smith 4-Nov-2003 Joe P Smith INODO0D3 |- Edit |
0 ) The tables get cutoff on low-res modes Bug Closed 3 - Medium Jog P Smith 15-Mov-2003 Joe P Smith INO00013 |— Edit |
0O ) permissions not updating when changed Bug Closed 4-Low Joe P Smith 15-Nov-2003 Fred Bloggs INO00014 | [~ Edit_|
0 ) Dossnt lat me add a new cateqory Bug Resolved 4-Low Fred Bloggs 4-Nov-2003 Fred Bloggs INO00010 |- Edit \
Show[15 ¥ rows per page M « Displaying page ’1_ Taof 1w

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed
on the first row, and you can make changes to all the editable rows and then update the changes
by clicking the one <Update> button. Also, if you want to make the same change to multiple rows
(e.g. to change five incidents from “Resolved” status to “Closed”), you can click on the “fill" icon to
the right of the editable item, which will propagate the new value to all editable items in the same
column.

When you have made your updates, you can either click <Update> to commit the changes, or
<Cancel> to revert back to the original information. Alternatively, pressing the <ENTER> key will
commit the changes and pressing the <ESCAPE> key will cancel the changes.

Note that in the case of incidents, you need to have Project Owner permissions for the project to
make bulk changes using the <Edit> button as such changes can override the workflow business
rules established.
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6.1.7. Copying Incidents

To copy an incident or set of incidents, simply select the check-boxes of the incidents you want to
copy and then click <Copy>. This will make a copy of the current incident with its name prefixed
‘Copy of ...." to distinguish itself from the original. Any file attachments will also be copied along
with the incident itself.

6.1.8. Exporting Incidents

To export an incident or set of incidents from the current project to another project in the system,
all you need to do is select the check-boxes of the incident(s) you want to export and then click
the <Export> button. This will then bring up a list of possible destination projects:

S’mreamk ‘Welcome, System Administrator | My Profile | Administration | Log Out | Help?
My Page Project Home Planning Testing Tracking Reporting

Incidents | Role: Project Owner I

Grnowmcse {3 oo | Qufeten | Qg en ¥

Displaying 1 - 14 out of 14 incident(s) for this project
¥ @ Incident Name A Y Type A¥Y | Export ltems tected By AY  Detected On AY  Owned By AY  Inc.#AY  Edit
= | | |Buq Please select the project you want to export to [ A | | | |_A"r_ Yl o |:|
0O B Cannot add a new book to the system Bug ) |d Bloggs 15-Hov-2003 Fred Bloggs INDOBO1T
O ®lpasbase not backing up comectly Bug Sample Application One ¥ |psmitn 2-Nov-2003 INOD000
¥ Cannot install system on Oracle S Bug > Export | Cancel |d Bloggs 2-Nov-2003 1N0D000S
O @ ™) Cannot add a new book to the system Bug P Smith 4-Now-2003 Joe P Smith 1NOODOOT
O ] valigation on the edit book page Bug Resolved Fred Bloggs 15-Nov-2003 Joe P Smith MOOOO11
0 ¥ Session handling Bug Closed - Joe P Smith 15-Nov-2003 Joe P Smith INODDO15
O | ™ The homepage hangs whilst loading Bug Mot Reproducible | 2-High | Joe P Smith 15-Nov-2003 Fred Bloggs 1NODO015
] B Quote handling issues throughout Bug Resalved '2-High  Fred Bloggs 15-Hov-2003 Fred Bloggs 1N000012
O @ ™ Editing the date on a book is clunky Bug Assigned m Joe P Smith 4-Now-2003 Fred Bloggs INODO0O0B
[0 |8 ™ The book listing screen doesn't sort Bug Open 3 - Medium Joe P Smith 2-Now-2003 INDOOO0G
[m] ®1 Editing the date on an author is clunk Bug Assigned 3 - Medium Joe P Smith 4-Now-2003 Joe P Smith INOO0O0Y
[m] B The tables get cutoff on low-res modes Bug Closed 3 - Medium Joe P Smith 15-Nov-2003 Joe P Smith INDOD013
O ] permissions not updating when changed Bug Closed 4 -Low Joe P Smith 15-Hov-2003 Fred Bloggs IM000014
O ™) Doesnt let me add a new catego Bug Resolved 4 -Low Fred Bloggs 4-Now-2003 Fred Bloggs INDODO10
Show ToWs per page 1 « Displaying page El% of 1mm

o New incident  £3 Delele | 2 Relresh

Once you have chosen the destination project and clicked the <Export> button, the incidents will
be exported from the current project to the destination project. Any file attachments will also be
copied to the destination project along with the incidents.

6.2. Incident Details

When you click on an incident item in the incident list, or click the <New Incident> button (as
described in section 6.1), you are taken to the incident details page illustrated below:




Welcome, Fred Bloggs | My Profile | Log Out | Library nformation System v Help?

aTeam
h My Page Project Home Planning Testing Tracking Reporting
Incidents = Incident Details | Tasks | Resources Role: Manager
<< Back to Incident List | E)save [)sSaveandClose ohSaveandNew | IN[7 [Find | | B Refresh (3 Print
Workflow Operations Incident Mame: Cannot add a new book to the system (INOD000T)

> Besolve Incident Name:" Cannotadd a new book to the system
> Unable to Reproduce
> Duplicate Incident Status:” = Assigned Detected By:" | Joe P Smtn v |
Type:" Bug v Detected In Release: [1.0.0.0 - Lbrary System Release 1 v |
e N . L
annot log into the appl . E
e =200 ! - Priority: 1 - Critical v‘ Resohed In Release: 1010 - Library System Aelease | SP1 "]
%) hot able to add new autho L
R_-I Chl i T Severity 3 - Medium v Verified In Release:
¥ Database not backing up ¢ Owned By:* Fred Bloggs v Detected On: 11/4/2003 12:00:00 AM
B install sy
;'I Cannot install system on Last Modified 572009 9:50:20 AM
%) The book listing screen d e
a ;
_?ICannolﬂddanewhnuklo... Fert~ s _Size - o B I u|!!:|ﬁ5!5’t€!|'&%|—ﬂﬁﬂ<>@
¥ Editing the date on a boo

B When | click on the butten to add a book, enter the new information and click submit, | get a subscript out of range error
21 Editing the date on an au

%) Doesnt let me add a new
) validation on the edit bo..
B Quote handling issues thr.
B The 1ables get eutoff en
’ﬂ Permissions not updating
B Session handling

Schedule * Custom Props * Attachments * History * Associations *

This page is made up of three areas; the left pane is the navigation window where you can
quickly jump to other incidents as well as execute workflow transitions (see below), the upper part
of the right pane contains the incident detailed information itself, and the bottom part of the right
pane displays different information associated with the incident.

The left-hand navigation pane consists of a link that will take you back to the incident list, as well
as a list of the other related incidents that match the currently selected sort and filter option on the
incident list page. If the number of incidents exceeds fifteen, only the first fifteen entries will be
shown. Above this navigation list is a highlighted box that displays the list of any workflow
transitions that the current user can execute on the incident. This is described in more detall
below.

In addition to the left hand navigation, you can enter a specific incident number in the text-box in
the toolbar and click the <Find> button. In the same toolbar, there is also a shortcut for creating a
new incident without having to first return to the incident list page. In addition, the lower section of
the incident details page can be switched been four different views: “Resolution”, “Custom
Properties”, “Attachments”, “History”, and “Associations”. These are described later.

6.2.1. Editing an Existing Incident

If you are editing an existing incident, the fields that are available and the fields that are required
will depend on your stage in the incident workflow. For example an open incident might not
require a “Resolved Version” whereas a resolved incident could well do. The types of change
allowed and the email notifications that are sent will depend on how your project administrator
has setup the system for you. Administrators should refer to the SpiraTeam Administration Guide
for details on configuring the incident workflows to meet their needs.

Depending on the user’s role and whether they are listed as the owner or detector of the incident

or not, displayed in the left hand side of the page, above the navigation list is a set of allowed
workflow operations:
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Workflow Operations

= RHesolve Incident ‘—l Status > Assianed
atus: ssigne
= Unable to Reproduce 9

= Duplicate Incident

These workflow transitions allow the user to move the incident from one status to another. For
example when the incident is in the Assigned status, you will be given the options to:

» Resolve the Incident — changes status to “Resolved”
>» Unable to Reproduce — changes the status to “Not Reproducible”
» Duplicate Incident - changes the status to “Duplicate”

After changing the status of the incident by clicking on the workflow link, you can then fill in the
additional fields that are now enabled and/or required. Once you've made the changes to the
appropriate incident fields, you can either click <Save>, <Save and Close>, or <Save and New>
to commit the changes or <Refresh> to discard the changes and reload the incident from the
database. In addition you can print the current incident by clicking <Print>, which will display a
printable version of the page in a separate window.

6.2.2. Inserting a New Incident

If you are creating a new incident, the fields that are available and the fields that are required will
depend on how your project has been for configured. For example, some projects may require
that all incidents be started with Status=New and Type=Incident, others may allow you to specify
the incident type. The types of change allowed will depend on how your project administrator has
setup the system for you. Administrators should refer to the SpiraTeam Administration Guide for
details on configuring the incident workflows to meet their needs.

Once you've filled out the appropriate incident fields, you can either click <Save>, <Save and
Close> or <Save and New> to commit the new item or click on the “Back to Incident List” to
discard the insertion and return back to the incident list.

6.2.3. Resolution

In this mode, the lower section of the screen displays a threaded list of resolutions that have been
logged against this incident:
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Resolution # Schedule # Custom Props # Attachmentz Higtory Aszsociations

To add a new resolution or comment to this incident, please enter it below and click the [Update] button:*

E| Tty | — oo O @

[Fort] - || [5ize] ~x B I O

= Existing Resolutions/Comments:
= Joe P Smith {11-Now-2003 )
Retested and it looks good
= Fred Bloggs (10-Nov-2003 )

Fixed the permissions check in the admin module

|- Update ||- Update & Close ||- Cancel |

You can expand or collapse the list of existing resolutions by clicking the appropriate expand or
collapse icon. To add a new resolution to an incident, all you need to do is enter the new
resolution / comment in the text box above the list and then click <Update>. Your resolution will
now be added to the existing items in the list.

6.2.4. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
incidents. To learn more about how to setup and configure custom properties for a project, please
refer to the SpiraTest Administration Guide. Assuming that custom properties have been defined
for your project, you will see a list of optional parameters that can be set on the incident. These
can be either freetext or drop-down-lists. In the example below, you can enter Notes, and/or the
Operating System that the incident was observed on.

General # Custom Properties # Attachments # History # Aszociations #

Please edit the following custom properties of this artifact and click [Update] when finished:

MNotes: May be an array bounds issue

Operating System: | Windows XP hd

Once you are satisfied with the values for the custom properties, simply click [Update] to commit
the changes.

6.2.5. Attachments

In this mode, the lower section of the screen displays the list of documents that have been
“attached” to the incident. The documents can be in any format, though SpiraTeam® will only
display the icon for certain known types.
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Re=zolution Schedule # Custom Props # Attachments # Higtory # Aszszociations *

Document Name Type Size Uploaded By Upload Date ¥
] Error Stackirace doc File 24 KB Fred Bloggs 1-May-2006
&1 Web Page capture htm File 88 KB Fred Bloggs 25-Apr-2006

Upload New Document/URL

Type:* @ File O URL
Filename:* | [ Browse... |
Description: | |

The attachment list includes the filename that was originally uploaded together with the file-size
(in KB), name of the person who attached it and the date uploaded. In addition, if you position the
pointer over the filename and hold it there for a few seconds, a detailed description is displayed
as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser
window will open. Depending on the type of file, this window will either display the document or
prompt you for a place to save it on your local computer. To delete an existing attachment from
an incident, simply click the <Delete> button and the attachment will be removed from the list.

To attach a new document to the incident, you need to choose “File” as the type and then click
the Browse button and select the file from your local computer, optionally enter a detailed
description then click the <Upload> button. The document will be copied from your computer and
attached to the incident. To attach a web-link (URL) to the incident, you need to choose “URL" as
the type and then enter the fully qualified URL (e.g. http://mywebsite.com?Document=1), an
optional description and then click the <Upload> button to attach the web-link.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn't put file
extensions on filenames (e.g. .xls for an Excel sheet) automatically, then you will need to
manually add the file extension to the filename before uploading if you want it to be displayed with
the correct icon in the attachment list.

6.2.6. History

In this mode, the main pane displays the list of changes that have been performed on the incident
artifact since its creation. An example incident change history is depicted below:

General ¥ Custom Properties # Attachments # History # Associations #
Change Date ¥ Field Name Old Value New Value Changed By
5/2/2006 12:00:00 AM Status Open Assigned Fred Bloggs
3/5/2005 12:00:00 AM Status New Open Fred Bloggs
3/4/2005 12:00:00 AM Type Incident Bug Joe P Smith

The change history displays the date that each change was made, together with the fields that
were changed, the old and new values and the person who made the change. This allows a
complete audit trail to be maintained of all changes in the system.

6.2.7. Associations

In this mode, the main pane displays a list of any requirements, test runs, test steps or other
incidents that are associated with this incident:
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http://mywebsite.com/?Document=1�

Resolution Schedule # Custom Props ® Aftachments # History # Associations *

v Date Artifact Name Created By Comment Artifact Type Artifact #
dahdd {3 Delete
19-Mar-2004 ) Ability to associate books with different editions Joe P Smith Requirement RQO00009
19-Mar-2004 £ Ability to ¢ Fred Bloggs This incident is related to the test step Test Step TS000002
17-Mar-2004 & The book | Joe P Smith Incident INOD000B
1-Dec-2003 B Ability reate n Joe P Smith Test Run: Ability to create new book Test Run TRO00001
1-Dec-2003 ) Ability to add new books to the system Fred Bloggs Test Run: Ability to create new book Requirement RQO00004

[* update | [> Update & Close | [+ Cancel |

The incidents in this list are ones that a user has decided are relevant to the current one and has
created a direct link between them. In the case of requirements and test cases, the association
can be either due to the creator of an incident directly linking the incident to the requirement or
test step, or it can be the result of a tester executing a test-run and creating an incident during the
test run. In this latter case, the check-box to the left of the association will be unavailable as the
link is not editable.

Each association is displayed with the type of artifact (requirement, test step, test run, incident),
the name of the artifact being linked-to, the name of the person who created the association, and
a comment that describes why the association was made. In the case of an indirect association
due to a test run, the comment will contain the name of the test run.

To create a new association, simply click the <Add> icon and then choose the type of artifact you
want to create an association to:

Add New Association (Step 1 of 2)
Please choose the artifact that you want to add an association to:

@ Requirement Incident

|- Next | |- Cancel |

Once you have selected the appropriate artifact type, you will then be able to choose the specific
artifact you want to link to. In the case of requirements you choose the item from a hierarchical
list-box, and in the case of incidents you can either enter the incident ID or choose from a list of
incidents you have recently submitted. In either case you can also add a comment that explains
the rationale for the association:

Add New Association (Step 2 of 2) Add New Association (Step 2 of 2)
Please choose the requirement that you want to add an association to: Please choose the incident that you want to add an association to:
- @  EnterIncident & |y |

el Add from history:  [Sample Risk 1 =
Ability to edit existing books in the system Sample Risk 2 £

- Ability to delets existing books in the system Sample Risk 3
-« Ability to associate books with different subjects TestChange Request

bility to associate books with different authors TestChange Request
bility to associate books with different editions TestChange Reguest
bility to completely erase all books stored in the systemwith one click ~ TestChange Request
Test Change Request
TestChange Request -

Comment

Comment

Finally, to delete an existing association (except for those due to test runs) select the check-box
next to its name and click the <Delete> icon. This will only delete the association, not the linked
artifact itself.

© Copyright 2006-2009, Inflectra Corporation Page 75 of 121 This document contains Inflectra proprietary information




7. Release Management

This section outlines how to use the Release Management features of SpiraTeam® to manage
different versions of the system being tested in a particular project. This is an optional feature of
the system, and you can manage the testing for a project successfully without tracking individual
releases. Typically when you develop a system, it is important to ensure that features introduced
in successive versions do not impair existing functionality - this is known as regression testing.

In such situations, you will want to be able to execute the same set of test scripts against multiple
versions of the system and be able to track failures by version. A feature that works correctly in
version 1.0 may fail in version 1.1, and the maintenance team may be testing the existing lifecycle
of v1.0 in parallel with the development team testing v1.1. Therefore by developing a master set
of releases/versions in the Release Management module, you can have the different testing
teams correctly assign their testing actions to the appropriate version.

There are two types of release artifact in SpiraTeam® - major project releases that are displayed
with the blue release icon and represent major versions of the system, and release Iterations (aka
builds) that are displayed with a yellow icon and represent intermediate builds/iterations of the
system. Note: Iterations can be contained within a Release, but not the other way round.

The main differences between releases and iterations are as follows:

» Releases are independent versions of the system being tested and as such, you can map
a requirement directly to a release, indicating the release of the system that the
requirement will be fulfilled in.

» When you report on a release (e.g. on the project home or in one of the reports) any child
iterations are automatically taken into account, and test runs and incidents that are
related to the child iterations will get included in the release reports. Child releases on the
other hand are not aggregated up into the parent release.

7.1. Release List

When you click on the Planning > Releases global navigation link, you will initially be taken to the
release list screen illustrated below:

e Team- Welcome, System | My Profile | Administration | Log Out | [Lirery infomation System  |w] Help?
) My Page Project Home Planning Testing Tracking Reparting

Requirements | Releases | [terations Role: Project Owner

dpinsed 3 Delete | > indent <o Ouideot @ Retesh | Ehest @dBwont |- Showhidecoumns - (v| Y Fer
¥ i Release Name Version # Test Status Task Progress Start Date End Date Plan Effort  Task Effert  lteration? Release |d  Edit
O [ | e = 5] el I |- v me[ | [orwer]
O = 3 Library System Release 1 1.0.0.0 I | 1.Mar.2004 12.Mar2004  216.0h 94.0h No RLO000OT [+ Edit |
O = 2 Library System Release 1 5P1 1.0.1.0 No Tasks 13-Mar.2004 30-Mar.2004 176.0h Ho RL0O000O2 @
O 0 1.0.1.00001 N | k 13-Mar-2004 20-Mar-2004 80.0h Yes RLOD0O11 @
] 1.0.1.00002 N | 21-Mar-2004 24-Mar-2004 48.0h Yes RLO00012 @
(] 1.0.1.0.0003 T 25-Mar-2004 30-Mar-2004 64.0h Yas RLO00013 E
0 7 1.0.2.0 Ho Tasks 1-Apr.2004 30-Apr-2004 352.0h No RLO00003 [ Edit |
O 1.0.2.0.0001 N loT 1-Apr-2004 10-Apr-2004 112 0h Yes RLOD0O14 [- Edit
O 1.0.200002 N lo T 11-Apr-2004 20-Apr-2004 112.0h Yes RLO0001S [- Edit
O 1.0200003 N lo T 21-Apr-2004 30-Apr-2004 128.0h Yes RLO0001E |~ Edit |
0 2 Iteration 001 1.0.0.0.0001 N 1-Mar-2004 4-Mar-2004 96.0h 32.0h Yes RLOO000B | = Edit
O B3 teration 002 10000002 1 5V1ar-2004 8-Mar-2004 24.0n 3200 Yos RLO0000S  [= Edit |
O T lteration 003 10000003 N || 3-Mar-2004 12-Mar-2004 T2.0h 30 0k Yes RLO0001D [- Edit
O = ‘3 Library System Release 1.1 1.1.0.0 [ | 15-Oct-2004 27-Oct-2004 168.0h 86.0h No RLO00DOD4 [- Edit
0 B Library System Release 115P1 1.1.1.0 lo T 1Hov2004  30-Nov-2004  336.0n No ALO00OOS [~ Ean |
O J Library System Release 1.1 SP2 1.1.20 N | k 1-Dec-2004 31-Dec-2004 320.0h No RLOO0OOT | » Edit
5““’[‘5 ¥ | rows per page 4 - Displaying page |1 of2e M

o Inset  £3 Delete > Indent < Outdent

_—
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The release list will contain all the releases and iterations associated with current project. When
you create a new project, this list will initially be empty, and you will have to use the <Insert>
button to start adding releases and iterations to the project. The hierarchical organization of
releases in the list is configurable, so you can organize the various releases in the way that
makes most sense for a particular project. Typically you have the major releases as the top-level
items, with sub-releases, builds and iterations as the lower-level items.

All of the releases in the list have a release-name, together with the assigned version number for
that release, the start-date and end-date for the release, the number of estimated project
personnel working on that release, the planned effort for the release, the total effort currently
scheduled (as tasks), the available effort for new tasking, the release id, and a set of custom
properties defined by the project owner.

For those releases that have test cases mapped against them, the execution status of the various
test cases associated with the release is displayed in aggregate for each item as a graphical bar
diagram. If you position the mouse over the execution status indicator you will see the detailed
execution information displayed as a tooltip.

For those releases that have at least one task associated with them, they will display a block
graph that illustrates the relative numbers of task that are on-schedule (green), late-starting
(yellow), late-finishing (red) or just not-started (grey). These values are weighted by the effort of
the task, so that larger, more complex tasks will be change the graph more than the smaller
tasks. To determine the exact task progress information, position the mouse pointer over the bar-
chart and the number of associated tasks, along with the details of how many are in each status
will be displayed as a “tooltip”.

Clicking on a release’s hyperlink will take you to the release details page for the item in question
(see section 7.2).

7.1.1. Filtering
You can easily filter the list of releases as illustrated in the screen-shot below:
. Welcome, System Administrator | My Profile | Administration | Log Out | [Librsey kfermation System - Help?
Team
My Page Project Home Planning Testing Tracking Reporting
Requirements | Releases | MHerations Role: Project Owner
hinset {3 Delete | o> indent <bOutdent |—Showlevel— |v| @yRefesh | [hEst [FExpot |- Showjhide columns— |v| Y Fiter
+ @ Release Name Version # Test Status Task Progress Start Date End Date Plan Effort Task Effort Iteration?  Release Id Edit
o | J | T | S | B])l & [ [ W Y[R » Filter
O = [ Library System Release 1 1.0.0.0 I | | 1-Mar-2004 12Mar-2004  216.0h 94.0h No RLOOODOT [ Edit
O = 3 Library System Release 1 5P1 1.0.1.0 No Tasks 13-Mar2004  30.Mar2004  176.0h Mo RLO0DO0Z
O 2l Library System Release 1 5P2 1.0.2.0 No Tasks 1-Apr-2004 30-Apr2004 3520 No RLO00DOS
O = T Library System Release 1.1 1.1.0.0 [ 15.0ct-2004  27-0ct2004  168.0h 86.0h No RLO000O4 [+ Edit |
] B Library System Release 1.1 5P1 | 1.1.1.0 P 1-hlov-2004 30-Nov-2004  336.0h Ho RLO0000S [+ Edit
(] 3 Library System Release 1.1 SP2 | 1.1.2.0 I H 1-Dec-2004 31-Dec-2004 320 0h Mo RLO0OOOT
O @ Library System Release 2005 1200 | 1-Apr-2005 2-Apr-2005 16.0h 10.0h Hao RLO0000G [+ Edit
Show |15 7] rows per page « < Displaying page[7 | "% of 10 »
dhinsert {3 Delete | <> indent <o Outdent

To filter the list by any of the displayed columns, you either choose an item from the appropriate
drop-down list or enter a free-text phrase (depending on the type of field) then click <Filter> or
press the <ENTER> key to apply the different filters. Note that the name field is searched using a
“LIKE” comparison, so that searching for “database” would include any item with the word
database in the name. The other freetext fields need to be exact matches (e.g. dates, release
numbers). In the screen-shot above, we are filtering on Iteration = No. Clicking on <Clear Filters>
clears all the set filters and displays all the releases for the project.
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In addition, if you have a set of filters that you plan on using on a regular basis, you can choose
the option Filter > Save Filter to add the current filter to the list of saved filters that appear on your
‘My Page’. The list of saved filters can also be retrieved by clicking Filter > Retrieve Filter:

- . Welcome, Fred Bloggs | My Profile | Log Out | Library infarmation System v| Help?
iraTeam : :
My Page Project Home Planning Testing Tracking Reporting
Requirements | Releases | Herations Role: Manager
dhnget  {Delete | o> indent <o Outdent |—Snowleve— V| ByRefesn | Chest  Bxpon ’m‘ Y Fit
¥ # Release Name Version # Test Sta End Date Plan Efig U Apply Fitter Iteration?  Release ld  Edit
O [ ~ Ay .| Save Filter I j I: £ cioar Fiter Hie v| RL j [» Filter
[0 @ T Library System Release 1 1.00.0 N Please choose a name for this filter 12Mar2004  216.0h | 2> Reatrieve Filter No RLODOOO
O = D Library System Release 1 $P1 1.0.1.0 |AII hon-teration ralaases | 30-Mar-2004 176.0h Save Filter Ho RLODODOZ IW‘
0 & T Library System Release 1 5P2 | 1.0.2.0 30-Apr-2004  352.0h No RLODO0O3 [+ Edit
0| = @ Library System Release 1.1 1.1.0.0 | > Save|Cancel | 270ct2004  168.0n 86.0h No RLO0000A
1} J Library System Release 1.185P1 1110 h: 1-Mov-2004 30-Nov-2004 336.0h Mo RLO0000S
] e Release 115p2 | 1120 Mo T N 1-Dec-2004 31Dec2004  3200h Ho RLODO0OT [+ Eait |
O 3 Library System Release 2005 1200 1-Apr-2005 2-Apr-2005 16.0h 10.0h No RLO000OG [+ Edit
Show 15 ¥ |rows per page << Displaying page (1| of 15
dpiset  {3Delete | o> indent b Qutdent

7.1.2. Insert

Hovering over the <Insert> button brings up a secondary menu that allows you to choose whether
to insert a release or iteration (if you just click Insert it defaults to inserting a release). In either
case, it will insert the new release / iteration above the currently selected item — i.e. the one
whose check-box has been selected, at the same level in the hierarchy. If you want to insert a
releasel/iteration below a summary item, you need to insert it first, then indent it with the <Indent>
button. If you insert a release without first selected an existing release from the list, the new
release will simply be inserted at the end of the list.

Once the new release has been inserted, the item is switched to “Edit” mode so that you can
change the default name, active flag, version number and creator.

7.1.3. Delete

Clicking on the <Delete> button deletes all the releases whose check-boxes have been selected.
If any of the items are summary items, then: if the item is expanded and the children are visible,
the children are simply made children of the item above it in the list, however if the item is not
expanded and the children are hidden, then the children are all deleted. This behavior is similar to
that found in project planning tools like Microsoft Project®.

In addition, if all the children are deleted from a summary item, it changes back into a detail item.
Any test runs or incidents that were associated with a deleted release are not themselves
deleted, but the relationship between them is lost.

7.1.4. Indent

Clicking on the <Indent> button indents all the releases whose check-boxes have been selected.
If any of the items are made children of a release that had no previous children, it will be changed
from a detail item into a summary item. Note: you cannot indent a release or iteration if it is below
an iteration, as iterations are not allowed to have child items

7.1.5. Outdent

Clicking on the <Outdent> button de-indents all the releases whose check-boxes have been
selected. If any of the items were the only children of a summary release item, then that item will
be changed back from a summary item to a detail item.
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7.1.6. Refresh

Clicking on the <Refresh> button simply reloads the release list. This is useful as other people
may be modifying the list of releases at the same time as you, and after stepping away from the
computer for a short-time, you should click this button to make sure you are viewing the most
current release list for the project.

7.1.7. Edit

Each releasel/iteration in the list has an <Edit> button display in its right-most column. When you
click this button or click on any of the cells in the row, you change the item from “View” mode to
“Edit” mode. The various columns are made editable, and <Update> <Cancel> buttons are
displayed in the last column:

= T m~ Welcome, Fred Bloggs | My Profile | Log Out | [Lbrery formation System _[w] Help?
B ea - Wy Page Project Home Planning Testing Tracking Reporting
Requirements | Releases | lterations Role: Manager
dhlnsert {3 Delete | > Indent < Ouident | Showlevel— |v| RiRefesh | [hCopy (& Expot |[-Showhide columns - |v| Y/ Clear Fiters
¥ i Release Name Version # Test Status Task Progress Start Date End Date Plan Effort Release Id Edit
O | i |- v] Cam- v [ @] [ @] | |R[ | [rier]
O = @ Library System Release 1 1.0.0.0 | | 1-Mar-2004 12-Mar-2004 216.0h RLO00OO1
O T [Library System Release 15P1 E [1000 =] No Tasks [z @|E [0z @|E 1760h . g:dm:
» Cancel
O 2 [Library System Release 15P2 [o20 ] No Tasks =] =
(] B teration 001 1.0.0.0.0001 lo Te 1-Mar-2004 4-Mar-2004 96.0h RLO00003
(@] B teration 002 1.0.0.0.0002 lo Test 5-Mar-2004 8-Mar-2004 24.0h RLO0000S | [+ Edit
O S iteration 003 1.0.0.0.0003 ! t N 9-Mar-2004 12-Mar-2004 72.0h RLOO0010 | [+ Edit
[0 = D Library System Release 1.1 1.1.0.0 | 15.0¢1.2004 27-0ct 2004 168.0h RLOD0OO4 | [+ Edit
[m] B Library System Release 1.1 SP1 1110 T 1-Now-2004 30-Nov-2004 336.0h RLO0000S | [+ Edit |
] 3 Library System Release 1.1 SP2 1120 No Test T 1-Dec-2004 31-Dec-2004 320.0n RLODO0OT | [+ Eai_|
[m] 2 iteration 001 1.1.0.0.0001 15-Oct-2004 18-Oct-2004 24.0h RLO000T7 | [Edit |
] B jteration 002 1.1.0.0.0002 19-Oct-2004 23-0ct-2004 72.0n RLO0001S | [+ Edit |
0O 2 teration 003 1.1.0.0.0003 | 24.0c1-2004 27-0ct-2004 72.0h RLOO001S | [~ Edit |
[m] B Library System Release 2005 1200 1-Apr-2005 2:Apr-2005 16.0h RLO0000S | [+ it |
Srmw[1s v fows per page < Digplaying page |1 [Sof 1w
opinsent £} Delete o> Indent  <n Outdent

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed
on the first row, and you can make changes to all the editable rows and then update the changes
by clicking the one <Update> button. Also, if you want to make the same change to multiple rows
(e.g. to change five releases from “active” to “inactive”), you can click on the “fill” icon to the right
of the editable item, which will propagate the new value to all editable items in the same column.

When you have made your updates, you can either click <Update> to commit the changes, or
<Cancel> to revert back to the original information. Alternatively, pressing the <ENTER> key will
commit the changes and pressing the <ESCAPE> key will cancel the changes.

7.1.8. Show Level

Choosing an indent level from the ‘Show Level’ drop down box allows you to quickly and easily
view the entire release list at a specific indent level. For example you may want to see all
releases drilled-down to the third level of detail. To do this you would simply choose ‘Level 3’ from
the list, and the releases will be expanded / collapsed accordingly.

7.1.9. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the release list as
columns for the current project. To show a column that is not already displayed, simply select that
column from the list of “Show...” column names and to hide an existing column, simply select that
column from the list of “Hide...” column names. This is stored on a per-project basis, so you can
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have different display settings for each project that you are a member of. The fields can be any of
the built-in fields or any of the custom properties set up by the project owner.

7.1.10. Copying Releases/Iterations

To copy a releasel/iteration or set of releases/iterations, simply select the check-boxes of the
release/iteration you want to copy and then select the Edit > Copy menu option. This will copy the
current release/iteration selection to the clipboard. Then you should select the place where you
want the releases/iterations to be inserted and choose the Edit > Paste option.

The releases/iterations will now be copied into the destination location you specified. The name of
the copied releases/iterations will be prefixed with “Copy of...” to distinguish them from the
originals. Note that copied releases/iterations will also include the test mapping information from
the originals.

7.1.11. Moving Releases/Iterations
To move a releasef/iteration in the hierarchy, there are two options:
1. Click on the icon the releasel/iteration you want to move and then drag the icon to the

location you want it moved. The border between the destination releases/iterations will
change as the icon is dragged over it to illustrate where it will be inserted:

Team Welcome, System Adr | My Profile | Administration | Log Out | |Library infarmation System w Help?
o My Page Project Home Planning Testing Tracking Reporting
Requitements | Releases | IRerations Role: Project Owner
dhinset 3 Delete | o> indent <p Outdent ... ShowLevel - w| [ Refresh | GhCopy [ E@ot |- Showthide columns ~ [v| 1 Clear Fitlers
+ @ Release Name Version # Test Status Task Progress Start Date End Date Plan Effort  Task Effort  Release Id Edit
] I [anv— ¥] [Aw-¥] | @ @] CA
0 = T Library System Release 1 1.0.0.0 [ | 1.Mar.2004 12.Mar.2004 216.0h 94.0h RLOD00OT [+ Edit |
] = [ Library System Release 1 SP1 1.0.1.0 No Tasks 13-Mar-2004 30-Mar-2004 176.0h RLO0000Z  [v Edit |
O = Z Library System Release 1 SP2 1.0.2.0 HNo Tasks 1-Apr-2004 30-Apr-2004 352.0h RLO0000O3 @
O 9 heration 001 1.0.0.0.0001 e 1-Mar-2004 4-Mar-2004 95.0h 32.0h RLOD0ODS
o 1.0.0.0.0002 e 5-Mar-2004 8-Mar-2004 24.0h 32.0h RLOD0ODY
(3] B heration 003 1.0.0.0.0003 [ 9.Mar-2004 12-Mar-2004 72.0h 30.0h RLOD0O10 » Edit
0 oY — T S, 1.1.0.0 I 15-0ct-2004 27-Oct-2004 168.0h 86.0h RLO000O4 [~ Eai |
- | ’.i””.‘."' S.:...)\gm =flp{:;t_1_5P_3_ 5 1110 r 1-Mov-2004 30-Hov-2004 336.0h RLO0000S
O 3 Library System Release 1.1 P2 1120 t 1-Dec-2004 31-Dec-2004 320.0h RLO0OD0OT
3] 2 eration 001 1.1.0.0.0001 15-0ct-2004 18-Dct-2004 24.0n 29.0h RLOOOOTT [V Edit |
] Htera 2 1.1.0.0.0002 19-Oct-2004 23-0ct-2004 72.0h 27.0h RLO00OTS [ Edit |
O 5 jteration 003 11000003 | 24-Oct-2004 27-0ct-2004 T2.0h 30.0h RLODOO1S
O B Library System Release 2008 1200 1-Apr-2005 2-Apr-2005 16.0h 10.0h RLODDODG
Show D fows per page 4 4 Displaying page EI"- of 1M
dpinsent {3 Delete | o> incent  <p Outdent

Once you have the release/iteration positioned at the correct place that you want it
inserted, just release the mouse button and the release list will be refreshed, with the
release/iteration moved to the desired location.

2. Alternatively you can simply select the check-boxes of the release/iteration you want to
move and then select the Edit > Cut menu option. This will cut the current
releaseliteration selection to the clipboard. Then you should select the place where you
want the release/iteration to be inserted and choose the Edit > Paste option. The
releaseliteration will now be moved into the destination location you specified.

7.1.12. Exporting Releases/Iterations

To export releases/iterations from the current project to another project in the system, all you
need to do is select the check-boxes of the releases/iterations you want to export and then click
the <Export> button. This will then bring up a list of possible destination projects:
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Sbﬁ:érest. Welcome, Fred Bloggs | My Profile | Log Out | [Lbray remstion System __+ | Helg?
- F— My Page Project Home Planning Testing Tracking Reporting
Requirements | Releases Role: Manager
dhinset {3 Delete | o> indent <hoOuient [—Showlevel— w| [RjRefresh | Choopy (@ Espot |- Showjide columns~  w| Y/ Clear Fiters
v i Release Name Test Status Creator Active Iteration? Release Id Edit
| | [ any - v] | Exportitems —Any - v] [-any-  ¥]| [-ay- ¥] AL l:l [~ Finter |
= O Library System Release 1 L Please select the project you want to export to: [ red Bloggs Yes No RLODODOT [+ Edit |
i) = T Library System Release 1 SP1 - Select Project - . Uoe P Smith Yes No RLO0000Z [+ Edit
1 ™ neration 001 loe P Smith Yes Yes RLO00OD11 » Edit
£ teration 002 > Export | Cancel loe P Smith Yes Yes RLOO0D12 » Edit
B heration 003 Mo Tests 1.0.1.0.0003 S-May-2004 Joe P Smith Yes Yes RLO0OD13 [+ Edit
= T Library System Release 1 SP2 1.0.2.0 5-Jun.2004 Joe P Smith Yes No RLODO0D3  [» Eait_|
B3 neration 001 o Test 1.0.2.0.0001 SJun-2004 Joe P Smith Yes Yes RLODOO14 [+ Eait |
¥ jteration 002 o Test: 1.0.2.0.0002 S-Jun-2004 Joe P Smith Yes Yes RLODOO1S  [= Edit |
B teration 003 Mo Test 1.0.2.0.0003 SJun-2004 Joe P Smith Yes Yes RLODOOTE [~ Edit |
2 kerstion 001 Mo Te 1.0.0.0.0001 15-Feb-2004 Fred Bloggs Yes Yes RLO000DB  [» Edit |
B3 eration 002 Mo Test: 1.0.0.0.0002 15-Feb-2004 Fred Bloggs Yes Yes RLOOOODS [+ Eait_|
B jteration 003 Mo Test: 1.0.0.0.0003 15-Feb-2004 Fred Bloggs Yes Yes RLODOO10  [= Edit |
= [ Library System Release 1.1 | 1.1.0.0 15.0¢1.2004 Fred Bloggs Yes Mo RLODODO4 [+ Edit |
B Library System Release 2005 1200 1-Apr-2005 Fred Bloggs Yes No RLO000DS [ Eait |
ofinset {3 Delete | > Indent < Outdent

Once you have chosen the destination project and clicked the <Export> button, the
releases/iterations will be exported from the current project to the destination project. Any file
attachments will also be copied to the destination project along with the releasel/iteration.

7.2. Release Details

When you click on release item in the release list described in section 7.1, you are taken to the
release details page illustrated below:

Welcome, Fred Bloggs | My Profile | Log Qut | | Library informaton System v|

e - Help?
spiraTeam

My Page Project Home Planning Testing Tracking Reporting

Requirements | Releases > Release Details | |terations
| Bsave dhsaveandNew {3 Delete | [ Refresh (g Print

Role: Manager
<< Back to Release List

Tl Library System Release 1 Release Name: Library System Release 1 (RLO00001)

2 Library System Release 1 SP1
2 Library System Release 1 SP2
) Reration 001
] teration 002
1 peration 003

3 Library System Release 1.1

Name*: Library System Release 1 |

B U|E=S=E|CEFE TS| —e=pOe@

Thig ig the initial release of the Library Management System

Description - Fort = w Saa- (W

Version Number®:
Start/End Date:"
# Resources:”
Non-Working:*
Planned Effort

Incidents

T Library System Release 2005 =

ooo |

[ @) - [z @
EN
:l person days
216 hours 0 minutes

Tasks Test Cases ® Custom Props *

Created By": | Fred Bloggs

Created On 15-Feb-2004
Ves v|
No v

Available Effort: 122 hours 0 minutes

Active":
lteration™:
Test Runs *

Aftachments History *

This page is made up of three areas; the left pane is the navigation window, the upper part of the
right pane contains the release detailed information itself, and the bottom part of the right pane
displays different information associated with the release.

The navigation pane consists of a link that will take you back to the release list, as well as a list of
the other releases in the current project. This latter list is useful as a navigation shortcut; you can
quickly view the test run information of all the other releases by clicking on the navigation links

without having to first return to the release list page.

The top part of the right pane allows you to view and/or edit the details of the particular release.
You can edit the various fields (hame, description, etc.) and once you are satisfied with them,
simply click either the <Save> or <Save and New> button at the top of the page to commit the
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changes. In addition you can delete the current artifact by choosing <Delete>, discard any
changes made by clicking <Refresh> or print it by clicking <Print>.

When you make changes to the release/iteration’s start-date, end-date, number of project
personnel resources, or number of non-working person days, the system will automatically
calculate how many hours of effort (planned effort) are available in the releasef/iteration for
assigning tasks. As you begin assigning tasks — either through the Tasks tab or the Iteration
Planning screen — the total estimated effort of the tasks is subtracted from this planned effort to
give the “available effort”.

The lower part of the right pane can be in one of six possible modes that can be selected:
“Incidents”, “Tasks”, “Test Cases”, “Custom Properties”, “Test Runs”, “Attachments”, and
“History”. Each of the different views is described separately below.

7.2.1. Incidents

This is the default view for the release details page. It displays the incidents associated with the
selected release. The incident list can be one of three modes:

» Detected in this Release — this will display a list of all the incidents that were detected
during the testing of the selected release. This is useful in determining if there are open
incidents associated with a release that need to be dealt with.

>» Resolved in this Release — This will display a list of all the incidents that have been
reportedly resolved in this release. This is useful for double-checking that all the resolved
incidents for a release have indeed been fixed.

» Verified in this Release — This will display a list of the incidents that have been verified as
being fixed in this release. This is useful for generating release notes for a specific
release indicating what changes and enhancements have been made in the release.

Regardless of the mode, each incident is listed together with the type, status, priority, name,
owner, detector, detection date and a link to the actual incident details (see section 6.2):

Incidents # Tazks Test Cazes # Custom Props # Test Runs # Atftachmentz. History #
Display List of Incidents: Detected in This Release -
Incident#  Name Type Status Priority Owned By Detected On Detected By
IN0D00O7 % Cannot add a new book ta the system Bug Assigned | 1-Crtical | Joe P Smith | 4-Nov-2003 Joe P Smith
IN0D0002 % Not able to add new author Incident | Mew 1-Nov-2003 Joe P Smith
IMO00001 %) Cannot log into the application Incident | New 1-Nov-2003 Fred Bloggs
Displaying 1 - 3 of 3 incidents

Show 15~ rows per page 1]

To change between the three modes outlined above, simply select the desired mode from the
drop-down list contained within the header of the incident list table.

7.2.2. Tasks

In this mode, the lower part of the right pane displays the list of project tasks that need to be
completed for the release/iteration to be completed:
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Incidents. Tasks # Test Cases Custom Props # Test Runs Attachments History

v Task Name Progress Status Iteration Owned By Priority Est/ Actual Task #

O oh NewTask 73 Remove $3 Delete % Refresh Est. Effort: 32 0h / Actual Effort: 31.2h
[0 | ¥ Refactor book screen to include delete button Completed | 1.0.0.0.0002 | Joe P Smith 1 - Cntical  5.0h/7.7h TKO00007
[0 | #Create book object delete method Completed | 1.0.0.0.0002 | Joe P Smith 1 - Crtical  5.0h/4.2h TKO000008
[0 | ¥ Write book object delete query Completed 1.0.0.0.0002 | Joe P Smith 1 -Cutical  3.0h/3.3h TKO0O009
[0 | ¥ Develop edit author details screen Mot Started | 1.0.0.0.0002  Joe P Smith 2 - High §.0h/- TKO00024
[0 | & Create author object update method Mot Started | 1.0.0.0.0002  Joe P Smith 2 - High 5.0h/- TKO00025
[0 | ¥ Write author object update gueries Mot Started | 1.0.0.0.0002  Joe P Smith 2 - High 3.0h/- TKO00026

Each of the tasks is displayed together with its name, description (by hovering the mouse over
the name), progress indicator, priority, current owner, estimated effort, actual effort and numeric
task identifier. Clicking on the task name will bring up the Task Details page which is described in
more detail in section 8.2. This allows you to edit the details of an existing task.

You can perform the following actions on a task from this screen:

» New Task — inserts a new task in the task list with a default set of values. The task will be
associated with the current releasel/iteration.

Remove — removes the task from this release/iteration without actually deleting the task

Delete — deletes the task itself.

7.2.3. Test Case Mapping
This mode displays the test case mapping information for the release in question:

Incidents # Tasks # Test Cases # Custom Props # Test Runs # Attachments History #
Available Test Cases: Test Coverage:
v | Name W |Test # | Name Status
[ = &2 Functional Tests ) [0 TCO00004 ﬂ_‘l,c._him\; to create new author NAA,
g_'l Ability to create new book [0 TC000002 g_'l,&.hilit\,' to create new book MAA
R y [ TCO00005 23 apility to edit existing autho MAA
£ Ability [Remove< | | [ TC000003 £7 apility to edit existing book N/A
g_'l Ability to edit existing autho e [0 TC000006 g._)l,&.hilit\; to reassign book to di /A
L Avility to reassign book to di O TC000009 27 Author management MNiA
[ =& Regression Tests ] TCo00008 2£9Baok management /A,
[0 =& Scenario Tests
i
Create Test Set From This Release &‘J
The test coverage box indicates the test cases that are currently mapped against the release.
To add test cases to this release, choose from the list above and click [Add].
You can use the [Remove] and [Remove All] buttons to remove tests that no longer cover the release.

The pane consists of two lists of test cases, the one on the left being the hierarchical list of the
test cases belonging to the project arranged in test folders. The right box (which will initially be
empty) contains the list of test cases mapped to this release/iteration. The test cases in this box
include columns for their ID and name. Hovering the mouse over the names of the test cases in
either box will display a “tooltip” consisting of the test case name, place in the folder structure and
a detailed description. Clicking on the hyperlinks in right-hand box will jump you to the test case
details screen for the test case in question (see section 5.2.9).

To change the test case mapping for this release, you use the buttons (Add, Remove, Remove
All) positioned between the two list-boxes. The <Add> button will move the selected test cases
from the list of available on the left to the list of mapped on the right. Similarly the <Remove> and
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<Remove All> buttons will remove either the selected or all the test cases from the right list-box
and add them back to the left list-box.

Finally, as a shortcut you can click the “Create Test Set from This Release” link to create a new

test set from this release, that will include all of the test sets associated with this release. This is

useful in regression testing when you have created a new release and want to be able to quickly
assign a tester to ensure that all the functionality in the release works as expected.

7.2.4. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
releases. To learn more about how to setup and configure custom properties for a project, please
refer to the SpiraTest Administration Guide. Assuming that custom properties have been defined
for your project, you will see a list of optional parameters that can be set on the release. These
can be either freetext or drop-down-lists. In the example below, you can enter Notes and/or the
Operating System that the release is intended for.

Incidents # Test Cazes # Custom Properties # Test Runs # Attachments Hiztory #

Please edit the following custom properties of this artifact and click [Update] when finished:

Notes: Thizs i=s the first wversion of the system
Operating System: [ Windows Vista -
Tpate

Once you are satisfied with the values for the custom properties, simply click [Update] to commit
the changes.

7.2.5. Test Runs

This view displays the list of all the test runs executed against the release. Each test run is listed
together with the date of execution, the name of the test case, the name of the tester, the
release/version of the system that the test was executed against, the name of the test set (if
applicable), the overall execution status for the test case in that run and a link to the actual test
run details (see section 5.4). In addition, you can choose to display any of the custom properties
associated with the test run.

Incidents ® Tasks ® Test Cases % Custom Props Test Runs % Attachments History =

= Refresh | Apply Filter | Clear Filters | | - Show/hids colmns — vi

+ & TestRun Name AV Execution Date AV Test Set AV Release AV Status A ¥ Est. Dur. A¥ Act. Dur. A¥Y Web Browser A¥ Operating System AY Run# AY
O @  [Av- ¥ [resn-weon Y] [-A v| | J{ [P v [Aw v w[ |
O ;| 1-Dec-2003 1000 Caution 0.1h 0.8h TRO00010
O thor  1-Dec-2003 Failed 0.1h 1.5h TRO00004
(] B A lity to edit existing book | 1-Dec-2003 Passed 0.1k 1.5h TRO00003
() 1-Dec-2003 Failed 0.2h 1.2h Opera Windows 2003 TRO00012
O 4 1-Dec-2003 1.000 Failed 02h 1.3h Intemet Explorer Windows XP TRO00001
Show[15 | rows per page « 4 Displaying page[1 | % of 10-»

The “customize columns” drop-down list allows you to change the fields that are displayed in the
test run list as columns. To show a column that is not already displayed, simply select that
column from the list of “Show...” column names and to hide an existing column, simply select that
column from the list of “Hide...” column names. The displayed columns can be any standard field
or custom property.
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You can also filter the results by choosing items from the filter options displayed in the sub-
header row of each field and clicking the “Apply Filter” link. In addition, you can quickly sort the
list by clicking on one of the directional arrow icons displayed in the header row of the appropriate
field.

7.2.6. Attachments

In this mode, the lower section of the screen displays the list of documents that have been
“attached” to the release. The documents can be in any format, though SpiraTeam® will only
display the icon for certain known types.

Incidents # Tasks Test Cases # Custom Props # Test Runs # Attachments History #
Document Name Type Size Uploaded By Upload Date ¥
€| Related Information URL 0 KB System Administrator 19-Oct-2008

Upload New Document/URL

Type:” O File @ URL

. -
Filename: | H Erowse... |

Description: | |

The attachment list includes the filename that was originally uploaded together with the file-size
(in KB), name of the person who attached it and the date uploaded. In addition, if you position the
pointer over the filename and hold it there for a few seconds, a detailed description is displayed
as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser
window will open. Depending on the type of file, this window will either display the document or
prompt you for a place to save it on your local computer. To delete an existing attachment from a
release, simply click the <Delete> button and the attachment will be removed from the list.

To attach a new document to the release, you need to choose “File” as the type and then click the
Browse button and select the file from your local computer, optionally enter a detailed description
then click the <Upload> button. The document will be copied from your computer and attached to
the release. To attach a web-link (URL) to the release, you need to choose “URL" as the type and
then enter the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional
description and then click the <Upload> button to attach the web-link.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn't put file
extensions on filenames (e.g. .xls for an Excel sheet) automatically, then you will need to
manually add the file extension to the filename before uploading if you want it to be displayed with
the correct icon in the attachment list.
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7.2.7. View History

In this mode, the main pane displays the list of changes that have been performed on the release
artifact since its creation. An example release change history is depicted below:

Incidents # Test Cases # Custom Properties # Test Runs # Attachments History #
Change Date ¥ Field Name 0ld Value New Value Changed By
5/2/2006 12:00:00 AM MName Library System v1.0.0 Library System Release 1 Fred Bloggs
3/4/2005 12:00:00 AM Version Mumber 1.0.0 1.0.0.0 Joe P Smith

The change history displays the date that each change was made, together with the fields that
were changed, the old and new values and the person who made the change. This allows a
complete audit trail to be maintained of all changes in the system.

7.3. Iteration Planning

As well as being able to assign tasks and incidents to releases and iterations individually through
the Release/lteration details page (see above), when you are first assigning tasks and incidents
to the iterations in the release, it is usually more convenient to use the Iteration Planning screen
instead. To access this screen, go to Planning > Iterations, choose the current release and the
following screen will be displayed:

. Welcome, Fred Bloggs | My Profie | Administration | Log Out | | Ly Tcmaton System v Help?
Team e
My Page Project Home Planning Testing Tracking Reporting
Requirements | Releases | lterations Role: Manager
Displaying the iteration plan for the selected release. To move items, use drag-and-drop Selected Release: [£0.00- Lorar System Rease | hd
. Planned Estimated Available
- Release 1.0.0.0 (3/1/2004 - 3/12/2004) - Refresh 216.0n 94.0h 122.0h
M4 ] jeration 1.0.0.0.0001 (3/1/2004 - 314/2004) 2 teration 1.0.0.0.0002 (3/5/2004 - 3/8/2004) 2 iteration 1.0.0.0.0003 (3/9/2004 - 3/12/2004)
Planned Estimated Ayailabla Planned Estimated Available Planned Estimated Aailable
96.0h 32.0h 64.0h 24.0h 32.0n -B.0h T2.0n 30.0h 42.0h
t ] Refact t t tt [ 71 Refactor author screen to include delete butten 6.0h
[0 ¥ Develop edit author details screen 8.0h
[ 7] Create author object update mathod 5.0h
[J 7 Write author object update queries 3.0h || [J Z3 Write edition object insert queries 3.0h
Tasks Incidents
= New Task | Delete | Refresh | Apply Filter | Clear Filters Show.hide colmns v
v 4 Task Name 4¥ Progress Status A Y Priority 47 Owner AT Release A ¥ Task# AY Edit
0 |. Ay - v \-.a-y - v \—:ny - v - Ary - v (None) v TK * Filter
(] ¥ Refactor author details page to include contact in Mot Started 2 - High TKO00030 [ Edit |
O ¥ Update author select query to include contact info Mot Started 2-High TK000031 - Edit
O ) Update author update/insert queries to include con Not Started 2 - High TK000032 - Edit
O ) Make sure that testing emvironment ready Mot Started 4 - Low Joe P Smith TKO00043 [+ Edit|
Show 15 ¥ |rows per page 4 4 Displaying page[1 = of 1 »

This screen is divided into two sections:

» The top part of the screen displays the iterations contained within the current release (up-
to three per page) together with the list of tasks and incidents currently assigned to the
iteration. Also any tasks/incidents directly associated with the release itself are displayed
in the first panel.

» The bottom part of the screen displays the list of unplanned, not-started tasks and
unplanned, open incidents that need to be associated to an iteration. This is essentially
the backlog of tasks (linked to requirements) and outstanding incidents that need to be
scheduled. The tasks are show in one tab and the incidents are shown in the other

To navigate around the release, you use the small black arrow buttons located at the top of the
iteration panels. These allow you to quickly move to the previous/next iteration in the currently
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selected release. To change the release itself, you use the drop-down-list at the top-right of the
page to change to a different release.

7.3.1. Scheduling Tasks/Incidents to Iterations

To assign a new task/incident to the iteration schedule, you either position the mouse pointer over
a single task/incident icon, dragging it to the desired iteration or you select several checkboxes in
the task/incident list and then drag all the selected items in one go. Once the task/incident(s)
have been added to the iteration, the estimated effort for the iteration will increase, and the
available effort will decrease by the same amount.

Note: The system will allow you to assign more tasks/incidents to an iteration than is possible to
complete, however this will result in a negative value for ‘available effort'. If this happens you
need to rebalance the items, extend the iteration length or add project personnel resources to the
iteration.

7.3.2. Rescheduling Tasks/Incidents

To move tasks/incidents from one iteration to another, you either position the mouse pointer over
a single task/incident icon, dragging it to the desired new iteration or you select several
checkboxes in the existing iteration and then drag all the selected items to the destination
iteration in one go. To remove a task/incident from an iteration, you should just drag and drop it
from the iteration panel back to the task/incident task list at the bottom of the page. This will
return the task/incident to the list of unplanned items at the bottom of the page.

Note: Once a task has changed status from ‘not-started’ to any of the other statuses, its checkbox
will be disabled and you will need to return it to the ‘not started’ status before attempting to
reassign it. This is a safety feature that prevents you from accidentally rescheduling a task that is
currently being worked on.

7.3.3. Task Assignment Rules

When you move a task from one iteration to another or assign a new task to the iteration, the
system makes the following changes to the task automatically:

» The releasel/iteration that the task is assigned-to is updated

» The start-date and end-date of the task is changed to match that of the iteration if the
dates lie outside the bounds of the iteration. This means that the task may change from
being on-schedule to late-starting depending on whether the iteration is already in
progress

7.3.4. Editing the Task/Incident List

As well as being able to schedule the incidents and tasks with the various iterations in the upper
portion of the screen, the incident and task lists displayed on the bottom half of the screen include
the same editing functions found in the Task List page and the Incident List page. You can insert,
edit, delete, filter, sort and change the displayed columns for the lists. For more details see
section 6.1 for the Incident List and section 8.1 for the Task List.
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8. Task Tracking

8.1. Task List

When you click on the Tracking > Tasks global navigation link, you will initially be taken to the
tasks list screen illustrated below:

i Team' Welcome, System Administrater | My Profile | Administration | Log Out | [Lbrary ifomaton Syten  [w) Heg?

IR -— My Page Project Home Planning Testing Tracking Reporting

Incidents | Tasks Role: Project Owner

dhNewTask §3Delete | RjRefresh | ChCopy [ Espot |- Showmidecolumns— [v]| Y Fiter

Displaying 16 - 30 out of 43 task(s) for this project
v @ Task Name 47 Progress Status A Y Priority 4 ¥ Owner AY Release AY Task & AY Edit
O ‘ [~ 2y - '| —Any — " I—-’-nv-- v| —Any — v [~ 2y~ '] TK\_] [- Filter |
[m] ¥ Wiite author obiect update queries Not Started 2 - High Joe P Smith 1.0.0.0.0002 TK000026  [-Edit |
O ) Refactor author screen to include delete button Not Started 2 - High Fred Bloggs 1.0.0.0.0003 TKO00027 [~ Eait |
O £ wiite edition object insert queries Not Started 1 - Critical | Fred Bloggs 1.0.0.0.0003 TKO00023 [» Edir |
O 71 Create edition object insert method || In Progress :1-crim| Fred Bloggs 1.0.0.0.0003 TKO00022 [~ Edit |
| ¥ Develop new edition entry screen ] In Progress :rcmu Fred Blaggs 1.0.0.0.0003 TK000021 [~Edit |
(W] ) Create author obiect delete method [ ] In Progress 2 - High Fred Bloggs 1.0.0.0.0003 THO00028  [wEdi |
0 73 Write author obiect delete query [ | In Progress 2 - High Fred Bloggs 1.0.0.0.0003 TK000029 [+ Eai |
[m] ) Modify book insertiupdate queries to include autho Completed 1- Critical | Joe P Smith 1.1.0.0.0001 TKO00015  [wEain |
A 7 Refactor book details screen to include author dro Completed :1-G|‘Hei Joe P Smith 1.1.0.0.0001 TKO00014 - Edit |
0 1 Create book-subject mapping queries Completed 1-Critical | Joe P Smith 1.1.0.0.0001 TKO00D13  [SEdi |
[m] ) Create book-subject mapping delete method Completed :1 - Critical Fred Bloggs 1.1.0.0.0001 TK000012 [~Edit |
] 71 Create book-subject mapping insert method Completed - Ciical | Fred Bloggs 1.1.0.0.0001 TKO00011 [~ Ean |
0 ) Develop book-sublect association screen Completed 1 Critical | Fred Bloggs 1.1.0.0.0001 TKO00010 v Edit |
0 £ Modify book insert/update gueries to include editi Completed :1—C|'Iied Fred Bloggs 1.1.0.0.0002 TKO0001T > Edit |
0 £ Refactor book details screen to include edition dr Completed 1-Critical | Fred Bloggs 1.1.0.0.0002 TKO00016  [wEdit |
Show 15 ¥ | rows per page M 4 Displaying page 2 |%of 3w K

The task list screen displays all the tasks entered for the current project, in a filterable, sortable
grid. The grid displays the task number together with fields such as priority, name, assigned
owner, start date, end date, scheduled release, etc. The choice of columns displayed is
configurable per-user, per-project, giving extensive flexibility when it comes to viewing and
searching tasks.

In addition, you can view a more detailed description of the task by positioning the mouse pointer
over the task name hyperlink and waiting for the popup “tooltip” to appear. If you click on the task
name hyperlink, you will be taken to the task details page described in section 8.2. Clicking on
any of the pagination links at the bottom of the page will advance you to the next set of tasks in
the list according to the applied filter and sort-order. There is also a drop-down-list at the bottom
of the page which allows you to specify how many rows should be displayed in each page,
helping accommodate different user preferences.

One special column that is unique to tasks is the ‘progress indicator’. This illustrates graphically
both the percentage completion of the task and also if the task is either starting late or finishing
late. The following table illustrates the different type of status that can be conveyed by the
indicator:

Indicator Display Progress Description

Task has not yet started, but the scheduled start date is
still in the future.

Task has not yet started, and the start date has elapsed.
This is considered a ‘Late Starting Task’

Task has started, and is approximately 25% complete.
The scheduled end date is still in the future.

Task has started, and is approximately 25% complete.
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However the scheduled end date has elapsed already.
This is a considered a ‘Late Finishing Task'.

Task has been 100% completed.

Essentially, the gray section of the bar indicates the % of the task yet to be completed, and the
green/red section of the bar indicates the % of the task that has already been completed. If the
bar changes from green to red it means that the end date has been reached and the task is not
yet complete, and if the background changes from gray to yellow it means that the task has not
yet started, but the scheduled start date has passed.

8.1.1. Sorting and Filtering
You can easily filter and sort the list of tasks as illustrated in the screen-shot below:

Welcome._ System Admi | My Profile | Administration | Log Out | [ Lbrey infomation System ] Help?

Team

My Page Project Home Planning Testing Tracking Reporting
Incidents | Tasks Role: Project Owner

dhNewTask  §3 Delete B Refresh [hcopy [ Expont [~ Show/hide columns = v| Y7 Fiter
Displaying 1 - 4 out of 4 task(s) for this project

v @ Task Name 4V Progress Status AV Priority AY Owmer AT Release AY Task# A Y Edit

] [ | [Rusainguae | [—any— ] [~an- ¥ —any- ¥ Ay W ™[ | [+ Fier |
] a ditior o . In Frogress 1 - Critical Fred Bloggs 1.0.0.0.0003 TK000022 [~ Edit |

O N | In Progress 1 - Critical Fred Bloggs 1.0.0.0.0003 TK000021

O LA write object delete quen, || In Progress. 2 - High Fred Bloggs 1.0.0.0.0003 TKO00029

O L Create author object delete method I | In Progress 2 - High Fred Bloggs 1.0.0.0.0003 TKDO0025 [~ Edit |
Show 15 ¥ | rows per page <4 Displaying page[1 | % of 12

ofF NewTask  §3 Delete | [ Refresh
e ——]
To filter the list by progress, status, priority, owner or release, you simply choose an item from the
appropriate drop-down list, and for the other fields, you enter a free-text phrase then click <Filter>
or press the <ENTER> key to apply the different filters. Note that the name field is searched using
a “LIKE” comparison, so that searching for “database” would include any item with the word
database in the name. The other freetext fields need to be exact matches (e.g. dates, task
numbers).

To change the column that is sorted, or to change the direction of the current sort, simply click on
the up/down arrow icon in the appropriate column. The currently sorted column is indicated by the
larger, white arrow with the back-border. In the screen-shot above, we have filtered on tasks that

are finishing late, sorted in order of decreasing priority.

Clicking on Filter > Clear Filter removes any set filters and expands the incident list to display all
incidents for the current project, and clicking on Filter > Save Filter allows you to save the filter to
your ‘My Page’ for use in the future. The list of saved filters can also be retrieved by clicking Filter
> Retrieve Filter.

8.1.2. New Task

Clicking on the <New Task> button creates a new task in the grid with an initial set of information.
You can click on the name of the task to edit its information.

8.1.3. Delete

Clicking on the <Delete> button deletes the tasks whose check-boxes have been selected in the
task list.
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8.1.4. Refresh

Clicking on the <Refresh> button simply reloads the list of tasks; this is useful when new tasks
are being added by other users, and you want to make sure you have the most up-to-date list
displayed.

8.1.5. Show / Hide Columns

This drop-down list allows you to change the fields that are displayed in the task list as columns
for the current project. To show a column that is not already displayed, simply select that column
from the list of “Show...” column names and to hide an existing column, simply select that column
from the list of “Hide...” column names. This is stored on a per-project basis, so you can have
different display settings for each project that you are a member of. The fields can be any of the
built-in fields or any of the custom properties set up by the project owner.

8.1.6. Edit

Each task in the list has an <Edit> button display in its right-most column. When you click this
button or just click on any of the cells in the row, you change the item from “View” mode to “Edit”
mode. The various columns are made editable, and <Update> <Cancel> buttons are displayed in
the last column:

Welcome,_ System Admi | My Profile | Administration | Log Out | [ Lbrey information System v Help?

Team

My Page Project Home Planning Testing Tracking Reporting
Incidents | Tasks Ruole: Project Owner

chNewTask  §3 Delete % Refresn [hcopy [ Expont |- Show/hide columns = v| Y7 Fiter
Displaying 1 - 4 out of 4 task(s) for this project

v § Task Hame 4 ¥ Progress Status AF Priority AY Owner 4Y Release 4 ¥ Task & &Y Edit

O | | [fons e ] [camy— ¥ [cam-  ¥]  [camw- v [aw-  v] k[ | [rer]

O T Create edition object insent method I | In Progress 1+ Critical Fred Bloggs 1.0.0.0.0003 TK000022 [+ Edit |

O | {1|Develop newedition entry screen (2] | [mProgress  ¥|ED |[1-crtcst V|l [Freaioges ¥|EN [1omcowa  ¥]ED [~ update |[+ Cancer |
O | #)|write author object delete query | J [nProgress — ¥] |[2-Heh ¥]  [FretBioges ¥ [1o00ows ¥]

O 1 Create author object delete method In Progress 2 - High Fred Bloggs 1.0.0.0.0003 TKO0D028 [+ Edit |

Show [15_ W] rows per page 44 Displaying page[1 | % of 15

If you click <Edit> on more than one row, the <Update> and <Cancel> buttons are only displayed
on the first row, and you can make changes to all the editable rows and then update the changes
by clicking the one <Update> button. Also, if you want to make the same change to multiple rows
(e.g. to change five tasks from “Not Started” status to “In Progress”), you can click on the “fill” icon
to the right of the editable item, which will propagate the new value to all editable items in the
same column.

When you have made your updates, you can either click <Update> to commit the changes, or
<Cancel> to revert back to the original information. Alternatively, pressing the <ENTER> key will
commit the changes and pressing the <ESCAPE> key will cancel the changes.

8.1.7. Copying Tasks

To copy a task or set of tasks, simply select the check-boxes of the tasks you want to copy and
then click <Copy>. This will make a copy of the current task with its name prefixed ‘Copy of ...." to
distinguish itself from the original. Any file attachments will also be copied along with the task
itself.

8.1.8. Exporting Tasks

To export a task or set of tasks from the current project to another project in the system, all you
need to do is select the check-boxes of the task(s) you want to export and then click the <Export>
button. This will then bring up a list of possible destination projects:
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Welcome. System | My Profile | Administration | Log Out | | Library information System - Help?

My Page Project Home Planning Testing Tracking Reporting

Incidents | Tasks

b NewTask g3 Delete | B Refresh | [HCopy & Export W Fiter

Displaying 1 - 4 aut of 4 task(s) for this project
¥ & TaskName A ¥ Progress| Exportltems | Owner AY Release A ¥ Task# AY Edit
Running Ls — ATY v e ATY e v » Filter

a | ‘ i —| Please select the project you want to export to: | | - | ! ‘ L Lo

O £ Create edition object insert method ] Fred Bloggs 1.0.0.0.0003 TK000022
5] 7 Develop new edition entry screen | SempleApplicationOre ______ |» | Fred Bloggs 1.0.0.0.0003 TKD00021
1 Wiite author object delete query [ | > Export | Cancel Fred Bloggs 1.0.0.0.0003 TKO000029 [~ Eait |
O {2 Create author object delete method | TTTTOTE: z =TI Fred Bloggs 1.0.0.0.0003 TKO00028
Show (15 W | rows per page 4 4 Displaying page |1 %aof 10

Once you have chosen the destination project and clicked the <Export> button, the tasks will be
exported from the current project to the destination project. Any file attachments will also be
copied to the destination project along with the tasks.

8.2. Task Details

When you click on a task item in the lists displayed on either the main task list page or on the
requirement / release details pages, you are taken to the task details page illustrated below:

- - Welcome, Fred Bloggs | My Profile | Log Out | Library Information System v Helg?
aTeam — .
e My Page Project Home Planning Testing Tracking Reporting

Role: Manager

Requirements | Releases > Task Details | lterations
| Esave cFSaveandNew £} Delete | R Refresh () Print

<< Back to Task List

=] Iteration 002 Task Name: Refactor book details screen to include edition drop-down (TK000016)

7] Refactor book details screen to include ... .

¥ Modify book insert/update queries to inc Hame: [Refachur book details screen to include edition drop-down

1 Develop author-subject association scree Description = Fort - v = v BZU|EEE|EEFEFEEN—e=pOoc@

2 Create author-subject mapping insert met

7] Create author-subject mapping delete met

3 Create auther-subject mapping queries
Priority: [1-Crical v Oumar: [Fred Boggs v]
Requi |x-~|m- o associate books with ditferent edtion: v | Last Updated: 12/1/2003 12:00:00 AM
Release / Reration: [1.1.0.0.0002 - teration 002 ] Created On:  12/1/2003 12:00:00 AM

(10/19/2004 - 10/23/2004)

Schedule = Custom Properties. Aftachments History

This page is made up of three areas; the left pane is the navigation window, the upper part of the
right pane contains the task detailed information itself, and the bottom part of the right pane
displays different information associated with the task.

The navigation pane consists of a link that will take you back to the task list, as well as a list of the
other related tasks. Depending on which page you came from, this navigation list will be different:

> If you arrived at the screen from the requirement details page, the navigation pane will
display the parent requirement together with a list of all the tasks that are associated with

the requirement.

> If you arrived at the screen from the release/iteration details page, the navigation pane
will display the parent release/iteration together with a list of all the tasks that are
associated with the release/iteration.

> If you arrived at the screen from the main task list page, the navigation pane will display a
list of the other tasks that match the currently selected sort and filter option. If the number
of tasks exceeds fifteen, only the first fifteen entries will be shown.

The top part of the right pane allows you to view and/or edit the details of the particular task. You
can edit the various fields (hame, description, etc.) and once you are satisfied with them, simply
click either the <Save> or <Save and New> button at the top of the page to commit the changes.
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In addition you can delete the current artifact by choosing <Delete>, discard any changes made
by clicking <Refresh> or print it by clicking <Print>.

The lower part of the right pane can be in one of four possible modes that can be selected:
“Schedule”, “Custom Properties”, “Attachments”, and “History”. Each of the different views is
described separately below.

8.2.1. Schedule

In this mode, the main pane displays the general schedule and completion status of the specific
task. You can enter/edit the start-date, end-date (i.e. the due-date), estimated and actual effort,
and the completion status / percentage.

Schedule # Custom Properties Attachments Hiztory
Stats: Estmated Efor: rowrs [0 minses
% Complete:* 9 Actual Effort: T RS
Start Date: End Date: 07907700

© Copyright 2006-2009, Inflectra Corporation

Note that if this task is currently assigned to a release or iteration, the start-date and end-date of
the task must lie within the date-range of the parent release/iteration. If your task looks like it will
not be completed in the available timeframe, you will need to contact the project manager to get
them to either extend the date-range of the task, or consider moving the task to the next iteration.

8.2.2. Custom Properties

In this mode, the main pane displays any custom properties that the project owner has defined for
tasks. To learn more about how to setup and configure custom properties for a project, please
refer to the SpiraTest Administration Guide. Assuming that custom properties have been defined
for your project, you will see a list of optional parameters that can be set on the task. These can
be either freetext or drop-down-lists. In the example below, you can enter Comments and/or the
project track that the task is associated with.

General # Custom Properties # Attachments History

Please edit the following custom properties of this artifact and click [Update] when finished:

Comments:

Track: [ Infrastructure -

[» Update ||» cancel |

Once you are satisfied with the values for the custom properties, simply click [Update] to commit
the changes.

8.2.3. Attachments

In this mode, the lower section of the screen displays the list of documents that have been
“attached” to the task. The documents can be in any format, though SpiraTeam® will only display
the icon for certain known types.
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General * Custom Properties # Attachments History
Document Name Size Uploaded By Upload Date ¥

B Customers xls 163 KB System Administrator 26-Feb-2008

Upload New Attachment

Filename: Browse...

Description: |Samp|e data that should be used when developing feature |

The attachment list includes the filename that was originally uploaded together with the file-size
(in KB), name of the person who attached it and the date uploaded. In addition, if you position the
pointer over the filename and hold it there for a few seconds, a detailed description is displayed
as a tooltip.

To actually view the document, simply click on the filename hyperlink and a new web browser
window will open. Depending on the type of file, this window will either display the document or
prompt you for a place to save it on your local computer. To delete an existing attachment from a
task, simply click the <Delete> button and the attachment will be removed from the list.

To attach a new document to the task, you need to choose “File” as the type and then click the
Browse button and select the file from your local computer, optionally enter a detailed description
then click the <Upload> button. The document will be copied from your computer and attached to
the task. To attach a web-link (URL) to the task, you need to choose “URL" as the type and then
enter the fully qualified URL (e.g. http://mywebsite.com?Document=1), an optional description
and then click the <Upload> button to attach the web-link.

Note: If you are using a non-Windows® computer (e.g. Macintosh®) that doesn’t put file
extensions on filenames (e.g. .xls for an Excel sheet) automatically, then you will need to
manually add the file extension to the filename before uploading if you want it to be displayed with
the correct icon in the attachment list.

8.2.4. View History

In this mode, the main pane displays the list of changes that have been performed on the task
artifact since its creation. An example task change history is depicted below:

General # Custom Properties # Aftachments # History #
Change Date ¥ Field Name Old Value New Value Changed By
2/26/2008 12:49:04 PM Release Id 9 8 Systermn Administrator
2/26/2008 12:48:59 PM Release Id 8 9 Systern Administrator
2/26/2008 12:48:51 PM Task Priority 1 - Critical 2 - High System Administrator

The change history displays the date that each change was made, together with the fields that
were changed, the old and new values and the person who made the change. This allows a
complete audit trail to be maintained of all changes in the system.
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9. Resource Tracking

This section outlines how you can use the Resource Tracking features of SpiraPlan® and
SpiraTeam® to view the total workload for each of the project personnel resources assigned to a
specific project. This allows you to verify that the work is evenly distributed amongst the project
members and that no individual resource is overloaded.

When you click on the Tracking > Resources link on the global navigation bar, you will initially be
taken to the project resources list screen illustrated below:

T Welcome, Fred Bloggs | My Profile | Log Out | Library Information Sysiem v| Help?
eam R S

My Page Project Home Planning Testing Tracking Reporting

Incidents | Tasks | Resources Role: Manager

@ Refresh Y Fiter

Displaying the resource usage for the current project or selected release Display data for: |M;M ':
¥ Resource Name AY Project Role AY Task Effort AY Incident Effort 4 Total Effort A¥ User# AY
O hey- ¥ | | ] Jus[ |
B Fred Bloggs Manager 54.0h 0.0h 54.0h usooooo2
O Joe Smith Obsenver 40.0h 0.0h 40.0n US000003
ShowE rows per page 4 < Displaying pageE % of 10

This screen lists all the personnel (project resources) that belong to the current project together
with the total value of the estimated effort of all the work assigned to them. The effort is shown for
tasks and incidents as well as a total of the two together. You can display the workload for the
project as a whole, for a specific release (including all child iterations) or for a specific iteration.

If any project resources have been assigned more work that they have time to complete during
the length of the release/iteration, the background color of the effort value will be colored in red,
indicating that you need to offload some of the work to other project resources.
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10. Document Management

This section outlines the document management features of SpiraPlan® and SpiraTeam® that
can be used to upload, manage and share documents between the different members of the
project. This module includes support for uploading files and URLS, versioning of documents, the
ability to organize into folders and categorize and search using meta-tags.

In addition the document management features are fully integrated into the rest of the system, so
that documents attached to other artifacts (e.g. requirements, test cases, etc.) are automatically
connected to the project documentation repository.

10.1. Document List

When you click on the Project Home > Documents link on the global navigation bar, you will
initially be taken to the project documents list screen illustrated below:

— . Welcome, Fred Bloggs | My Profile | Log Out |  [Lkrary iformation System ¥ Help?
spiraTeam ——
- My Page Project Home Planning Testing Tracking Reporting
Project Home | Documents Role: Manager
Document Folders | Refresh v Document Name A Type oY Size AV Edited By AY  Edited On AV Uploaded By AY Doc# AV
O - Ay e v w ANy == v | [ Any - v De
o 65 Root Folder . I ] ]| [ e ] Il ]
= B Design Documents [ | 18 sequence Diagrar for Book Mgt pdf UML Diagram | 35 Joe P Smith 10-May-2006  Fred Bloggs DCoononT
® £ Misc Documents O | R Graphical Design Mockups.psd Screen Layout | 1009 Joe P Smith 1-May-2006 Joe P Smith DCoo0013
# 3 Screen Captures (] UML Diagram 43 Fred Bloggs 23-Apr-2006 Fred Bloggs Dcoooo12
=8 Specifications 0 o Wireframeved | Screen Layout | 633 Fred Bloggs | 2-Apr-2006 Joe P Smith DCO0000E
# 3 Test Results — =
[ | 3 Book Management Screen Wireframe. ai Screen Layout | 392 Fred Bloggs 1-Apr-2006 Jog P Smith DCo00o11
Show [15 ¥ | rows per page < Displaying page[1 | of 1 »

Operations.

4P Add Document

iresh Documents

Y Apoly Current Fittes
8 Clear All Fiers
] Export Documents

This screen consists of three main sections:

» The top left-hand pane displays a hierarchical list of the various folders that have been
setup for the current project. Clicking on the [+] expand icon will expand the child folders
and clicking on the name of the folder will display the list of documents in the folder in the
main pane to the right.

» The main right-hand pane displays a list of all the documents contained within the
currently selected folder. This list can be filtered and sorted, and you can choose how
many rows of documents to display on the page at one time.

» The bottom left-hand pane contains all the “Operations” that can be performed on the
document list. You can use the various icons to add documents to the current folder,
delete existing documents from the project, refresh the list of documents, export
documents to another project and options to apply the selected filter.
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10.1.1. Add New Document

To add a new document to the project, you just need to click on the <Add Document> icon in the
Operations list, and the ‘Add New Document’ dialog box will be displayed:

- - Welcome, Fred Bloggs | My Profie | Log Out | Help?
spiraTeam
L a— [T Fojcct Home Planning Testing Tracking Reporting
Project Home | Documents Role: Manager
Document Folders | Refiesh s Type A Y Size AV Edited By AY  Edited On 4V By AY Doc# AY
O v — Afy - v DC
=& Root Folder X B = = B
= B Design Documents ] Add New Document ith 10-May-2006  Fred Bloggs DCO0000T
@ @8 Misc Documents 0 ith  1May-2006  Jos P Smith DC000013
©es Type:* @ File O URL
] creen Captures O 95 23-Apr-2008 Fred Bloggs DCo00012
e Filename:*
=0 Specifications = L | Biice g5 2Apr2006  JocPSmth  DCO000IS
& £ Test Results A
(] Description 05 1-Apr-2006 Joe P Smith DCoooo11
= Show IE] OWS per page, H 4 Displaying pagelz]'a of 1 »
dhiiid Document. Document Type:* [Funmnll Specificaton "]
2% Delote Document Tags: [ |
2 Refiesh Documents
> Upload | Cancel
Y Apply Cuent Fittes
£ Clear All Filters

& Export Documents

From here, you need to either browse to the file being uploaded or enter in its URL, and then
enter the description (optional), choose the type of document from the list provided and supply
any meta-tags that you want to search on (separated by commas). Then click <Upload> to
complete the operation or <Cancel> to abort.

10.1.2. View Document Information

When you hover the mouse pointer over any of the documents displayed in the document list, an
information panel will be displayed that contains the name, description, version, document type
and meta-tags of the document:

o~ . Welcome, Fred Bloggs | My Profile | Log Out | Help?
spiraTeam
E— My Page Project Home Planning Testing Tracking Reporting
Home | Documents Role: Manager
Document Folders | Refiesh v Document Name 4 ¥ Type A Y Size AV Edited By A¥Y  Edited On AV Uploaded By AY Doc# AV
- Ay = v = Ay - v - Ay = v
I O | e | | 3] fan-v] be[ |
28 Design Documents O | sequence D PSmith  10Msy2006  Fred Bloggs DCO0000T
® 8 Misc Documents O | "2 Graphical 04 Sequence Diagram for Book Mgt pdf P Smith 1-May-2006 Joe P Smith DCo00013
# 23 Screen Captures O = Use Case Di d Bloggs 23-Apr-2006 Fred Bloggs DCcoooo12
&. & Specifications O | & author Mang Filename: Sequence Diagram for Book Mgt.pdf & d Bloggs 2.Apr-2006 Joa P Smith DCD0000E
[# 3 Test Results == Document Type: UML Diagram Bl 1 2006 P Smith DCO00011
O | % Book Mansad  Fig Type: P J Bloggs -Apr Joe P Smit
Operations Show "9 Pl Description: Sequence diagram in UML format that provides 14 Displaying WQDDQ o1
itional detail ing the book
b iAdd Document use-case / test case
12 Delote Document Version: 12
% Refresh Documents Tags: sequence diagram | book management
Vs L etme
£ Cloar All Fitars L RS S AN
B Export Documents Document ID: DCO00007
Expont Documents
> View Details | Cancel
"

You can click on the document URL to actually open the document itself in a new window, click
on the meta-tag links to find related documents that contain the same meta-tag, or click on “View
Details” to see more information regarding the document, including an ability to edit its meta-
information and see the different versions of the document.

10.2. Document Details

When you click on a test case item in the document list described above, you are taken to the
document details page illustrated below:




B Welcome, Fred Bloggs | My Profile | Log Out | [Libraryinformation System ¥ | Help?
aTeam
My Page Project Home Planning Testing Tracking Reporting
Project Home | Documents > Document Details Role: Manager
== Back to Document List Save 3 Dekote % Refresh
> Design Documents Document: Sequence Diagram for Book Mgt pdf (DC00000T)
'] Sequence Diagram for Book Mgt.pdf
< Graphical Design Mockups.psd Filename:" |Sequ9ncg Diagram for Book Mgt pdf
() Use Case Diagram.vsd Deseription — Font - v s v BT U|ESE|ISIEEE | —=QOc@
= Author M n Wiref . - "
) Author Management Sereen Wirshrame.ved Sequence diagram in UML format that provides detail g the hook use-case / test
& Book Management Screen Wireframe ai aa
Document Folder:*  [Design Documens v Created By:*  [Fred Blaggs M|
Document Type:" |u'.l|_ Diagram v Edited By:" [Joe P smtn v
Tags |sequence diagram. book management Created On 5/3/2006 12:00:00 AM
File Type (Size) Acrobat 8 (35 KB) Last Edited 5/10/2006 12:00:00 AM
Current Version: 1.2
Versions * Associations ®

This page is made up of three areas; the left pane is for navigation, the upper part of the main
pane contains the details of the document, and the bottom part of the right pane contains the list
of document versions and the list of artifacts that the document is associated with.

The navigation pane consists of a link that will take you back to the project document list, as well
as a list of other documents in the current folder. This latter list is useful as a navigation shortcut;
you can quickly view the detailed information of all the peer documents by clicking on the
navigation links without having to first return to the main document list page.

The top part of the main pane allows you to view and/or edit the details of the particular
document. You can edit the various fields (name, description, etc.) and once you are satisfied
with them, simply click the <Save> button at the top of the page to commit the changes. In
addition you can delete the current document by choosing <Delete>, or discard any changes
made by clicking <Refresh>.

The lower part of the main pane can be switched between two different views by clicking the
appropriate tab. Initially the pane will be in “Versions” mode, but it can be switched to
“Association” as well. The functionality in each of these two views is described below:

10.2.1. Edit Document Versions

This view displays the list of different versions that exist for the current document. When you
initially create a new document there will be only a single version (e.g. v1.0), however as
revisions are made to the document, rather than having to create a whole new document, you
can just upload the new revision as a hew version (e.g. v1.1) and it will be added to the list of
versions.

Each version in the list is displayed with its name, a description of what changed in the version,
the version number assigned to the revision, the file-size, who uploaded the new version and a
link to actually open the new version:

© Copyright 2006-2009, Inflectra Corporation Page 97 of 121 This document contains Inflectra proprietary information




Versions # Aszsociations #
Size Uploaded By Uploaded On ¥ Operations

Active Version Version Comments
35 KB | Fred Bloggs | 10-May-2006

v ) Version 1.2 | Sequence diagram in UML format that provides additional
detail surrounding the book managament use-case / test

case
) Version 1.1% | Sequence diagram in UML format that provides additional 30 KB | Fred Bloggs | 5-May-2006 » Make Active | Delete
detail surrounding the book managament use-case / test
case
28 KB Joe P Smith | 3-May-2006 = Make Active | Delete

) Version 1.0 = | Sequence diagram in UML format that provides additional
detail surrounding the book managament use-case / test

case

Upload New Version

Filename:* | Browse...
Description: [~ font - v| [-sz- v BI U= = - AN RN ) [ Red |

Version:” I:I Make this the active version

On this page, you have the option to delete an existing version, make a different version the
active one (the one that users see when they view the document list and click on the link) and
upload a new revision. If you upload a new version, you need to provide a description of the
changes made, a new version number and whether the new version should be made the active
one. Note: If the original document was a file (instead of a URL) then all revisions will need to be
files, similarly if the original document was a URL, all revisions will need to be URLSs.

10.2.2. Edit Document Associations

This view displays a list of the artifacts in the current project that are associated with the current
document. If you originally uploaded the document as an attachment to a requirement, test case,
etc. then an initial association will be already listed, otherwise it will be empty.

Versions % Associations #
Date Artifact Name Created By Artifact Type Artifact # Operations
1-Dec-2003 X7 Ability to create new book2 Fred Bloggs Test Case TC000002 > Delete

Add New Association
Please choose the artifact that you want to add an association to:

Artifact Type:* |Requir5ment v

From this screen you can either delete an existing artifact association or add a new association
from the current document to an pre-existing artifact in the system. To add the association, you
just need to select the type of artifact being associated (requirement, test case, incident, etc.) and

the numeric ID of the artifact.
For example to add an association to Requirement RQ00005 you would choose Artifact Type =
Requirement and Artifact ID = 5.
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11. Reports Center

This section describes the reporting features of SpiraTeam®, including an overview of each of the
report types that are available. When you click on the “Reports” tab on the global navigation bar,
you will initially be taken to the reports home page illustrated below:

—— . Welcome, Fred Bloggs | My Profile | Administration | Log Out | Halp?
spiraTeam e e
—— My Page Project Home Planning Testing Tracking Reporting
Reporting Role: Manager
Saved Reports
> 1.0 Release List Report Requirement Reports  Test Case Reports Incident Reports Task Reports  Release Reports
s > Req Summary > Test Case Summary > Incident Summary > Task Summary > Release Summary
> Requirements Detailed > Test Case Detailed > Incident Detailed > Task Detailed > Release Detailed
> Requirements Plan > Test Set Summary > Release Plan
> T i > Test Set Detailed

> Printable Test Scripts
> Test Run Summary
> Test Run Detailed

Requirements Graphs Test Case Graphs Incident Graphs Task Graphs
> Requirements Summar, > Test Case Summary > Incident Summary > Task Summary
>R Caoverage > Test Run Summary > Incident Progress Rate > Task Velocity

> Test Run Progress Rate > Incident Cumulative Count > Task Bumup
> Incident Open Count > Task Bumdown
> Incident Aging

> Incident Turnaround Time

This page consists of two main areas:

» The left hand pane displays a list of any reports that have either been saved by the
currently logged in user, or those reports created by other members of the project, that
have been marked (by that user) as ‘shareable’.

» The right-hand main pane displays a list of the reports and graphs available in the
system, categorized by the artifact they primarily relate to (requirements, test cases,
incidents and releases). Clicking on any of the report hyperlinks will take you to the
configuration page for the report in question.

The configuration page for each report differs slightly, but the general format is illustrated below:




Welcome, Fred Bloggs | My Profile | Administration | Log Out | il—b'ﬂw information System v Help?

My Page Project Home Planning Testing Tracking Reporting

Reporting > Requirements Detailed Report Role: Manager

=< Back to Reports Home

Requirements Detailed Report

> Requirements Summary
Flease choose from the vanous options below to specify how you would like this report to appear
> Requirements Detailed You can filter the results displayed by various parameters as well as choose which elements of the report are displayed

> Requirements Plan

Report Format
> Requirements Traceability
Format: ® HTML £]
O MS-Word 2003+ 2]
O L=

Report Elements
Requirements Details: [ Adtifact Change History
[) Associated Tasks
[ Linked Incidents
[J Linked Requirements
[ List of Attached Documents
[0 Test Case Coverage

Requirements Details - Standard Field Filters

Author: ~Al v
Impontance: —Hl- v
Owner: - v
Status: [<an= v
Created On: =]
Last Modified: =]

Requirement #:

Task Progress: A v

Test Coverage: [~an v

Requirement Name:

Actual Effort:
Plan Effort:
Task Effort:

Release: — Al "

Requirements Details - Custom Property Filters

URL: |
Difficulty: - A~ v
Requirement Type: -Al v

If would like to save this report for future use, please give it a name below before clicking the [Create Report] button

Report Name: |
[T 1 would like to share this report with other members of the project

= Create Report [- Cancel |
|

You can configure the reports in the following ways:

» Report Format — This allows you to specify the display format of the report. Depending
on the specific report, they can be displayed as a web-page (HTML), downloaded as a
Microsoft Word document, downloaded as a Microsoft Excel spreadsheet or downloaded
as a Microsoft Project file. In addition there is a raw-XML format that allows you to export
the underlying report data into any external reporting system that supports XML import.

> Report Elements — This allows you to determine which types of information to include in
the report. This varies by report type, but includes the dependent items related to the
artifact being reported on (attachments, test steps, coverage, history, etc.)

» Standard Field Filters — This allows you to constrain the range of data being reported
on, based on the various fields associated with the artifact in question. These filters are
typically selections from multi-valued-dropdown lists and date-ranges.

» Custom Property Filters — This allows you to constrain the range of data being reported
on, based on the custom fields associated with the artifact by your project administrator.
These filters can be either freetext or drop-down lists.
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» Sort Options - This option is only available for the non hierarchical-data reports (i.e. for
test runs, incidents and tasks only) and allows you to specify the sort order of the results
returned in the report. For the hierarchical-data based reports the sort order is always the
order of the hierarchy.

>» Report Name — If you would like to save the report configuration so that you can quickly
re-run it at a later date, you just need to enter a name for the report and indicate (by
selecting the checkbox or not) whether you want this report to be private or shared by all
members of the project.

Once you have selected the format, elements and filters, clicking the <Create Report> button
launches the report in a new window. Each of the reports is now briefly described below:




11.1. Requirements Reports

11.1.1. Requirements Summary Report

This report displays all of the requirements defined for the current project in the order they appear
in the requirements list. The requirement's details and coverage status are displayed in a
summary list form:

= Print Report
Requirements Summary Report
This report displays all of the requirements defined for the current project in the order they appear in the requirements list. The requirement’s details and coverage status are displayed in a summary list form
Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
Req # Name Description  Priority Status Author Owner Creation Date Test Coverage Task Progress Last Modified Release # Planned Effort Task Effort Actual Effort URL
42 Tasks:
60% On
0 Covering. Schedule,
Functional 0 Failed, 6% Running
1| System n Fred 01-Dec2003 |0 Passed, | Late, 01-Dec-2003 M hours 0| 190 fours | 188 hours
Requirements fogress 0095 0 Blocked 4% Starting mins mins mins
0 Caution Late,
29% Mot
Started
42 Tasks:
60% On
0 Covering. Schedule,
Online Library 0 Failed. 6% Running
2 | Management AR [l 01-Dec2003 |0 Passed, | Late, 01-Dec-2003 M5houre @ | 190 haurs | 188 haurs
System g 99 0 Blocked, 4% Starting
0 Caution Late,
29% Not
Started

11.1.2. Requirements Detailed Report

This printable report displays all of the requirements defined for the current project in the order
they appear in the requirements list. For each individual requirement, the name, priority, author,
status and coverage status are displayed, along with tables containing the list of covering test
cases, linked incidents/requirements, associated tasks, attached documents, and the change
history:

Req #4 - Abifity to add new books to the system
The ability to add new books inta the system, complete with ISBN, publishes and other related information

Priority: 1 - Critical Status: Completed
Author: Fred Bloggs Creation Date: 01-Dec-2003
Coverage: 3 Covering, 1 Failed, 1 Passed 0 Blocked 0 Caution Last Modified: 01-Dec-2003
Owner: Joe P Smith Planned Effort: 15 hours 0 ming
Release #: 1.0.0.0 Task Est. Effort: 16 hours 0 mins
Task Actual Effort: 15 hours 30 mins
URL: http:/fww libraries. org
Difficulty: Moderate

Requirement Type:

Test Coverage:

Test # Name Status Est. Duration Last Execution Date
TC? Ability to create new baok Failed 0 hours 10 mins 04-Dec-2003

TCE Book management Passed 0 hours 4 mins 01-Dec-2003

TC13 Adding new beok and author te library Mat Run - -

Linked Requirements

Name Created By Comment Date Req Id
Ability to delete existing books in the system Fred Bloggs These two requirements are related 12-Mar-2004 RQE

Associated Incidents

Name Created By Comment Date Inc Id

Cannet install system on Oracle 9i Fred Bloggs This bug affects the requirement 14-Mar-2004 IN5

Cannot add a new book to the system Joe P Smith Test Run: Ability to create new book 04-Nov-2003 N7
Associated Tasks:

11.1.3. Requirements Plan

This report displays a complete work breakdown structure of the project from a requirements
perspective, including all requirements and tasks organized by schedule:
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Requirements Plan Report

This report displays a complete work breakdown structure of the project, including all requirements and tasks organized by schedule

Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library

1D # Name Type Status Priority Owner Start Date End Date Release # % Complete Plan Effort Est. Effort Actual Effort
1 Functional System Requi q :;1 1{5 hours 0 1‘3_0 hours 0 1ﬂlﬁ hours 40
rogress mins mins mins
1 N In 145 hours 0 190 hours 0 188 hours 40
2 Online Library Management System Requirement Progress ming mins mins
3 Book Management Requirement Completed 1 . 30 hours 0 %. hours 0 95. hours 0
Critical mins mins mins
. Joe P 15 hours 0 16 hours 0 15 hours 30
4 Ability to add new books to the system Requirement  Completed  1- Critical g 1.000 mins ming mine
1 Develop new book eniry screen Task 1-Criical  Fred Bloggs 4 02-Mar-2004 | 1.0.0.0.00 Shours Dmine | 7 hours 20 ming
2 Create buok object insert method Task 1-Critical  Fred Bloggs 4| 02-Mar-2004 | 1.0.0.0.00 Shours Dming | S hours 20 mins
3 Write book chjsct ingert queries Task 1-Criical | Fred Bloggs | 01-Mar-2004  02-Mar-2004 | 1.0.0.0.00 Ihours Dming | 2 hours 50 ming
. . . 1 ]
5 Ability to edit existing books in the system | Requiement  Completed | 1- Critical 92¢P 1000 f5hows0  [16houwrs0 | 16 hours 50
Smith mins mins mins
4 Develop edit book detais screen Task Compileted 1-Critical  Fred Bloggs | 03-Mar-2004  04-Mar-2004 | 1.0.0.0.00 Bhours Omins | 7 hours 20 mins
5 Create book object update method Task Compieted 1-Criical  Joe P Smith 4 04-Mar-2004 | 1.0.0.0.00 Shours Dmins | & hours O mins
& Wirte book cbject update querss Task Compieted 1-Crical | Joe P Smth | 03-Mar-2004  D4-Mar-2004 | 1.0.0.0.00 3hours Dming | 2 hours 30 mins
I | i g . . 14 he 16 h 5
6 Ability to delete existing books in the Requirement | Completed | 1 - Critical Fred 1000 4 hours 0 & hours 0 15 hours 10
system Bloggs mins mins mins

11.1.4. Requirements Traceability Matrix

This report displays a matrix of the requirements in the system with their list of covering test
cases and associated, mapped requirements:

Project 1: Library Information System

Sample application that allows users to manage books, authors and lending records for a typical branch library

Requirements Forward Traceability

This section displays a list of all the requirements with the associated test cases/requirements.
Req# MName Importance Status Release # Test Ti ili i T
RQ1 Functional System Requirements In Progress
RQ2 Online Library Management System In Progress
RQ3 Book Management 1 - Critical Completed
RQ4 Ability to add new books to the system 1 - Critical Completed 1000 TC2, TC8, TC13 RQ6
RQ35 Ability to edit existing books in the system 1 - Critical Completed 1.0.0.0 TC3.TC8 RQ7
RQ& Ability to delete existing books in the system 1 - Critical Completed 1.0.0.0 TC8. TC12 RQ4
RQ7 Ability to associate books with different subjects 1 - Critical Completed 1.1.0.0 TC4, TC8 RQ5
RQ8 Ability to associate books with different authors 1 - Critical Completed 1.1.0.0 TCB, TC13
RQ8 Ability to associate books with different editions 1 - Critical Completed 1100 TC4, TC8, TC12
RQ10 Ability to completely erase all books stored in the system with one click 1 - Critical Completed 1200 TC4, TC8, TC12
RQ11 Edition Management 1 - Critical In Progress
RQ12 Ability to create different editions 1 - Critical In Progress 1.0.0.0

11.1.5. Requirements Summary Graph

The requirements summary graph shows how many requirements are currently in a project. The
number of requirements is displayed according to the criteria that you specify. You can specify
the type of data displayed along the x-axis, and the requirement information which is used to
group the data. When you first open the graph you will be asked to pick the field that you would
like to display on the x-axis and the field that you would like to group the data by. Once you have
chosen the appropriate fields and clicked the <Select> button the graph will be displayed:
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X-Axis: Grouped-By: Importance: v > Select

Requirements: Summary [ 1-Crtical [ 2-High [ 3-Medium [ 4-Low

10
9

8

Completed In Progress Requested

In this version of the report, the x-axis represents the requirements’ status, and the individual bars
are grouped by requirement importance. Each data-value can be viewed by positioning the
mouse pointer over the bar, and a “tooltip” will pop-up listing the actual data value.

Clicking on the “Display Data Grid” link will display the underlying data that is being used to
generate the graph:

> Hide Data Grid
Status Importance
1 - Critical 2 . High 3 - Medium 4. Low
Completed 8 1 0 0
In Progress 2 2 0 0
Planned 0 2 3 0
Requested 0 1 4 2

This feature is available on all the various graphs in the system.

11.1.6. Requirements Coverage Graph

The requirements coverage graph shows how many requirements are currently in a project,
according to their test coverage status.

Requirements: Coverage @ 1-Crtical [ 2-High [0 3-Medium [J4-Low

Blocked Caution Hot Run Mot Covered




The x-axis of the report represents the various test execution statuses that a requirement can
have as its coverage status (plus the Not-Covered status), and the individual bars are grouped by
the requirements importance. Each data-value can be viewed by positioning the mouse pointer
over the bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data
Grid” link will display the underlying data that is being used to generate the graph.

11.2. Test Case Reports

11.2.1. Test Case Summary Report

This report displays all of the test cases defined for the current project in the order they appear in

the test case list. The test case's details and execution status are displayed in a summary grid
form with the test steps optionally displayed:

Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
Test # Name Description Priority Test Step Test Step Description Test Step Expected Result Test Step Sample Data Status  Author Owner Est. Duration Created On Last Modified|
1 Functional WA Fred  Fred 01-Dec- 13-0ct-2009
Tests Bloggs  Blogas 2003 15:07:47
Tests that
Ability to the user can
2 create new  create a (13-t ‘ Failed ;ﬂ’ Er‘d 0 23'0[_18':' :g;};agoua
book new book in | “TC8 0993 | Hloggs - h h
the system
Call Login to .
1 Application Mat Run
2 User clicks link to User taken to first screen Mot Run
create book in wizard
3 "U;ir:;ﬁ';m?]l:g _Use!' taken to next screen  Macbeth, William Mot Run
then clicks Next in wizard Shakespeare
User chooses book's | User sees screen
4 genre and sub-genre  displaying all entersd Play, Tragedy Mot Run
from list information
5 User clicks submit Confirmation screen is Mot Run
button displayed

11.2.2. Test Case Detailed Report

This report displays all of the test cases defined for the current project in the order they appear in
the test case list. The test case's details and execution status are displayed, along with sub-

tables containing the list of test steps, test runs, attached documents, the change history, and a
list of any associated open incidents:

Test #2 - Ability to create new book
Tests that the user can create a new book in the system
Status: Failad Priority: 1 - Critical
Author: Fred Bloggs Creation Date: 01-Dec-2003
Owner: Fred Bloggs Last Execution: 04-Dec-2003
URL: hittp:/ivww.libraryreferences.org
Test Type: Functional Test
Step Description Expected Result Sample Data Last Status
Call Login to Application Mot Run
2 User clicks link to create book User taken to first screen in wizard Not Run
3 User enters books name and author, then clicks Next User taken to next screen in wizard Macbeth, William Shakespeare Mot Run
4 User chooses book's genre and sub-genre from list User sees screen displaying all entered information Play. Tragedy Not Run
5 User clicks submit butten Confirmation screen is displayed Mot Run
Test Runs:
Run# Tester Test Set Release Version Status Est. Duration Actual Duration Execution Date
TR18 Fred Bloggs Heration 003 1.1.0.0.0003 Failed 2 mins 70 mins 04-Dec-2003
TR15  Joe P Smith Iteration 002 1.1.0.0.0002 Passed 2 mins 70 mins 03-Dec-2003
TR13  Fred Bloggs heration 001 1.1.0.0.0001 Passed 2 ming T0 ming 02-Dec-2003
TR12  Fred Bloggs Library System Release 1 1.0.0.0 Failed 10 mins 70 mins 01-Dec-2003
TR2 Fred Bloggs Testing Cycle for Release 1.1 Library System Release 1 SP1 1010 Passed 10 mins 90 mins 01-Dec-2003
TR1 Joe P Smith Testing Cycle for Release 1.0 Library System Release 1 1.0.0.0 Failed 10 mins 75 mins 01-Dec-2003
Requirements Coverage:
Req # Name Status Priority
RQ4 Ability to add new books to the system Completed 1 - Critical
QOpen Incidents:
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11.2.3. Test Set Summary Report

This report displays all of the test sets defined for the current project in the order they appear in
the test set list. The test set's details and execution status are displayed in a summary list form:

Test Set Summary Report
This report displays all of the test sets defined for the current project in the order they appear in the test set list. The test set's details and execution status are displayed in a summary list form
Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
Test Set # Name Description Status Release Creator Owner Created On Planned Date Last Modified Last Executed # Passed # Failed # Caution # Blocked # Not Run Notes
" Functional In Fred 02-Jan- _
X8 Test Sets Progress Bloggs 2007 05-Feb-2007 | 13-Oct-2009 - 0 0 0 ] 0
This tests
the
Testing functionality
™ Cyclefor | Imtroduced '; 10.0.0 E’ed ‘é"e P 02‘1;"' 05Feb-2007 | 13-0ct-2009  01Dec2003 |1 2 0 0 4
Release 1.0 M release rogress loggs  Smith | 200
1.0 of the
library
system
This tests
the
Testng e ot Fred JoeP | 03Jan
™ Cycle for 1100 - : 07-Feb-2007 | 13-Oct-2009  01-Dec-2003 3 0 0 ] 6
inrelease | Started Bloggs Smith | 2007
Release 1.1
2.0 of the
library
system
Thic o

11.2.4. Test Set Detailed Report

This report displays all of the test sets defined for the current project in the order they appear in
the test set list. The test set's details and execution status are displayed, along with sub-tables
containing the list of test cases, test runs, attached documents, and the change history:

Test Set #1 - Testing Cycle for Release 1.0
This tests the functionality introduced in release 1.0 of the library system
Owner: Joe P Smith Creator: Fred Bloggs
Release: 1.0.0.0 Creation Date: 02-Jan-2007
Status: In Progress Last Execution: 01-Dec-2003
Planned Date: 05-Feb-2007 Last Updated: 13-Oct-2009
Hotes:
Operating System:
Test Cases:
Test # Name Priority Est. Duration Status Last Execution Date
TC2 Ability to create new book 1 - Critical 10 mins Failed 01-Dec-2003
TC3 Ability to edit existing book 1 - Critical 5 ming Passed 01-Dec-2003
TC4 Ability to create new author 1 - Critical 8 mins Failed 01-Dec-2003
TC5 Ability to edit existing author 2 - High 5 mins Mot Run -
TCG Ability to reassign book to diffierent author 2 - High & ming Mot Run
TCB Book management 2 - High 4 mins Mot Run
TC9 Author managemant 2 . High 4 ming Mot Run
Test Runs:
Run # Tester Release Version Status Est. Duration Actual Duration Execution Date
TR4 Joe P Smith Library System Release 1 1000 Failed 8 mins 90 mins. 01-Dec-2003
TR3 Fred Bloggs Library System Release 1 1.0.0.0 Passed & mins 90 mins 01-Dec-2003
TR1 Joe P Smith Library System Release 1 1000 Failed 10 mins 75 mins 01-Dec-2003

11.2.5. Printable Test Scripts

This printable report is useful when you want to be able to conduct the testing activities offline on
paper, or when testers need paper copies of the test script in addition to using the online test
execution wizard.

In either case, this report simply displays all of the test cases defined for the current project in the
order they appear in the test case list together with their detailed test steps and a list of any
attached documents.
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Project 1: Library Information System

Sample application that allows users to manage books, authors and lending records for a typical branch library

Test #2 - Ability to create new book

Tests that the user can create a new book in the system

Tesr Steps:
Step Description Expected Result Sample Data Status Actual Result
User opens up browser and enters application URL: The browser loads the login . [Passed CIFailed
1 http:/fwww libraryinformationsystem.com/beta web page hitp:fiwww libraryinformationaystem.com/beta [CBlacked [caution

[IPassed [IFailed
[ClBlocked [ Caution
User taken to first screen in [Passed CIFailed
wizard [Blocked [ Caution
[Passed [IFailed
[IBlocked [ Caution
[IPassed [IFailed
[IBlocked []Caution

User taken to main menu

2 User logs in to application screen

Login=librarian, Password=password1
2 User clicks link to create book

User taken to next screen in

3 User enters books name and author, then clicks Next wizard

Macbeth, William Shakespeare

User sees screen displaying

4 User chooses book's genre and sub-genre from list all entered infarmation

Play. Tragedy

i p Confirmation screen is [JPassed [1Failed
5 User clicks submit button displayed DIBlocked T Caution
File Attachments:
Filename Description Author Date Uploaded
Sequence Diagram for Book Mgt pdf Sequence diagram in UML format that prondes i detail the book use-case / test case Fred Bloggs  03-May-2006

11.2.6. Test Run Summary Report

This report displays all of the test runs defined for the current project. The test run's details and
execution status are displayed in a summary grid form;

Test Run Summary Report
This report displays all of the test runs defined for the current project in date order (most recent first). The test run's details and execution status are displayed in a summary list form
Project 1: Library Information System
Sample application that allows users to manage books, suthors and lending records for a typical branch library
Test Run # Name Test Case #Release  Test Set Type Tester Est. Duration Actual Duration Start Date End Date Status  Runner Message Notes Web Browser Operating Systd
Ability to
TRID | edit existing TC3 1000 Manual ;:5" Ohous§ | Ohows50  O1Oec-  O1Dece o0,
book oggs | mins mins 2003 2003
ponyte Fred  Ohows10 1hows10  01Dec- | 01D T
i ours ours = -Uec- - . ul .
TR1Z ;::;13 new TCZ 1000 Automated Bloggs | mins mine 2003 2003 Failed | MUnit wae Opera Windows 2003
found
ponyte Fred | Ohows2 | 1hours10  02Dec- | 02D T
i ours ours = -Uec- . uf
TR13 ;::;13 new TC2 1.1.0.0.0001 Autemated Bloggs | mins mine 2003 2003 Passed | JUnit wae
found
e Fred | OhowsS |1hours10  02Dec- | 02D T
" Py 4 ours ours C- -Uec- . ul
TR14 x:ksxlshng TC3 1.1.0.0.0001 Automated Bloggs | mins mine 2003 2003 Passed | JUnit wae
found

11.2.7. Test Run Detailed Report

This report displays all of the test runs defined for the current project in date order (most recent
first). The test run's details and execution status are displayed, along with sub-tables containing
the list of test run steps, and a list of any associated open incidents:




Test Run #1 - Ability to create new book
Tests that the user can create a new book in the system

Test Case #: Tc2

Release #: 1.0.00 Status: Failed

Tester: Joe P Smith Execution Date: 01-Dec-2003

Type: Manual Test Set: Testing Cycle for Release 1.0
Est. Duration: 0 hours 10 mins Actual Duration: 1 hours 15 mins

Notes:

Web Browser: Intemet Explorer

Operating System: Windows XP

Step Description

Expected Result

Sample Data ActualResult

Status
1 User logs in to application User taken to main menu screen Passed
2 | User clicks link to create book User taken to first screen in Passed
wizard
3 User enters books name and authar, then clicks User taken to next screen in Macbeth, William An error page is displayed - "Mo such object or with block vanable at line Failed
HNext wizard Shakespeare 473"
Associated Incidents:
Inc # Type Status Priority Severity Name Owned By Detected On
7 Bug Assigned 1- Critical 3 - Medium Cannot add a new book to the system Joe P Smith 04-Now-2003
File Attachments:
Filename Description Author Date Uploaded
Error Logging-in Screen-shot gif

Captured sereen-shot of the error that was raised when attempting o log in to the library application Fred Bloggs 24-Apr-2006

11.2.8. Test Case Summary Graph

The test case summary graph shows how many test cases are currently in a project. The number
of test cases is displayed according to the criteria that you specify. You can specify the type of
data displayed along the x-axis, and the test case information which is used to group the data.
When you first open the graph you will be asked to pick the field that you would like to display on
the x-axis and the field that you would like to group the data by. Once you have chosen the
appropriate fields and clicked the <Select> button the graph will be displayed:

K-Axis: Grouped-By: Priority v » Select
Test Cases: Summary [ 1-Critical @ 2-High [ 3-Medium
10]

51
ol
A
5
A
4
5
i
7B\Ucked Caution Failed IN#A Mot Run Passzed '

In this version of the report, the x-axis represents the test case execution status, and the
individual bars are grouped by test case priority. Each data-value can be viewed by positioning
the mouse pointer over the bar, and a “tooltip” will pop-up listing the actual data value. Clicking on

the “Display Data Grid” link will display the underlying data that is being used to generate the
graph.

11.2.9. Test Run Summary Graph

The test run summary graph shows how many test runs are currently in a project. The number of
test runs is displayed according to the criteria that you specify. You can specify the type of data
displayed along the x-axis, and the test run information which is used to group the data. When
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you first open the graph you will be asked to pick the field that you would like to display on the x-
axis and the field that you would like to group the data by. Once you have chosen the appropriate
fields and clicked the <Select> button the graph will be displayed:

K-Auxis: Grouped-By: Type v » Select
Test Runs: Summary M Automated @ Manual

10]

51

41

Blocked Caution Failed Passed

In this version of the report, the x-axis represents the test run execution status, and the individual
bars are grouped by test run type. Each data-value can be viewed by positioning the mouse
pointer over the bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the
“Display Data Grid” link will display the underlying data that is being used to generate the graph.

11.2.10. Test Run Progress Rate Graph

The test run progress rate graph shows how many tests have been executed during a period of
time, and what execution status was recorded. The report can either be displayed for 60 days of
data daily or for 12 months of data weekly, ending on a specified date.

The screen-shot below illustrates the progress rate report loaded with the past 60 days of test run
data depicted on a daily basis:

Release: |— All Releases — V‘ Date Interval: @ Daily O Weekly Date Ending: | 1zszo0s [ » Filter

Test Runs: Progress Rate [ Failed [0 Passed [ MNotRun [ NA  [JBlocked [ Caution

20|

T T T T T T T T T T T T T T T T T T T T _T_T 1 T T T T T T T T T T T T
10/7/2003 10/ 2/2003 1001712003 10622/2003 102Ti2003 11162003 11212003 1126/2003  1211/2003

T T T T T T T T T T T T T T
117112003 11612003 1141172003




In this version of the report, the y-axis represents the number of test runs executed in each 24
hour period, and the x-axis represents a specific day in the time-span. Each data-bar can be
viewed by positioning the mouse pointer over the point, and a “tooltip” will pop-up listing the
actual data value. You can filter the report by the release that the test run was executed against,
and also change the ending date of the date range. By clicking on the weekly radio button, you
can display the past 12 months of test run data organized on a weekly basis. Clicking on the
“Display Data Grid” link will display the underlying data that is being used to generate the graph.

11.3. Incident Reports

11.3.1. Incident Summary Report

This report displays all of the incidents tracked for the current project. The incident's details are
displayed in a summary list form:

Incident Summary Report
This repont displays all of the incidents tracked for the current project. The incident’s details are displayed in a summary list form

Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library

Inc # Name Description Resolution Type Status Priority Severity Detected By Owned By Detected On Last Modified Closed On Detected Release Resolved Release
When trying to
log into the
application with a

Cannot log r
valid username Fred 01-MNow-
- 5 x -
1 ::loht::lian and password, Incident New Bloggs 2003 01-Dec-2003 1000 1.0.1.0
PP the system
throws a fatal
exception
When | try and
click on the
button to add a
Mot able to
new author the Joa P 01-Now-
W - - x -

2 ::(dh:'et ayatem simply Incident New Smith 2003 01-Dec-2003 1000 1.0.1.0
displays the
main screen and
does nothing

When | click on

Clicking on the logout link,

instead of Fred 01-Now-
3 Irlrltk‘lhr"u\:s logging au, 1 get Incident New Bloggs 2003 01-Dec-2003 - 1010 1020
el e an ASP session
not valid error

11.3.2. Incident Detailed Report

This printable report displays all of the incidents tracked for the current project sorted by incident
number. For each individual incident, the name, type, priority, status, opener, owner and close
date are displayed, along with tables containing the detailed description and resolutions as well
as a tabular list of attached documents, linked requirements/incidents and the change history:

Project 1: Library Information System
Sample application that allows ugers 1o manage books, authors and lending records for a typical branch library

Inc #1 - Cannot log into the application

When trying to log into the 2 with a valid and password, the system throws a fatal exception

Type: Incident Priority:

Status: New Severity:

Opened By: Fred Bloggs Opened On: 01-Mow-2003
Assigned To: Last Modified: 01-Dec-2003
Detected In Release:  1.0.0.0 Closed On: -

Resolved In Release:  1.0.1.0 Verified In Release: 1.01.0
HNotes:

Operating System:

Associations:
Artifact Type Hame Created By Comment Date Artifact Id
Test Run Sample Test Fred Bloggs Test Run: Sample Test 01-Nov-2006 TR9
Incident The book listing screen doesn't sort Joe P Smith This incident and bug are related 16-Mar-2004 IN &
Requirement Ability 10 create new users in the system Joe P Smith Tes1 Run: Sample Test 01-Dec-2003 RQ 26

File Attachments:

Filename Description

Author Date Uploaded
Bug Stack Trace txt

Joe P Smith 04-May-2006

Error Logging-in Screen-shot gif Captured screen-shol of the error that was raised when attempting to log in to the library application Fred Bloggs | 24-Apr-2006
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11.3.3. Incident Summary Graph

The incident summary graph shows how many incidents are currently in a project. The number of
incidents is displayed according to the criteria that you specify. You can specify the type of data
displayed along the x-axis, and the incident information which is used to group the data. When
you first open the graph you will be asked to pick the field that you would like to display on the x-
axis and the field that you would like to group the data by. Once you have chosen the appropriate
fields and clicked the <Select> button the graph will be displayed:

X-Axis: Grouped-By:  |Tvpe v » Select

Incidents: Summary [ Bug O Change Request @ Enhancement @ Incident @ Issue @ Limitation @ Risk W Training

20

Assigned Duplicate Not Reproducible Open

In this version of the report, the x-axis represents the incidents’ status, and the individual bars are
grouped by the type of incident. Each data-value can be viewed by positioning the mouse pointer
over the bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data
Grid” link will display the underlying data that is being used to generate the graph.

11.3.4. Incident Progress Rate Graph

The incident progress rate chart displays the total number of incidents created and closed over a
particular date-range. The report can either be displayed for 60 days of data daily or for 12
months of data weekly, ending on a specified date.

The screen-shot below illustrates the progress rate report loaded with the past 60 days of incident
discovery/closure data depicted on a daily basis:




Reporting > Incidents: Progress Rate
=< Back to Reports Home

Incident Type - All -

Welcome, Fred Bloggs | My Profile | Log Qut | | Library information System > Help?
My Page Project Home Planning Testing Tracking Reporting
Role: Manager
Incident Graphs: Summary | Progress Rate | Cumulative Count | Open Count | Aging | Tumaround Time
~ Date Interval: @ Daily O Weekly Date Ending: (92372008 | (midyyyy) * Filter

Incidents: Progress Rate @ Discovered

Closed

|
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In this version of the report, the y-axis represents the number of incidents (either created or
closed in a 24 hour period), and the x-axis represents a specific day in the time-span. Each data-
point can be viewed by positioning the mouse pointer over the point, and a “tooltip” will pop-up
listing the actual data value. You can filter the report by the type of incident, and also change the
ending date of the date range (e.g. displaying only the bugs for the date range).

Similarly, by clicking on the weekly radio button, you can display the past 12 months of incident
discovery data organized on a weekly basis:

Welcome. Fred Bloggs | My Profile | Log Qut | | Library information System ~] Help?
My Page Project Home Planning Testing Tracking Reporting
Reporting > Incidents: Progress Rate Role: Manager
== Back to Reports Home Incident Graphs: Summary | Progress Rate | Cumulative Count | Open Count | Aging | Tumaround Time
Incident Type: |- All - v] Date Interval: O Daily & Weekly Date Ending: (9232008 | (midiyyyy) = Fiter |
Incidents: Progress Rate @ Discovered @ Closed
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In this version of the report, the y-axis represents the number of incidents (either created or
closed in a 7-day period), and the x-axis represents a specific week in the time-span. Each data-
point can be viewed by positioning the mouse pointer over the point, and a “tooltip” will pop-up
listing the actual data value. Again you can filter this report by the type of incident and also
specify the ending date of the date-range. Clicking on the “Display Data Grid” link will display the
underlying data that is being used to generate the graph.

Clicking the “Back to Project Home” hyperlink will take you back to the Project Home dashboard.
In addition, the toolbar displays a list of shortcuts to other incident reports that can be displayed.
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11.3.5. Cumulative Incident Count Graph

The cumulative incident count chart displays the cumulative total number of incidents logged in
the system for the current project over a particular date-range. The report can either be displayed
for a 60 day interval on a daily basis or for a 12 month interval of a weekly basis. The report
displays two data series, one illustrating the total count of all incidents, the other the total count of
all open incidents (i.e. with status not set to fixed or closed).

The screen-shot below illustrates the cumulative count report loaded with the past 60 days of
cumulative incident count data depicted on a daily basis:

Welcome, System A | My Profile | A istration | Log Out | | Librory information System i Help?

e Ity Page Project Home Planning Testing Tracking Reporting
Role: Project Owner

Reporting > Incidents: Progress Rate
<< Back to Reports Home Incident Graphs: Summary | Progress Rate | C Count | Open Count | Aging | Tumargund Time

Incident Type — All - ~ Date Interval: @ Daily O Weekly Date Ending 10192008 ([ (midiyyyy) » Filter

Incidents: Progress Rate @ Discovered Closed
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In this version of the report, the y-axis represents the number of incidents, and the x-axis
represents a specific day in the time-span. Each data-point can be viewed by positioning the
mouse pointer over the point, and a “tooltip” will pop-up listing the actual data value. You can also
filter the type of incident being reported, as well as change the end date for the date interval.

Similarly, by clicking on the weekly radio button, you can display the past 12 months of
cumulative incident count data organized on a weekly basis:

Welcome, Systam ini: | My Profile | Administration | Log Qut | | Library nformatson System > Help?
My Page Project Home Planning Testing Tracking Reporting
Role: Project Owner
=< Back to Reports Home Incident Graphs: Summary | Progress Rate | Cumulative Count | Open Count | Aging | Tumaround Time
Incident Type: — All - | Date Interval @Daily O Weekly Date Ending 10/192008 | (midiyyyy) > Filter |

Incidents: Cumulative Count ® Open Total
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In this version of the report, the y-axis represents the number of incidents logged in a 7-day
period, and the x-axis represents a specific week in the time-span. Each data-point can be
viewed by positioning the mouse pointer over the point, and a “tooltip” will pop-up listing the
actual data value. Again, you can also filter the type of incident being reported, as well as change
the end date for the date interval. Clicking on the “Display Data Grid” link will display the
underlying data that is being used to generate the graph.

Clicking the “Back to Project Home” hyperlink will take you back to the Project Home dashboard.

11.3.6. Open Incident Count Graph

The open incident count chart displays the total number of open incidents in the system for the
current project over a particular date-range categorized by incident priority. The report can either
be displayed for a 60 day interval on a daily basis or for a 12 month interval of a weekly basis.
The screen-shot below illustrates the discovery report loaded with the past 60 days of cumulative
incident count data depicted on a daily basis:

Tea - Welcome, System Administrator | My Profile | Administration | Log Out | |Library information System ~ Help?
My Page Project Home Planning Testing Tracking Reporting
Reporting > Incidents: Open Count Role: Project Owner
=< Back to Reports Home Incident Graphs: Summary | Progress Rate | Ci lative Count | Open Count | Aging | Tumnaround Time
Incident Type: |~ All — v| Date Interval: ~ ® Daily O 'Weekly Date Ending:  [1019/2008 |[D (midfyyyy) [ Filter |
Incidents: Open Count M@ 1-Critical [ 2-High [ 3-Mediuom [J4-Low
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In this version of the report, the y-axis represents the number of incidents, and the x-axis
represents a specific day in the time-span. The exact count of each bar in the stacked histogram
can be viewed by positioning the mouse pointer over the bar, and a “tooltip” will pop-up listing the
actual data value. You can also filter the type of incident being reported, as well as change the
end date for the date interval. Clicking on the “Display Data Grid” link will display the underlying
data that is being used to generate the graph.

Similarly, by clicking on the weekly radio button, you can display the past 12 months of open
incident counts organized on a weekly basis (categorized by priority).

11.3.7. Incident Aging Graph

The incident aging chart displays the number of days incidents have been left open in the system.
The chart is organized as a stacked histogram, with the count of incidents on the y-axis and
different age intervals on the x-axis. Each bar-chart color represents a different incident priority,
giving a project manager a snapshot view of the age of open project incidents by priority.
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S - , System ini | My Profile | Administration | Log Qut | |Library nformation System [ | Help?
spiraTeam
— My Page Project Home Planning Testing Tracking Reporting
Reporting > Incidents: Aging Role: Project Owner
=< Back to Repons Home Incident Graphs: Summary | Erogress Rate | Cumulative Count | Ogen Count | Aging | Tumarcund Time
Incident Type: |~ Al - v Date Interval: Date Ending:  [10712000 | gmicryyyy)
Incidents: Aging & 1- Critical @ 2 - High O 3-Medium [0 4-Low
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This report can be filtered by the type of incident, so for example you can see the aging of just
bugs, or just issues for the project in question. Clicking on the “Display Data Grid” link will display
the underlying data that is being used to generate the graph.

11.3.8. Incident Turnaround Time Graph

The incident turnaround time chart displays the number of days incidents have taken to be closed
(from the time they were first raised) in the system. The chart is organized as a stacked
histogram, with the count of incidents on the y-axis and different turnaround time intervals on the
x-axis. Each bar-chart color represents a different incident priority, giving a project manager a
shapshot view of the turnaround time of project incidents by priority.

e - Welcome, System Administrator | My Profile | Administration | Log Qut | |Lbrary nformaton System | v Help?
spiraTeam
— My Page Project Home Planning Testing Tracking Reperting
Reporting > Incidents: Turnaround Time Role: Project Owner
== R Hom: Incident Graphs: Summary | Progress Rate | Cumulative Count | Qpen Count | Aging | Tumaround Time
Incident Type: - All - v Date Interval: Data Ending: I:l (midhyyyy)
Incidents: Turnaround Time | 1 - Critical 2-High [0 3-Medum [04-Low

B
- =

o7 214 Y21 228 283 W42 4349 088 Ste3 Bl T Tem 84.90 »90

This report can be filtered by the type of incident, so for example you can see the turnaround time
of just bugs, or just issues for the project in question. Clicking on the “Display Data Grid” link will
display the underlying data that is being used to generate the graph.




11.4. Task Reports

11.4.1. Task Summary Report

This report displays all of the tasks tracked for the current project. The task’s details are displayed
in a summary list form:

Project 1: Library Information System
Sample application that allows users to manage books, authors and lending records for a typical branch library
Task # Name Description Status Priority Owned By Created On Last Modified Release # Requirement # Start Date End Date % Complete Est. Effort Actual Effort|
Wirite edition object Mot 1- Fred 01-Dec- 11-Mar- 12-Mar- . 3 hours 0
2 insert queries Started Critical  Bloggs 2003 01-Dec-2003 | 1.0.0.0.0003 | RQ12 2004 2004 % mins .
Develop edit author Mot Joe P 01-Dec- r 07-Mar-  08-Mar- ; 8 hours 0
2 details screen stated 2 MO0 sman 2003 01-Dec-2003 | 1.0.0.0.0002) RQ15 2000 2000 0% mins
Create author
Mat Joe P 01-Dee- 07-Mar-  08-Mar- - 5 hours 0
25 ra:;xfhngéwpdale Staned 2-High Ton 2003 01-Dec-2003  1.0.0.0.0002 RQ15 2004 2004 0% mins -
Write autheor object Mot Joe P 01-Dec- 07-Mar-  08-Mar- .. 3 hours 0
2 update queries Started 2-High 'grith 2003 01-Dec-2003 | 1.0.0.0.0002 | RQ1S 2004 2004 % mins )
Refactar author
27 | ecreen to include Mot 2-High Fred 01-Dec 44 Dec2003 1.0.0.0.0003 RO 09Mar. 10Mar- o, 6 hours 0
delete button Started Bloggs 2003 2004 2004 mins

11.4.2. Task Detailed Report

This report displays all of the tasks tracked for the current project. The task's details are
displayed, along with a tabular list of attached documents and the change history:

Task Detailed Report

This report displays all of the tasks tracked for the current project. The task's details are displayed. along with a tabular list of attached documents and the change history.

Project 1: Library Information System

Sample application that allows users to manage books, authors and lending records for a typical branch library

Task #23 - Write edition object insert queries

Requirement ID: RQ 12 Status: Mot Started
Release #: 1.0.0.0.0003 Priority: 1 - Critical
Assigned To: Fred Bloggs Created On: 01-Dec-2003
Start Date: 11-Mar-2004 Last Modified: 01-Dec-2003
End Date: 12-Mar-2004 Estimated Effort: 3 hours 0 mins
% Complete: 0% Actual Effort: -

11.4.3. Task Summary Chart

The task summary graph shows how many tasks are currently in a project. The number of tasks
is displayed according to the criteria that you specify. You can specify the type of data displayed
along the x-axis, and the task information which is used to group the data. When you first open
the graph you will be asked to pick the field that you would like to display on the x-axis and the
field that you would like to group the data by. Once you have chosen the appropriate fields and
clicked the <Select> button the graph will be displayed:
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—— . s P o ; " Help?
- . System | My Profile | | Log Qut | |Library information System » Help?
spiraTeam
— My Page Project Home: Planning Testing Tracking Reporting

Reporting > Tasks: Summary Role: Project Owner

=< Back to Reports Home Task Graphs: Task Summary | Task Velocity | Task Bumup | Task Bumndown

Yohis:  |Priority [w Grouped-By: | Status |

Tasks: Summary I Completed [ InProgress [ Mot Started

2 - High 3 - Medium

In this version of the report, the x-axis represents the tasks’ priority, and the individual bars are
grouped by the status of task. Each data-value can be viewed by positioning the mouse pointer
over the bar, and a “tooltip” will pop-up listing the actual data value. Clicking on the “Display Data
Grid” link will display the underlying data that is being used to generate the graph.

11.4.4. Task Velocity Chart

The Task Velocity graph shows the total estimated and actual effort delivered in each project
release and/or iteration:

S’F-J}Faream- Welcome, System | My Profile | | Log Out | [Libeary Wlormation System ] Help?
— My Page Project Home Planning Testing Tracking Reporting
Reporting > Tasks: Velocity Role: Project Owner
=< Hi Task Graphs: Task Summary | Task Velocity | Task Burmnup | Task Bumdown
Display datafor | 1.1.0.0.0003 - Reration 003 ]
Tasks: Velocity @ Expected Velocity < Actual Velacity
W
27
Ny . ®
21
1%
15
12
El
&
¥
10252004 102802004 0172008
= Display Data Grid

The y-axis of the graph displays the total estimated and actual effort delivered, and the x-axis can
be configured to display three different levels of granularity:

» All Releases — This shows the total estimated and actual effort for each of the releases
in the project

» Specific Release — This shows the total estimated and actual effort for each of the
iterations in the selected release




» Specific Iteration — This shows the total estimated actual effort for each working day in

the date-range covered by the selected iteration.

11.4.5. Task Burnup Chart

The Task Burnup graph shows the cumulative increase in work for each release/iteration in the
project with the percentage of tasks that are on-schedule, late starting and late finishing indicated:

Welcome, System | My Profile | Administration | Leg Out |

Reporting > Tasks: Burnup

My Page Project Home Planning Testing

=< Back to Reports Home

Display data for | 1.0.0.0 - Library System Release 1 v

O On Scheduie [ Late Finshing [ Late Starting [ Wot Started

Tasks: Burnup

100

Tracking

Library information System vl Help?

Task Graphs: Task Summary | Task Velocity | Task Bumup | Task Bumdown

Reporting
Role: Project Owner

1.0.0.0.0001 1.0.0.0.0002

1.0.0.0.0003

The y-axis of the graph displays the cumulative increase in work for the project, broken down by
progress (on-schedule, late-finishing, later-starting or not-started), and the x-axis can be

configured to display three different levels of granularity:

» All Releases — This shows the increase in work for each of the releases in the project

» Specific Release — This shows the increase in work for each of the iterations in the

selected release

» Specific Iteration — This shows the increase in work for each working day in the date-

range covered by the selected iteration.

11.4.6. Task Burndown Chart

The Task Burndown graph shows the remaining work that needs to be done for each

releasel/iteration in the project:

Welcome, System Administrator | My Profile | Administration | Log Out | |Lirary mformaton System

spiraTeam’

My Page Project Home Planning Testing Tracking Reporting

Reporting > Tasks: Burndown

<< Back to Reports Home Task Graphs: Task Summary | Task Velocity | Task Burnup | Task Bumdown

Display datafor. | 1.0.0.0 - Library System Release 1 ]

Tasks: Burndown O Remsining Ettort

Role: Project Owner

1000 1.00.8.0001 1.0.0.0.0002 10.00.0003
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The y-axis of the graph displays the total remaining work that needs to be done, and the x-axis
can be configured to display three different levels of granularity:

» All Releases — This shows the total remaining work that needs to be done for each of the
releases in the project

>» Specific Release — This shows the total remaining work that needs to be done for each
of the iterations in the selected release

» Specific Iteration — This shows the total remaining work that needs to be done for each
working day in the date-range covered by the selected iteration.

11.5. Release Reports

11.5.1. Release Summary Report

This report displays all of the releases and iterations defined for the current project in the order
they appear in the release/iteration hierarchy. The release's details are displayed in a summary
list form:

Release Summary Report
This report displays all of the releases and iterations defined for the current project in the order they appear in the releasefiteration hierarchy. The release’s details are displayed in a summary list form

Project 1: Library Information System

Sample application that allows users to manage books, authors and lending records for a typical branch library

General Testing Information
Rel # Name Version Number Description Creator Creation Date Iteration Active Start Date End Date # Failed # Passed # Blocked # Caution # Not Run Task Progress Planned Effort
18 Tasks

. 50% On
This is the 2
. L I
Library initial ?;lj:denlJ:ning
1 System 10.0.0 re[eage of Fred 16.Feb-2004 N ¥y 01-Mar- | 12-Mar- 2 0 0 1 4 Late 216 hours 0
Release the Library  Bloggs 2004 2004 9% Starti mins
1 Management L:e o
System 26% Hot
Started
This senice gJaé:s'
%
Library i‘:ﬁiﬂ:igﬁs Schedule
System Joe P i 13-Mar- | 30-Mar- 0% Running 176 hours 0
2 Release 1.0.1.0 :Ir.lngas”anda Smith 05-May-2004 M Y 2004 2004 0 3 1 0 3 Late ming
15P1 0% Startin
security Lz:e 0% Ni[
wulnerability

Started

11.5.2. Release Detailed Report

This report displays all of the releases and iterations defined for the current project in the order
they appear in the release/iteration hierarchy. The release's details are displayed, along with sub-
tables containing the list of requirements added, mapped test cases, test runs executed, incidents
resolved, attached documents, scheduled tasks and the change history:
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1.1.0.0 - Library System Release 1.1
This version adds additional reporting functionality to the 1.0 version
Version # 11.00
Creator: Fred Bloggs
Start Date: 15-0ct-2004
End Date: 27-Oct-2004
# Resources: 3
Non-Working Days: 6
Notes:
Operating System:
Requirements Added:
Req # Name
RaQ1 F I System Requi
RG2 Online Library Management System
RQ3 Book Management
RQ7 Ability to associate books with different subjects
RQ8 Ability to associate books with different authors
RQ9 Ability to associate books with different editions
RQ13 Author Management
RQO17 Ability 1o link authors to their contact information
Mapped Test Cases:
Test# Name
TC4 Ability to create new author
TC2 Ability to create new book
TCS Ability 10 edit exigting author

Active:

Creation Date:
Planned Effort:
Available Effort:

Task Est.

Actual Effort:

¥

15-0ct-2004

168 hours 0 mins
82 hours 0 mins
86 hours 0 ming
85 hours 40 mins

Effort:

Status Priority
In Progress
In Progress
Completed 1 - Critical
Completed 1 - Critical
Completed 1 - Critical
Complated 1 - Critical
In Progress 2 - High
Requested 2 - High

Status Last Execution Date

Failed 01-Dec-2003

Failed 04-Dec-2003

Blocked 01-Dec-2003

11.5.3. Release Plan Report

This report displays a complete work breakdown structure of the project from a release
perspective, including all releases, iterations, requirements, tasks and incidents organized by

schedule:
Project 1: Library Information System

ID# MName
RL1 1.0.0.0 - Library System Release 1
RO4 Abiity to 89d new books 10 the system
ROS Abity to edit existing books in the system
RO6 Abilty to delete existing books in the system
RO12 Abifty to create different edtions
RO1S Abifly t £0 £xisting BUIErS i the System
RO1E Abity to delete existing authors in the system
RLZ 1.0.1.0 . Library System Release 1 5P1
g Canngt log inio the application
2 Not able to add new suthor
N7 Cannot 8dd & new Book fo the system
RL11 1.0.1.0.0001 - Iteration 001
RL1Z 1.0.1.0.0002 - Iteration 002
RL13 1.0.1.0.0003 - lteration 003

S T R TR TR R

Sample application that allows users to manage books, authors and lending records for a typical branch library

Status  Priority Owner

Type

Release

Requirement | Completed

Requirement | Completed

Requirement | Completed
R n

Requirement Progress

Requirement | Pannes

n

ReQUESTIENt | 0 oos

Release

Incigent New

Incident New

Bug Agsigned

Iteration

Iteration

Iteration

1 - Critical
1 - Critical
1 - Critical

1 - Critical
2. High

2. High

7 - Critica!

Jog P Smith
Joe P Smith
Fred Bloggs.

Fred Bioggs
Fred Bioggs

Fred Blagge

Joe P
Smith

Start Date  End Date % Complete Plan Effort

01-Mar-
2004

13-Mar-
2004

06-New-2003
13-Mar-
2004

21-Mar-
2004

25-Mar-
2004

01-Apr-

12-Mar-
2004

30-Mar-
2004

20-Mar-
2004

24-Mar-
2004

30-Mar-
2004

30-Apr-

0%
0%

25%

216 hours 0
mins

15 hours 0 mins
15 hours 0 mins
14 hours 0 mins

15 hours 0 ming
10 hours 0 mins

176 hours
mins

80 hours 0 ming
43 hours 0 mins

64 hours 0 ming
352 hours 0

Est. Effort

94 hours 0
mins

16 hours § mins
18 hours 0 mins
18 hours 0 mins.

16 hours 0 mins.
16 hours 0 mins

14 hours 0 ming.

0 hours 20 ming

Actual Effort
93 hours 30
mins

15 hours 30 ming
18 howrs 50 mins
15 howrs 10 mins
16 hours 0 mins:
16 howrs 0 ming

14 hours 0 ming




Legal Notices

This publication is provided as is without warranty of any kind, either express or implied,
including, but not limited to, the implied warranties of merchantability, fithess for a particular
purpose, or hon-infringement.

This publication could include technical inaccuracies or typographical errors. Changes are
periodically added to the information contained herein; these changes will be incorporated in new
editions of the publication. Inflectra® Corporation may make improvements and/or changes in the
product(s) and/or program(s) and/or service(s) described in this publication at any time.

SpiraTest®, SpiraPlan®, SpiraTeam® and Inflectra® are registered trademarks of Inflectra
Corporation in the United States of America and other countries. Microsoft®, Windows®,
Explorer® and Microsoft Project® are registered trademarks of Microsoft Corporation. All other
trademarks and product names are property of their respective holders.

Please send comments and questions to:
Technical Publications
Inflectra Corporation
8121 Georgia Ave
Suite 504
Silver Spring, MD 20910
U.S.A

support@inflectra.com
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